Description of Functions 04/2005 Edition

motion control

NC program management DNC S| EM ENS

SINUMERIK 840D/840Di/810D







DNC Plant / DNC Cell
Manual 1
DNC IFC SINUMERIK
Manual 2

Motion Control Information

System

SINUMERIK 840D/840Di/810D

NC Program Management DNC

Description of Functions

Valid for

Motion Control Information System DNC Software version 2
Appendix

04.05 Edition
Index




MCIS DNC Documentation

Version history

Brief details of this edition and previous editions are listed below.

The status of each edition is indicated by the code in the "Remarks" column.

Status code in the "Remarks" column:

A .... New documentation
B .... Unrevised reprint with new order number
C .... Revised edition with new status

If factual changes have been made on the page since the last edition, this is indicated by a new edition

coding in the header on that page.

Edition Order No.
03.03 6FC5 297-1AE80-0BP0O
04.05 6FC5 297-2AE80-0BPO

Remarks
A
C

This manual is included in the documentation on CD-ROM (DOCONCD).

Edition
10.04

Order No.
6FC5 298-7CA00-0BG1

More information is available on the Internet at:
http://www.ad.siemens.de/sinumerik

This document was created with WinWord V 8.0 and Designer V 7.0
and the DocuTool AutWinDoc.

The reproduction, transmission or use of this document or its contents
is not permitted without express written authority. Offenders will be
liable for damages. All rights, including rights created by patent grant or
registration of a utility model or design, are reserved.

© Siemens AG 20053. All Rights Reserved.

Remarks
C

Other functions not described in this documentation might be
executable in the control. This does not, however, represent an
obligation to supply such functions with a new control or when
servicing.

We have checked the content of this document for agreement with the
hardware and software described. Since deviations cannot be
precluded entirely, we cannot guarantee full agreement. However, the
data in this manual is reviewed regularly and any necessary
corrections included in subsequent editions. Suggestions for
improvement are welcome.

Technical data subject to change

Order No. 6FC5 297-2AE80-0BPO
Printed in Germany

Siemens Aktiengesellschaft



04.05 Preface

Preface

Audience

This description of functions is intended for CNC production users.

It is also intended for interested parties and DNC users, and

contains information about planning, commissioning and starting up NC program
management.

Objective
The areas of application and range of functions of DNC are described.
The following aspects are covered:
¢ Functionality
e Configuration options
¢ Interface parameters
Hotline

If you have any questions, please get in touch with our hotline:

A&D Technical Support

Phone: +49 (0)180 50 50 222

Fax: +49 (0)180 50 50 223

E-mail: adsupport@siemens.com

Online: www.siemens.de/automation/support-request

If you have any queries (suggestions, corrections) in relation to this documentation,
please fax or e-mail us:

Fax: +49 (0) 9131 98 21 76

E-mail: motioncontrol.docu@siemens.com

Fax form: See the reply form at the end of the document.

SINUMERIK Internet address

http://www.siemens.com/motioncontrol

© Siemens AG 2005 All Rights Reserved
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Current publications

An overview of publications that is updated monthly is provided in a number of
languages on the Internet at:

http://www.siemens.com/motioncontrol

Select “Support” -> “Technical Documentation” -> “Overview of Publications” or
“DOCon WEB”.

SINUMERIK 840D powerline

Since September 2001 the

* SINUMERIK 840D powerline and

¢ SINUMERIK 840DE powerline

have been available with improved performance. The hardware description below
contains a list of the available powerline modules:

References: /PHD/, SINUMERIK 840D Configuration Manual

SINUMERIK 810D powerline

Since December 2001 the

« SINUMERIK 810D powerline and

+ SINUMERIK 810DE powerline

have been available with improved performance. The following hardware
description contains a list of the available powerline modules:

References: /PHC/, SINUMERIK 810D Configuration Manual

For whom is the manual intended?

¢ Project engineers
¢ Maintenance and service personnel

Finding information

\Y

To help you to find your way around, the manual includes a table of contents and
two appendices:

« List of References

* Index

© Siemens AG 2005 All Rights Reserved
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Preface

Danger and warning symbols

/N
/N

The following danger and warning symbols are used in this document.
Explanation of symbols used:

Danger

This symbol indicates an imminently hazardous situation which, if not avoided,
will result in death or serious injury or in substantial property damage.

Warning

This symbol indicates a potentially hazardous situation which, if not avoided,
could result in death or serious injury or in substantial property damage.

Caution

This symbol (with a warning triangle) indicates that minor injury or damage to
property may result if appropriate precautions are not taken.

Caution

This symbol (with a warning triangle) indicates a potentially hazardous situation
which, if not avoided, may result in property damage.

Notice

This symbol indicates a potential situation which, if not avoided, may result in an
undesirable result or state.

© Siemens AG 2005 All Rights Reserved
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Other information

Important

This notice indicates important facts that must be taken into consideration.

Note

This symbol always appears in this documentation where additional explanatory
information is provided.

<\VFK_/\/ .
® o /b Machine manufacturer

Y
\ B

This pictorial symbol always appears in this document to indicate that the
machine manufacturer can affect or modify the function described. Note the
machine manufacturer’s instructions.

Trademarks

IBM® is a registered trademark of the International Business Corporation. MS-
DOS® and WINDOWS™ are registered trademarks of the Microsoft Corporation.
[ |

© Siemens AG 2005 All Rights Reserved
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DNC Plant / DNC Cell (FBDN1) 04.05
1 Introduction

1.1 Product brief

DNC is a software module in the Siemens Motion Control Information System
(MCIS) family.

MCIS comprises modular software solutions for integrating CNC and machine tools
into automation networks. They are designed to integrate modern controls such as
SINUMERIK 810D/840Di/840D, as well as older CNC and machine tools, which do
not feature an open network link capability, into an automation network. MCIS is
thus the key to increased productivity in your production plant.
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1.1.1 MCIS for machine tools

MCIS consists of several function modules, which, with the exception of RCS and
RPC, access the shared MCISDB MCIS database. The MCIS database consists of
shared components, such as user administration and machine nodes, and
module-specific components, which are assigned to individual function modules.

1. Production data management
« MDA (Machine Data Acquisition)
e PDA (Production Data Acquisition)
e PMT (Parts Monitoring & Tracking)

For improved transparency and efficiency of production processes.

2. NC program management
DNC (Direct Numeric Control)

For reducing the cost of NC data organization by virtue of user-friendly
management, archiving and supply of NC programs for CNCs

and for rapid NC program supply to SINUMERIK 810D/840D/840Di controls via
the Ethernet network.

3. Tool management
TDI (Tool Data Information)

For reducing tool stock levels and machine downtimes.

4. Maintenance management
TPM (Total Productive Maintenance)

For assisting the machine operator with maintenance tasks on machinery and
plants.

5. Service management
RCS (Remote Control System)

Remote diagnostics for reducing machine downtimes through rapid signaling of
faults and very simple online diagnosis via modem, ISDN, Intranet, Internet, or
ADSL.

6. Computer link
RPC (Remote Procedure Call)

Computer link software for communication between SINUMERIK
840D/810D/840Di and an external master computer.
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1.1.2 NC program management DNC

General

DNC manages and archives NC data and transfers them to CNC machine tools.
DNC, therefore, acts as the link between the production planning department and
the factory and offers an extensive scope of functions for managing NC data and
versions.

Operating system

DNC runs on standard PCs under Windows.
Database

NC data are managed in a database.

Control interface

The control system is connected to DNC via a machine server. A special machine

server is needed for each type of interface.

¢« DNC provides a machine server (DNC IFC serial) for linking any type of
control without a special protocol via a serial interface.

« DNC IFC SINUMERIK operates on SINUMERIK 810D/840Di/840D controls
and integrates them into the network.

¢ The file system machine type can be used to transfer NC data from and to
any shared network drives. Any network-capable control system can be linked
to the DNC system under Windows. A DNC IFC file system license is required
for this type of interface.

« ltis also possible to create any kind of machine server to establish a link to
controls with other types of interface, e.g., OLE/COM, or special serial
protocols.
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1.2 Application ranges and system versions

DNC is suitable for use in all sectors utilizing CNC-based production equipment
and is scalable in its configuration, i.e., from a local solution with DNC Cell up to a
factory-wide system with DNC Plant.

1.2.1 DNC Plant

DMNC Plant DMNC HMI
e.g. on NC programming

- . workstations
e i
- I - i

#7 Ethernet PC terminal

. -

Serial CNC machines linked with SINUMERIK 840D/840Dif810D and
a station PC or with ComServers other Ethernet-compatible CNCs

Fig. 1-1 Sample configuration for DNC Plant

DNC Plant is a high-powered central NC data archive, in which NC data can be
administered easily on a server.

Several hundred CNC machines can be connected to DNC Plant, either directly or
via station PCs. DNC Plant includes an operator interface.

DNC HMI can be used to add operator stations to DNC plant, e.g., for the chief
operator's or NC programmer's office.

This is the server variant of DNC.

Station PCs

The machine servers and an operator interface for transferring NC data run on the
station PCs.
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Networking

The following can be networked with DNC Plant:

¢ As many serial CNC machine tools as desired
* Via station PCs (up to 16 on one station PC)
» Via serial/Ethernet interface converters (COM servers) with DNC IFC Serial

¢ Programming systems

e Tool presetting stations

¢ Any number of SINUMERIK 810D/840Di/840D controls with DNC IFC
SINUMERIK (transmission protocol: TCP/IP) via a direct interface

¢« PCs with DNC HMI as operator stations of DNC Plant

e Any Ethernet-capable CNC machine tools, which can be supplied with NC data
via a Windows file system

Additional configuration options

MCIS DNC can be combined with and expanded by further MCIS modules.

In this context, the shared database is expanded by module-specific components.
Existing shared components, such as user administration and machine nodes, are
recognized during configuration.

1.2.2 DNC HMI

DNC HMI can be used to add operator stations to DNC Plant for NC program
management. DNC HMI is installed and operated on Windows PCs, to which no
serial machines are connected, e.g., in the production planning department or
factory.
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1.2.3 DNC Cell

MNC programming
workstations

/ Ethernet

DNC Cell

I

WL o

o ﬂ = | Up to 16 serial SINUMERIK 840D/840Di/810D
S -

and other Ethernet-compatible CNCs
Up to 16 serial CNC machines

Fig. 1-2 Sample configuration for a local DNC configuration (DNC Cell)

DNC Cell is a stand-alone NC data archive, in which NC data can be administered
easily.

Interfaces

« Up to 16 CNC machines/tool setting stations operating on different types of
control can be connected via a serial interface.
e Up to 16 Ethernet-capable CNC machine tools can be directly connected via
the network (line protocol: TCP/IP):
SINUMERIK 810D/840Di/840D controls using DNC IFC SINUMERIK
* Any Ethernet-capable CNC machine tools, which can be supplied with NC
data via a Windows file system (DNC IFC file system).

Networking

Programming systems
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1.2.4 DNC IFC SINUMERIK

DNC IFC SINUMERIK is used to connect Ethernet-capable CNC machines with
SINUMERIK 810D/840D/840Di to DNC Plant or DNC Cell.
See also: Book 2 DNC IFC SINUMERIK

1.2.5 DNC Compare

DNC Compare is an option package. DNC Compare can expand DNC Plant and
DNC Cell with the following functionality:
¢ Match NC programs

Comparison of different NC program versions

Differences between programs are highlighted in color.

Erilecompare M=l E3
PL_6.MPF P3_2 . MFF
1 %_N_F1_MFF 1 %_N_F1_MFF il
2 - SPATH=-_N_MPF_DIR 2 - SPATH=/_N_MPF_DIR
3 HO E_HEAD{ 268439551 .0, ,0..0. 150,

3 N0 E_HEAD{Z268439551.0..0..0..1
4 W& E_TS({"FRAESERZ0",K "FRAESER1O0" .1 | 4 NS E_TS{"FRAESERZ0". "FRAESER1O
5 Nio GO G90 X-12. ¥-12. ;#SH 5 W10 GO <90 X-12. ¥-12. #¥SH
& W1& GO <90 Z-5. ;#SH [ N15 GO G90 Z-5. #SH
7 W20 51 G90 G41 XS, ¥5. G94 Fl00. | 7 N20 G1 G90 G41 E5. ¥5. G94 F1O0
8 N2E G111 X30. ¥75. #SHM b W25 G111 X30. ¥75. #5SHM

9

| W30 G1 RP=20. AP=176. :#SH W30 Gl RP=20. AP=176. :#SH
10 W35 GZ AP=90. #SH
11 H40 G1 <90 X1z20. ;#SM 10 M40 G1 <90 X120, ;#5SM
12 W45 G111 Xiz20. ¥75. ;#5M 11 W45 G111 Xi20. ¥75. ;#5M
13 W50 G2 AP=4 . #5SM 12 WEO G2 AP=4. #5SK
14 NSE G1 G90 X145, Y5, #SM 13 W55 G1 G90 X145, ¥5. #5M
15 W&l G1 G90 X-20. #SM 14 WeD G1 G90 X-20. ;#SM
1lg M20 ;#SH 15 Ma0 ;#SM
L | K b
oK | & NEXT | 9 PREV | NAELL
| Leftonky | Mowved | Right Orly [TotalLines : 17 |DifF: 3 [ v

Fig. 1-3 Result of an NC program comparison

¢ Match machines*:
Checks whether the NC programs in the SINUMERIK are the same as those in
DNC Plant/Cell.
* This function is only available when connected to SINUMERIK
810D/840D/840D:i controls with PCUS50/70. DNC IFC SINUMERIK must also be
installed on the SINUMERIK system.

Note

The DNC Compare option package must be enabled in DNC Admin under
Tools > Options, by entering an 8-digit ID. The ID is supplied with the option
package.

You will only need one copy of DNC Compare for each DNC Plant/Cell
application.

© Siemens AG 2005 All Rights Reserved
FBDN1/1-18 Motion Control Information System DNC (FB) - 04.05 Edition



04.05 DNC Plant / DNC Cell (FBDN1)
1 Introduction

1.2.6 DNC IFC Serial

DNC IFC Serial is used to connect CNC machines to DNC Cell or DNC Plant or
the station PCs via a serial interface.

Note
DNC IFC Serial is required for each serial CNC machine.

1.2.7 DNC IFC Dialog (dialog function)

DNC IFC Serial can be expanded using DNC IFC Dialog.

It enables the operator to download and upload machining programs directly to and
from the CNC.

Dialog programs for requests (created in editor) and responses are exchanged
between DNC and the machine server. These programs contain the data needed
for transmission to and from the CNC.

Note
DNC IFC Dialog can be installed as an option for each serial CNC machine.

1.2.8 DNC IFC File System

DNC IFC File System can be used to connect any CNC machine tool to which NC
data can be transferred via a Windows file system and Ethernet network.
Programs are transferred using the DNC or HMI computer or via a station PC.

A SINUMERIK with PCU20, for example, can also be integrated via the DNC IFC
File System.

1.2.9 DNC Machine

DNC Machine is an extremely simple Ethernet networking solution for SINUMERIK
810D/840D/840Di controls.

DNC Machine provides an operator interface on the SINUMERIK, allowing NC
programs to be exchanged between the file system and SINUMERIK without the
need for any other software components.

Note
DNC Machine can be used independently of MCIS DNC Plant/Cell.
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2 Plant Structure

2.1 Plant topology

The plant topology mirrors the physical configuration of the machinery with the NC
data storage system and its hierarchical structures in MCIS DNC. To create a
structured image of the production plant, DNC uses the following hierarchical

levels:
 Groups
« Machine

DNC provides the "Workpiece" archive, in which all the NC data relating to a
workpiece can be bundled.

&} machine
EID group gwurkpiece
=-7 group
rachire
é SINUMERIK
El{:l group
- n maching
Fig. 2-1 Configuration option for the plant structure

Group

NC data management provides the option of creating coarse and fine hierarchical
structures with the aid of the Group hierarchical levels. Several machines of the
same type can be combined within one group, for example. Groups can be further
divided into subgroups. It is also possible, however, to manage individual NC data
and workpieces directly within each group.

Machines can also be set up without a higher-level group.

Machine

Machines are the lowest organizational unit. Every logical machine represents a
physical CNC machine and serves as a collection point for the NC data and
workpieces, which belong exclusively to this particular machine.

Workpiece

A Workpiece organization unit has been made available to allow interrelated NC
data to be managed together. All NC data for a particular machining operation on
one CNC machine, for example, can be collected and managed in a Workpiece.
There is also the option of bundling the NC data for a workpiece prior to transfer
them to the CNC machine.

As the SINUMERIK 810D/840DI/840D is capable of managing workpieces, it is
possible to store part-oriented NC data from DNC in the same format on the control
system.
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In principle, DNC is capable of managing all types of NC data. The following data
types are predefined in DNC:

*  MPF (MainProgramFile) NC main program

e SPF (SubProgramFile) NC subprogram

¢ TOA (ToolOffsetActive) Tool offsets

e ZOA (ZeroOffsetActive) Zero offset

« BMP (BitMaP) Graphics file for clamping drawings,
etc.

e WPL (WorkPLan) ASCII file for tool diagrams

¢ RPA (R-ParamaterActive) Memory area in the NCK for R
parameters

« JOB (JOBs) Job list

¢ ARC (ARChive) Archives

¢ INI (INltialization program) Initialization program

¢ COM (COMment) Comments

« AWB Display description

e LST (displayLiST) Display list

e TOP (TOolPlan) Tool plan

« CEC Sag/angularity

e EEC Measuring system error compensation

¢ QEC (QuadrantErrorCompensation) Quadrant error compensation

¢ PDF (PortableDocumentFormat) Text and graphics in PDF format

*  JPG (Joint Photographic Experts Group)  Graphics file

e TIF (Tagged Image File) Graphics file

¢ GIF (Graphics Interchange Format) Graphics file

They are predefined in the MCIS database. The editor assigned in the Microsoft
Explorer is used for each NC data type.

In addition to conventional NC data (NC main programs and subprograms, tool
offsets and zero offsets), DNC NT is capable of manipulating special NC data (e.g.,
graphics files and tool lists). These are available on SINUMERIK
810D/840Di/840D.

Note

New NC data types must be registered with the system by means of an entry in
database table DNCDATATYPE.

If you need a special editor for the new data types, you must assign it to them via
the Microsoft Explorer or the MCIS DNC registry entries. See also: Microsoft
Windows Help (Start>Help) under index heading: “File types”.
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Link

FBDN1/2-24

A link provides a view of any selected directory in a file system. All files of all data
types, or of one particular data type, are displayed in this directory. A link thus
provides a direct view of NC data in other networked systems, e.g., NC
programming systems. DNC does not keep administrative data about these files.
Only the file system information can be displayed.

Links can be integrated into any organization level of the hierarchical NC data
structure.

Note

Links only provide one view of the objects located directly below. Subdirectories
cannot be accessed.
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2.2 DNC functions on hardware components

2.2.1 DNC Cell computer

In the local version of DNC Cell, the DNC Cell computer performs the following
tasks:

NC data management in the MSDE database or SQL server
User data management in the file system

Data maintenance and management

Configuration

Importing

Export

Data transmission to and from the CNC machines

User administration

Management of data filters

Management of log book filters

Comparison of NC programs

Automatic archiving of NC data from SINUMERIK 840D/840Di/810D (optional)

2.2.2 DNC Plant computer

In the DNC Plant version, the DNC Plant computer (server) performs the following
tasks:

NC data management in the MSDE database or SQL server (optional: Oracle
database)

User data management in the file system

Central data maintenance and management

Central import functions

Central configuration

User administration

Export

Importing

Management of data filters

Management of log book filters

Comparison of NC programs

Automatic archiving of NC data from SINUMERIK 840D/840Di/810D (optional)

2.2.3 DNC HMI computer

Additional operator interfaces can be added to the DNC Plant version using the
DNC HMI computer.
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2.2.4 Station PC

In the DNC Plant version, the following tasks are performed on the station PCs:
« Configuration of connected machine interfaces

« Data maintenance and management for connected machines

e Data transmission to and from the CNC machines

e Comparison of NC programs

2.2.5 NC programming system

NC programming systems can be integrated into the DNC group in order to transfer
NC data. NC data can be transferred from NC programming systems integrated
into the network to the management structure of the DNC using an import function.
For this reason, no MCIS software is required on the programming system
computer. However, there is the option to install DNC HMI software on an NC
programming system in order to operate the DNC system. If the DNC HMI
workstations are configured appropriately, controls can be accessed directly.

2.2.6 Control

SINUMERIK 840D/840Di/810D

SINUMERIK 810D/840Di/840D controls feature both the active memory containing
the NC data for processing on the machine tools and a passive memory on the
PCU50 or MMC. The passive memory can store, for example, NC data in the form
of NC programs, tool data or zero offset data, thus making NC data available
before production commences. The network link to DNC is provided via DNC IFC
SINUMERIK. NC data can be uploaded and downloaded to/from the control on the
SINUMERIK operator panel.

Controls with serial interface

Controls with serial interface can be connected to DNC Cell/Plant or station PCs
either directly or via interface converters (COM server). The serial interface
(machine server) must be configured for each CNC machine tool. NC data are
transferred to the control via the interface of the relevant station.
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2.2.7 Tool setting station

Tool setting stations can be linked to DNC in the following ways:

* Via a serial interface (the tool setting station is configured as a machine)
The tool offset data are uploaded from the tool setting station to the DNC. After
uploading, the tool offset data files (*.TOA) are stored under the tool setting
station in DNC. To download tool offset data to a CNC machine tool, the user
must move the relevant file (Cut/Paste operation) to the appropriate machine
within the DNC system. The data can then be downloaded to the CNC
machine tool.

« Via a network interface (the tool setting station is based on a PC with network
interface)
A'link to a directory on the tool setting device is configured in DNC. The tool
offset data files stored in this directory can then be copied (Copy/Paste) to the
relevant machine in the DNC system for subsequent downloading to the CNC
machine tool.

e Tool offset data transferred via the import function
The tool setting station must insert a header into the tool offset data files
indicating the machine to which the offset data refers. When importing via
DNC, the files are assigned to the appropriate machines in DNC (see also:
Import function). They can then be downloaded to a CNC machine tool.
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Notes

© Siemens AG 2005 All Rights Reserved
FBDN1/2-28 Motion Control Information System DNC (FB) - 04.05 Edition



04.05

DNC Plant / DNC Cell (FBDN1)

3 Operator Interface

3.1 Layout of DNC and DNC Admin Explorer
3.1.1 Explorer structure ...........cccoovvveeeeeeeinnns
3.1.2 Display formats ..........ccccovciviiiiieeeee.
3.1.3 0peration .........ccccevviiie i
3.1.4 Languages ........coeeereeeeeiiiiiee e

B.2VieW fiter ccoeeeeeieeeeeeeeeee e
3.2.1 Create oredit afilter..........cccccooevveennn.
3.2.2 View filter examples..........ccccccceeirninnis

© Siemens AG 2005 All Rights Reserved
Motion Control Information System DNC (FB) - 04.05 Edition

3 Operator Interface

3

........................... FBDN1/3-30
.......................... FBDN1/3-30
.......................... FBDN1/3-34
.......................... FBDN1/3-35
.......................... FBDN1/3-35

.......................... FBDN1/3-36
.......................... FBDN1/3-38
.......................... FBDN1/3-42

FBDN1/3-29



DNC Plant / DNC Cell (FBDN1)

04.05

3 Operator Interface

3.1 Layout of DNC and DNC Admin Explorer

The operator interface of the DNC system is Windows-based in terms of both
function and handling principles. Inputs in dialog boxes are made via the keyboard
or mouse. In addition to the standard menus, the interface also features a toolbar
for all important functions and a status bar for messages.

Operators must log onto the system. Various function rights are available to
operators, depending on their user rights.

There are two different operator interfaces:
e Operator interface for NC data management (DNC Explorer)
¢ Administration operator interface (DNC Admin Explorer)

3.1.1 Explorer structure
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Fil=  Edit “iew Option: Machine Alignment Help

I [=] E3

J Filter

|Fi|ter_4?11

| $fBRR + X ESdan 7
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Fig. 3-1 DNC operator interface

The interfaces of DNC Admin and DNC are virtually identical. However, each
program has a different range of supplementary functionalities. See also:
Chapter 10 Configuration.

The screen is divided into two windows.

e Similar to the Windows Explorer, the left-hand screen window shows a tree
hierarchy of all DNC administration units in the plant configuration, starting with
the base level (root) and including groups (subgroups), links and finally, on the
lowest level, the individual machine. Selected administration units are
highlighted in color.

e The right-hand window displays a list of all subordinate elements (NC data,
etc.) of the unit selected in the left-hand window. Apart from the file name, the
size, type, creation date, etc., of the units are displayed on the right. With the
exception of links, the list display is generated as a function of the database
table DNCLISTDESCRIPTION.

The address line, filter line, tool and menu bars are displayed at the top of the
Explorer screen and the status bar appears at the bottom.
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Table 3-1 DNC and DNC Admin menu

File Edit View Options
New ] Cut Configuration * | Settings
Show**
Open Copy NC Data Log Book
. . User
Import Paste Filter Editor Management *
. Consistency
Export Delete Filter ON/OFF Check *
Download ** Properties Toolbar List Editor *
" Reset Release Screen Form
Upleed Identifier Status Bar Editor *
Compare Version Area | Split Options... *
Log Off Refresh List
Exit

*

Only available in DNC Admin (New->... in configuration mode only)

** Only available in DNC

Table 3-2 DNC and DNC Admin new popup menu

File

New ¥ | NC data
Workpiece
Group *
Machine *
Link *
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Toolbar
LTI ETT R
Fig. 3-2 Operator interface toolbar
The toolbar contains icons for the following functions:
e Open
e Cut
» Copy
*« Paste
e Back (for workpieces)
¢ Delete
¢ Properties
¢ Download
¢ Upload
« Filter (active/inactive)
Filter bar

|E s @« X Sdudn 7 H Fiter  [Fiter_4711
Fig. 3-3 User interface filter bar

The filter bar indicates the filter currently selected. Other predefined filters can also
be selected here. Whether the filter is currently active or inactive is indicated by the
filter icon in the toolbar.

Address bar

The address bar contains the following information:
* Name of the workpiece if workpiece directory is open
e Path of link if link directory is open

J@|£E|+%ﬁﬁﬁ|]ﬁlter [MPF =]
| & |cULessE

Fig. 3-4 Address bar if workpiece directory is open

|| % B@| + X Hdndn 7 ||Fier  [MPF =]
J Address IE:"\F'G-F'Iatz_FIic:hter'\“.*

Fig. 3-5 Address bar if link directory is open
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Status bar

The status bar displays explanatory information about menu items and icons, as
well as message and error texts when appropriate.
It also displays the number of entries on the list side of the Explorer screen.

Note

Important error messages are displayed in a separate message window. These
messages must be acknowledged by the operator.

The following messages are displayed in the status bar:

« Results of processes. The appearance of these messages is sporadic.

« All messages generated by actions taken when the dialog function is active,
i.e., when it cannot be assured that an operator at the computer can
acknowledge the messages.

* Messages, which do not require the operator to react immediately.

The following messages can be displayed in a separate message window:

* Messages, which are generated immediately in response to user actions, and
which require the user to react in some way.

«  Serious system errors, which will prevent the system from continuing to
operate normally.
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3.1.2 Displa

y formats

DNC and DNC Admin offer two different display formats. The standard view is

intended for selection on PCs in areas outside the factory. The big view is intended

for use in the factory area.

Normal view

The operator interface is displayed in the standard Windows size.

Big view

In the big view, symbols and icons are twice as large as those in the standard view

and display text is also enlarged.

The primary purpose of this enlarged display format is to make the interface easier

to read at a greater distance in the workshop area.
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Open Cut Copy Paste Back Delete  Propetties  Download  Upload
| Fiter  [Fiker_4711 | & [Workpiece47T1
2 = Type | Wersion | Release.. | Tral.. | Length
E area motors Ive-cylinder-h... MPF
EC’ group 6 cylinder: E;w]] d-valve-cylinder-h... MPF 5 0 0 7490
_________ rmachining « || B=] cut-offcycle SPF 7 0 0 710
......... machine 44| E;w]] cut-off-cycle SPF 8 1 0 1084
--------- machine 4¢ E;‘]] fine-grinding-cycle SPF 4 0 1 B0
--------- rmachine 3¢ E;w]] fine-grinding-cycle  SPF 5 1 1 96
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Fig. 3-6 Operator interface big view
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The DNC and DNC Admin explorers are operated with the usual Windows tools,

i.e., mouse and keyboard.
The main functions can be selected via function keys:

¢ Properties
¢ Download

e Upload

¢ Update List
e Change Window
e Use Filter

3.1.4 Languages

F2
F3
F4
F5
F6
F7

The operator interfaces of DNC and DNC Admin support a variety of languages.

They operate in the currently selected language.

You can switch between the following languages by selecting Tools = Settings

while the system is running:

- German
- French
- ltalian
- Spanish
- English
- Chinese
- Russian

« GR
« FR
o T

« SP
« UK
« CH
« RU
Note

In the Chinese and Russian DNC systems, the online help is in English.
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3.2 View filter

General

Select View->Filter On/Off to apply a filter to the view of files in the right-hand
window of the operator interface. When the filter is active, DNC displays only a
selection of NC data, which are relevant to you.

DNC can filter your NC data on the basis of the full management database. The
only exceptions are the comment, workpieces and workpiece management data.
Texts within NC data comments cannot be used for filtering purposes.

The filter icon in the toolbar indicates whether or not the filter function is active.

B

Filter activated

S

Filter deactivated
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Fig. 3-7 Example of an unfiltered view
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Fig. 3-8 Example: Filtered view (here "SPF")
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Cross-area filters

When the cross-area filter is active, certain files from the overall tree structure can
be found in the left-hand window.

All NC data stored in DNC, which meet the relevant filter conditions, are displayed
when the cross-area filter is active.

Create a filter by clicking on the base (root) of the tree structure in the left-hand
window and then activating your filter.
Files in links are not displayed!!

Note

To prevent excessive delays in large plant, the NC data global display has been
assigned a maximum limit (1000 NC data). For this reason, you should configure
a suitable filter so that you view only the NC data relevant to your activity.

Workpiece management data is meaningful only in connection with the
cross-area filter. When the filter is used "normally”, no NC data are displayed if
the filter criterion is "Workpiece".

The list display of the cross-area filter is defined under the “GLOBAL" display
group. If this display group does not exist, the normal list display is used (for more
detailed information, see: List editor).

!{,—_DNE - Terminall M=l B
File Edit Wiews Ophions Machine Alignment  Help
J ﬁ"| o E| - a H Filter IFiIter 4-valve-cylinder-head j
J Address |Ernss-area filker activated
Marne | Type | ‘v'ersionl Release Iu:I| Machine |
EH:' W 4-valve-cylinder-head MPF 7 0 Maschines
= MPF & 0 Maschined
MPF S 0 Maschines
MPF 4 0 Maschined
4-yalve-cylinder-head MPF z 0 Maschines
4-valve-cylinder-head 2000 MPF 1 0 Maschinet
<[] ]
& ML 4

Fig. 3-9 Cross-area filters
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3.2.1 Create or edit a filter

Add or edit filter criteria

The filter criteria dialog (see below) appears when you select the View->Filter
Editor menu option.

MPF-Filter
Field name | OpET... | value | (] I
[ Type = MPF

Cancel |
Eilter seleu:tiu:unl
= |
[Ehanae |
Accept |
[NElete |
Field narme: Operand: W alue:
] i
Tope i | E— | [ gt
L IMName “
Releaze-D
Trialcut-1D
T upe
Yerzion (-
YWorkpiece ~

Fig. 3-10 Dialog filter criteria — new criterion

Note

If a filter has not yet been defined, the filter edit dialog appears immediately to
allow you to create a new filter (see next-but-one chapter below).

Select Edit and New to activate the lower 3 fields, in which you can enter and
change the filter criterion.

You can select the active filter, whose filter criteria you wish to edit, using the
Select Filter button.

If you have parameterized several criteria for the filter, you can sort them by
selecting the Up button. This serves only to improve your overview and does not
affect their function. Since all criteria are ANDed, they must all be met in order for
the filter to work.
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In the FieldName box, select one item of management data for the relevant NC
data.

You can parameterize an Operand to determine how your NC data with the
selected field name will be filtered. The following options are available:

Table 3-3 Filter operands

Operand | Description

= Equal to  Value
<> Not equal to  Value
< Less than Value
> Greater than Value
<= Less than or equalto  Value
>= More than or equal to  Value

Caution

Before you change a filter, make sure that you have selected the right filter in the
filter selection dialog by checking the dialog title of the filter criteria dialog box
(see above).

You also have the option of working with wildcards in the Value field. The following
wildcards are supported:

Table 3-4 Wildcards

DOS SQL Meaning Examples

wild- wild-

cards cards

* % String of optional | c¢* cylinder_head, coil_plunger
characters %A TOA, ZOA, RPA

? _ One optional ?PF MPF, SPF
character (0] TOA, ZOA, JOB

Note

DOS wildcards have the same meaning as SQL wildcards.

Wildcards are transferred as a "like" scan to the database. This can mean that
one filter can react differently to different databases (MSCE, ORACLE, etc.),
depending on the database setting. This may include, for example, a deviation
between lower and upper case letters. A filter may also react in different ways to
wildcards or date fields.
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When you have entered your criterion, select Accept.

The tick in the checkbox in front of the filter criterion indicates that the criterion is
activated. If the checkbox for a criterion is empty, the criterion will not have any
influence on the filter.

Important

All individual filter criteria are ANDed, i.e., criterion 1 AND criterion 2 AND
criterion x must be met in the NC data, if these data are to be displayed. A
plausibility check is not performed!!

Select filter

Selecting View->Filter Editor...=> Select Filter to open the filter selection dialog

(see below).

Filter zelection |
Filter name | dizplay group | LIZEr | zhatian |
SPF-Filker GROUPAD ] M achinel
tPF-Filter GROUFBIG tachine]

Filter_4711 GROUPAD DME M achine
Filker_3873 GROUPBIG helper t achine3

|shu:uwing arly MPF-filez
2k, I Cancel Change e Copy Delete

Fig. 3-11 Filter selection dialog

Note

If no filter is yet defined, the filter edit dialog appears immediately to allow you to
create a new filter (see next chapter).

The filter criteria dialog with the selected filter appears when you click OK. This
selected filter is then active. You can identify the currently active filter from the
title of the filter criteria dialog box.

Select New, Edit and Copy to call the filter edit dialog.

The filter criteria of the copied filter are transferred when you select Copy.
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Create a new filter - General filter data

This dialog (see below) appears when you select
View-> Filter Editor...> Select Filter>New or
View-> Filter Editor...>Select Filter>Copy or
View-> Filter Editor...>Select Filter>Edit.

MPF-Filter |

Filker narne:
W PF-Filke

Comment;
ISths arly MPF-Files

Digplay group:; Statior:
[GROUPAD =] [Machinet
| zer name:
IDNE

] | Cancel

Fig. 3-12 Filter edit dialog

Note

You must specify the filter name. The comment field is optional. The other fields
(if used) restrict those who can use the filter.

Confirming the filter with OK will take you back to the filter selection dialog. Here
you must select and confirm the new filter, in order to add its filter criteria.
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3.2.2 View filter examples

Filter criteria

Filter_4711 ] |

Mew

Field name | aper... | wvallie | (] I
O Name = EdE

O Name - o Cancel |
Feleasze-1D = 1 : :
O ersion r= 2 Filker selechnnl
O Tpe y= SPF

Developing date 11.07.01

[ Developing date 11.07.01 16:47:34

Change |
Lrnent |
Delete |
Field narme: Operand: Walue:
D eveloping date j |= j I'I'I.EI?.EH ﬂl

Fig. 3-13 Filter criteria dialog — Example

This filter contains a large number of filter criteria, not all of which are active. A tick
in the checkbox in front of the filter criteria indicates the currently active criteria.

All the following examples refer to the filter above and are activated and
deactivated in succession. The example heading indicates the criteria that have
been activated. All other criteria are deactivated for that particular example.
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Output data without filtering

File Edit “iew Extraz Machine alignment Help
B dBR « Xghav
Adrezze I
E M ame I * I Typ I Wersi... | Release |d. I Trialcutidl
- areamotors Bielle-mote 1 1 0
EH:I group & cylinders Chapeau-Tond-standard SFF 1 ] 0
{ """ mac:!nlniézegtre clarnping zetup = BMP 1 0 1]
""" ma"hfne oy : Cycle-filstage-B11 SPF 1 0 0
P ::Eh:zz 39_?1 Cycle-forage-chapeau-vl2 SPF 1 1] 0
P - teat = MFF 1 0 0
. ! u “  SFF 2 0 0
EH:l agroup B ovlinders || P
- g machine 34_sp %] "welcome to DMC MT-2000 MPF 2 0 1]
‘.. M marhine 33 fr
B [
Fig. 3-14 Output data without filtering
Example 1: Program name = c%
M arme | * | Typ | Yers.. | Heleaseld.l Trialcutidl Lengthl
Chapeau-rond-standard SPF 1 1]
clamping zetup = BrP 1 1] 1] 40018
Cycle-filetage-B11 SPF 1 0 1] 1
Cycleforage-chapeau-y12 SPF 1 0 1] G0

Fig. 3-15 Filtering of output data with filter: Program name = c%

DNC now displays all NC data with program names beginning with "c". The rest of

the program name is irrelevant. This is represented by wildcard "%".
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Example 2: Program name = %d%

I ame | * | Tvp | Yers... | Heleaseld.l Trialu:utiu:ll Lengthl

2] welcome to DNC NT-2000 MPF 2 1] 0 0

Fig. 3-16 Filtering of output data with filter: Program name = %d%

The system now displays all NC data with a "d" in the program name. The display
is not case-sensitive, which is why "Welcome to DNC" is also included. However,
this is a database setting, which may not be the same on your database.

Example 3: Version >=2

M ame I * | Typ | "ersl... | Heleaseld.l Trial-:utiu:ll Lengthl

2] welcome to DNC MT-2000 MPF 2 1] 0 1]

Fig. 3-17 Filtering of output data with filter: Version >= 2

All NC data, which are version 2 or higher, are now displayed.

Example 4: Program type >= SPF

Mame | = | Tep | emsi.. | Releaseld. | Trialcutid | Length |

1
Cycle-filetage-B11 SPF 1 n ] E1
Cycle-forage-chapeau-12 SPF 1 n ] (1]
Toaldata T 1 0 0 0
Up = SPF 2 0 0 24528

Fig. 3-18 Filtering of output data with filter: Program type >= SPF

The system now displays all NC data, which, as a program type, would appear
after "SPF" in a dictionary ordered alphabetically. For this reason, the display also
includes the NC program of type "TOA". As the criterion was configured with the
operand greater than, equal to, both the SPF and the TOA programs are included
in the list.
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Example 5: Creation date =11.07.01 16:47:34

M ame | * | Typ | ersi... | Releaze I|:|.| Trialcutidl Lengthl
FemaaykdilingCycle 4

FemqaukdilingCycle kMPF 3 0 1 G0
FemqaukdilingCycle FMFF 2 0 1 G0
FewaayhillingCrcle MPF 1 1 1 &0
FewaaybdillingCrcle SPF 2 1] 1 &0
FewaaybdilingCrcles MPF G 1] 1 &0

Fig. 3-19 Filtering of output data with filter: Creation date = exact time

You can also filter according to management data that are not visible in the
right-hand area of the window, such as the creation date.

Note

The date format is dependent on the database setting. The date must therefore
be entered as configured in the database, as no date conversion takes place.

A date/time input with seconds was chosen explicitly in this case. It is then possible
to locate copies and other versions of a program provided that they were all
created on the same date.

Example 6: Release identifier =1 AND creation date = 11.07.01

M ame | * | Typ | ersl,.. | Heleaseld.l Trialu:utiu:ll Length'

FemaaypkdilingCycle

Fig. 3-20 Filtering of output data with filter: Release identifier = 1 AND creation date =
particular day

This filter now displays the NC data, which meet both criteria. The release
identifier AND the creation date must match the filter.

The number of 'hits' can be significantly reduced by adding other criteria, which the
data must also meet.
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Notes
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4.1 Maintenance functions

4.1.1 Create/Edit management data

Create/Edit NC management data

NC data properties should be set up and maintained by authorized users such as
administrators or skilled operators. The right to edit management data must be
enabled for these users (see also: Chapter 5 - User administration).

According to how they are parameterized, NC management data are displayed on
up to four tab sheets:

* General

e About

« Extensions

e« Comment (integral property)

In addition to the standard screens, the following modification and extension
options are provided:
« Change the screen layout of the standard properties display box via the List
Editor.
e Change the field types for output and edit fields in properties screen via the
Screen Editor. The following types can be selected:
*  Output fields
» Editing fields
* Combo boxes
» Checkboxes
*  Output checkboxes
»  Static output fields

¢ Redefinition of data fields for describing NC data

Note

It is possible to define different field types for the screens for creating new NC
management data and modifying NC management data.

Field types are described in the DNCFORMDESCRIPTION table on the basis of
database fields FIELDTYPE and FIELDTYPE_NEW.
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With the exception of fields, which have been parameterized as read-only fields,
features included in the Properties dialog can be altered.

Note

Generally speaking, parameters are set to define the fields to be displayed in the
Properties dialog. Therefore, fields not parameterized for the Properties dialog

cannot be altered.

Screenshots of some the screens available on the standard interface appear

below:

Properties: 4-valve-cylinder-head x

General I.ﬂ'-.bu:uut I Enmmentl

M arne |4-valve-c_l,llinder-head

Wersion IE— Workpiece
Release- 1D = Trialeut- 1D
Length  [7807 Auto Archive
Develname [sismens Develdate
Modname [DNC Moddate
Loadcounter [0 Lastload

Type

v

[

[¢1 0953 10:41.54

[10.08.07 11:39:.08

] 4 | Cancel Help
Fig. 4-1 NC data properties/tab: General
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Propertiez: 4-valve-cylinder-head

21.09.9910:41:54
10.08.01 11:3%.08

10.08.01 11:37:33

Fig. 4-2 NC data properties/tab: Info
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Edit machine configuration data

You can only change the machine properties in configuration mode in the DNC
Admin program. View - Configuration can only be selected by authorized users
(administrators). Configuration rights must be enabled for these users (see also:
Chapter 5 - User administration).

Machine properties are displayed on two tabs:

e Transfer

e Configuration

As regards configuration of the machine properties, only the Configuration tab
sheet is relevant. This is divided into two sections:

In the first section the user can link physical CNC machines to logical machines in
the plant configuration via so-called machine configuration files.

You can edit the machine configuration file in interactive screens by clicking on the
Config Dialog button.

If you wish, you can also edit the machine configuration file directly and open it via
the Edit button to make changes.

The other section of the tab allows dialog function defaults to be set (see also:
Chapter 10.4 — Machine interfaces).

area motorz group b cylinders machining centre

Doverload  Configuration

Configuration file: EnIT

machining centre. M CF

Config dialog

Transmigzion module: Drigplay group faor list:

| Serial without protocol x| ™ Dialog functior |DELLIST =]

: [ Manual Ahart
Ipload directary Search levels for HC data

i_‘ maching & ___j r machine 5 ___j

k. Cancel Help

Fig. 4-3 Machine properties/tab: Configuration
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Edit link m

anagement data

Authorized users (default: Administrators) are able to define links in configuration

mode. Configuration rights must be enabled for these users (see also: Chapter 5 -
User administration).

The Edit button can be used to select a drive or path for a link, giving the DNC
system access to these files.

Note

Files that are visualized by means of a link have no database reference.

FBDN1/4-52
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4.1.2 Import NC data

General

DNC supports the import of NC data (files of all configured NC data types) from
networked or higher-level systems (e.g., from NC programming systems).

Table 4-1Relevant database fields for file import with header data

Database field Meaning Characters
NCDATANAME NC data name 40 characters, illegal
characters:
&\" /5 <=>?[\!, (){} % $B§U*
DNCDATATYPE NC data type 3 characters, only types
defined in table
DNCDATATYPE
VERSION Version number Long integer
NODENAME* Machine, group or path (e.g., |40 characters
Group1/Machine2)
WORKPIECE Workpiece name 40 characters
RELEASEID Release identifier Valuerange Oto 1 (1 =
released)
TRIALCUTID Trial cut identifier Value range 0 to 1 (1 = trial
cut identifier)
DEVELNAME Developer 32 characters
DEVELDATE Date of development Date
MODNAME Modifier 32 characters
MODDATE Date of modification Date
ADMINNAME Administration data modifier | 32 characters
ADMINDATE Date of administration Date
modification
LOCKNAME Lock identifier 32 characters
LOADID Load identifier Long integer
LOADORDER Load order Long integer

*  NODENAME is not a database field in the DNCDATA table, but an auxiliary
function for determining the NODEID from the node name. NODEID is an
internal database field in the NODETABLE and DNCDATA tables, and is used
to assign NC data to their nodes.

Note

If the administration data table is extended for a specific project, these new
database fields can also be used in the header!
Undefined fields or fields without assignment will be assigned the value 0 or an

empty string.
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/N

Warning
The following database fields must not be defined in the header:
NODEID is a system-internal variable, which is assigned
automatically.
LENGTH is the length of the NC program and is set automatically
during import.
LOADCOUNTER is the transmission counter and is incremented
by the system for each transmission.
LASTLOAD is the date of the last transmission and is set by the
system for each transmission.
LOCKNAME is not currently used by the system.

Manual import

After calling up the File>Import function, the user is presented with a file window
in which the file to import can be selected and then a selection menu indicating
how to proceed with the import file once it has been imported.

Confirm Import |

0033 _Flangia_moatore_1.#MMPF

Irmpartfile after Impart

{1 Bename

0 leave it unchanged

0k, Al Cancel

Fig. 4-4 Dialog: Confirm file import
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Import without header data

NC data without headers can be imported by authorized users (default:
Administrators or Workers). The NC management data must be entered in
interactive mode. For this purpose, these users must be authorized to import
NC data and edit NC management data (see Chapter 5 - User administration).

Import with header data

A file import with header data is carried out using two files. The header data is
contained in a header file (Unicode). The user data is contained in a separate
file. The type of file import enables the acceptance of NC data without the user
making any additional entries. All users are authorized to make this type of
import.

If management data is incomplete, authorized users can rework this
management data in interactive mode. The import request will be rejected if
made by an unauthorized user, for whom the right to edit NC management
data is not enabled (see also: Chapter 5 - User administration).

Management data can be allocated in the import file using field names (e.g.,
NCDATANAME). In this way, the import file can contain certain or all
management data record fields. The import file is divided into the following
areas via start and end identifiers:
« Header data/management data (HEADER-START, HEADER-END)
e Comment (COMMENT-START, COMMENT-END).
Keywords are database field names of the administration data table
DNCDATA.
One import file can contain several import blocks. Each block must consist of
header data and NC data and can also contain a comment.
In that way, all NC data required for machining can be grouped together in one
import file.

Table 4-2 Import file with header

Import file with separate NC data file

HEADER- START

NODENAME=G oupl/ Machi ne2
NCDATANAME=But terfly
DNCDATATYPE=BMP

VERSI ON=1

TRI ALCUTI BD=0

RELEASEI D=1
DEVELNAME=Schmi d

HEADER- END

NC- FI LE=Bf | y1. bnp
COVMVENT- START

This is a butterfly
COVMVENT- END

Import via links

Copying data from a link and subsequently pasting it into DNC is equivalent to
the import function. The action is subject to the same supplementary conditions
as importing with or without header data.
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Automatic import

File imports can also be performed automatically with header data. The format of
the header data is that of manual imports with header data.

Note
The header does not have to define all database fields for automatic transfer.

At least the following database fields must be specified:

«  NCDATANAME

« DNCDATATYPE

 VERSION*

«  NODENAME

<  WORKPIECE (only if the NC data belongs to a workpiece)

* If an existing version is assigned, this is overwritten.
If no version is specified, the next free version number is assigned. If the
maximum number of versions is exceeded, the version with the oldest
modification date and not released is deleted.

If the NC data imported automatically belongs to Machine2 from Group1, for
example, the following definition must be made:

NODENAVE=Gr oupl/ Machi ne2

When the NC data belong to a workpiece cylinder head that is assigned to
Machine5 of Group1, you must define the following:

NODENAME=Gr oup1/ Machi ne5
NCDATANAMVE=Butterfly
WORKPI ECE=Cyl i nder head

When DNC is set up, the import directory for NC data files is defined in a dialog.
The file types for the automatic import are defined as follows:

¢ File type of the import file: .imp

«  File type after successful automatic import:.iok

e File type after failed automatic import:.ier
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4.1.3 Edit NC data

General
NC data can be edited by authorized users.
Unauthorized users such as auxiliary staff can view but not edit and save NC data

to the database or create a new data version. To ensure that the data are
protected in this way, a copy of the data file is opened in a temporary folder.

The right to edit NC data must be enabled for the relevant users (see also: Chapter
5 - User administration).

Note

DNC uses the Microsoft Explorer Editor for all file types.
New file types must be assigned to an editor via the Microsoft Explorer.

Edit/save file

All NC data displayed in the currently selected directory can be opened for editing.
When a file is saved, a new file version is generated in the directory of the original
file, or the old version is overwritten, depending on the settings in database table
DNCGLOBALSETTINGS.

Note

In order to ensure that data are processed suitably for the DNC system, files
should only be edited using the Save and Exit menu commands in the editor of
your choice. Although all the other functions can be used, they will have no effect
on the MCIS database.

This applies, in particular, to the Save As menu command, as it creates a file with
the specified name in the specified directory, but does not set up a corresponding
link to the database. In this case, the old file version remains unchanged in the
database.

“Delete version” dialog

If the parameterized maximum number of versions is exceeded, the “Delete
Version" dialog will appear to allow deletion of an old version.
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4.2 Download functions

General

For uploading and downloading, the interface is opened only while transfer is in
progress and then closed again. The same serial interface can, therefore, be used
for different machines (e.g., with a DNC on a mobile station).

The right to download or upload NC data must be enabled for the relevant users
(see also: Chapter 5 - User administration).

Note

The interface is always open when a dialog function is configured. It can,
therefore, only be used for one CNC machine tool.

Transmission symbols

Uploads and downloads are identified by means of the yellow arrow symbols in the
operator interface on the machine.

Ap
Fig. 4-5 NC data uploaded from the CNC machine tool

o

Fig. 4-6 NC data downloaded to the CNC machine tool

Note

If you start a download operation, there may be a delay before the data begin to
flow (yellow arrow appears).

This will depend on whether end-of-line characters need to be converted, the
insertion of spacers or code conversions and on the file size and computer
capacity.
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!{r,_ DHNC - Terminall

File Edit “iew Ewxtraz Help

| Y BR P - XS dnan v

Adressz

| =

|

%lﬁ area motors

El{:l araup B cylinders

machine 43 dt

machine 44_en

machine 33_it

El {:I araup 8 cylinders
e machine 34_zp
o machine 33_fr ap

= lﬁ area gears

rianual gear =l

Albarnatie near

Fig. 4-7 Display of download functions in DNC
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4.2.1 Download NC data

Download requests

Download requests for serial machines can be viewed in the Properties screen for
the machine. The file currently being downloaded is displayed in the NC data field.
The files still to be downloaded are listed in the Download requests field.

Download states

The possible download states are listed below:

e Error (e.g., when a COM port is already in use by another machine)

* Inactive (initial setting)

e Send delay (with a send delay > 0 in the [SEND] section of the machine
configuration file)

¢ Active (download in progress)

¢ Prepare to send (NC data is interpreted, download then commences, e.g.,
code conversion). Prepare to send is visualized in the same way as send
delay.

Length
The Length field displays the number of bytes already downloaded.

area motors group b cylinders machine 49_dt E3

Loading | Caonfiguratian |

Download state: ‘Elusy Upload state: ‘Inactive

Length: 512 Length: |0

MC Data;

Cancel current job

rachine 49_dtkotar_z1_6 MPF

Loadlist:

machine 49_dt24711-up_1.5FF

Deleteselecten johs

] I Cancel Help

Fig. 4-8 Downloading NC data
Cancel current job

Click to cancel an active download operation.
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4.2.2 Download NC data to SINUMERIK 810D/840D1/840D with DNC IFC

General

SINUMERIK

If you intend to download data to a SINUMERIK 810/840DI/840D, a dialog box will
first appear in which you can select the download target in the control.

Load to SINUMERIK 840D

[T Load

Cancel |

Fig. 4-9 Dialog for downloading to SINUMERIK 840

NC data are downloaded to the SINUMERIK 810D/840DI/840D data management
system.
Check the Load box to transfer the data to the SINUMERIK NCK.
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4.2.3 Upload NC data

Upload request

An upload request for serial machines can be viewed in the Properties screen for
the machine. The file currently being uploaded is displayed in the NC data field.

Download states

The possible download states are listed below:

e Error (e.g., when the COM port is already in use by another machine)

* Inactive (initial setting)

* Ready (DNC is ready for the upload; this status remains active until the actual
upload (from the machine) is started.)

¢ Active (upload)

Length
The Length field displays the number of bytes already uploaded.

Loading | Caonfiguratian |

Upload state:

Length: 0 Length: 0

MNC Data;

Download state: ‘Inactive ‘REﬂdy

machine 44_enikeyway-milling-cycle_3.5FPF Cancel current job |

Loadlist:

Deleteselected jmhs

oK | Cancel Help

Fig. 4-10 Uploading NC data
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Cancel current job

dAreal PCUV2serial |

Dovnload | Canfiguration |

Download state: Inactive Upload state: B Clive
Length: 0 Length: G032

ML data:
E= |Eanu:e| cuent job |

PLLY Zzenialh e vaLyE -CrLINT Rkl

Download jobs: & Accept received MC data
: Mo |

[Nelete selented [ohs |

k. Cancel | Help |

Fig. 4-11 Cancel an active upload (receive data)

When you click on Cancel current job, two functions are available if you checked
the Manual abort box in the Configuration dialog:
Do not accept received NC data:
The data are discarded.
¢ Accept received NC data:
The data are accepted.
Background:
On some controls, it is necessary to delay the end of reception (end of upload
x seconds following receipt of last character).
To shorten the upload time, it is possible to abort the transmission following
receipt of the last character. The uploaded NC data are accepted.

Note

The dialog is displayed only if you checked the Manual abort box in the
Configuration dialog. By default, this box is not checked, which means that
received data are discarded when an upload is aborted.
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4.2.4 Upload NC data from SINUMERIK 810D/840D1/840D

General

If the SINUMERIK 840D machine type is selected and the upload is started, a
dialog will appear displaying the SINUMERIK 810D/840DI/840D data management

directory.

machiner x|

-

Wiorkpieces

CUS.DIR

:I CH Marme | T_l,lpel a. | Length | changed | Close I
+ ARC.DIR 4ALVE-CYLINDER-HEAD MPF 594363  0B.05.200Z 15:08:.. -
MPF.CIR FINE-GRINDING-CYCLE  MPF £4 05.05.2004 03:29:... Cancel
SPF.DIR CUT-0FF-CYCLE MHPF 84218 12022004 16:34:..

Delete

==
Tranzfer
(e

|1 woh 1 MC D aten usbertragen

Fig. 4-12

View of the SINUMERIK 810D/840DI/840D data management directory

The content of the SINUMERIK 840 data management system is displayed in a
hierarchical tree and list view. The directories are displayed on the left-hand side of
the screen. The list on the right-hand side shows the content of the directory that is

selected.
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Upload

Selecting one or more NC data files in the right-hand window and clicking the
Download key triggers the upload to DNC.

All of a directory's NC data can be downloaded again by selecting the appropriate
directory from the tree.

Note

It is not possible to download all NC data files and all subdirectories
simultaneously by selecting a directory.

Deletion

Selecting an NC data file and then clicking the Delete button will delete the file
from the machine.
Multiple selections can be deleted simultaneously.

Configure view of SINUMERIK 810D/840D1/840D

The directories visible to the user on the control can be configured in the
SINUMERIK 840D machine configuration dialog.
See also: Chapter 10 Configuration dialog.
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4.3 Version management and release/trial cut identifiers
4.3.1 Version management

General

DNC enables the user to parameterize the maximum permissible number of NC
data versions to be stored.

Machine-specific version management uses version ranges to define the hierarchy
level at which NC data with the same name (same name, same type and same
version) are permissible.

Up to n NC data with the same name and type may occur in one version range,
provided they have different version numbers.

The default setting is n=5. This value can be changed on a project-specific basis.

Note

There must be no more than one released version within a version range.

Machine-specific version management

Machine-specific version management defines where NC data of the same name

may occur:

e Group box: NC data with the same name must be unique within a group.

¢ Machine: NC data with the same name may occur on different machines.
However, names must be unique on each individual machine.

Note

Release and version searches are performed only in the selected version range
in each case.

See also: Chapter 10.5.4
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“Delete Version” dialog
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If the number of versions exceeds the maximum permissible parameterized
number, then the Version dialog box, in which all stored versions and their main
properties are displayed, will appear. One of the listed versions must be deleted.
« The version displayed against a gray background has been released and

cannot, therefore, be deleted.

« Versions in the copy list (menu item: Copy or Cut) are marked.

Verzion-Dialog ;

b aximurn count of versions reached,
delete an old wersion from the lizk below |

M ame : iDUS#_EancamDMDtDr_EEIEIEI

Type tPF
Yerz, | Modificationdate * | R... | T.. _!_ Comme
2 06.15.00 04:00: 36 pro 1] 1]
3 06.15.00 04:00:38 pra 1] 1]
4 5. 15.00 04:00: 40 i
A 0E.15.00 04:00: 42 pm 1] 1] i Copyl
1] | i

Delete I

Cancel |

Fig. 4-13 Version dialog
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Edit NC data

Modified NC data can be stored as follows depending on the configuration:
¢ Unchanged version and unchanged identifiers
« If the next free version is assigned, it obtains the edited version’s identifier.

Manual import of NC data

One of the following applies depending on whether the NC data files are imported
with or without header data:
¢ Without header:
If NC data of the same name, type and version already exist, the next higher
version is assigned to the import data.
¢ With header:

e If an existing version is specified in the header for NC data of the same
name and type, the importer must acknowledge import of the data before
they can be transferred.

« If the header for NC data of the same name and type does not specify a
version number, then the next higher number is assigned to the imported
data.

Upload NC data from the machine

When NC data are uploaded, a version is assigned depending on the configured
version strategy.

One of 6 strategies can be selected (see also: Configuration — Version strategy
during upload).

Paste NC data

If NC data are integrated by means of a Cut/Paste or Copy/Paste operation, the
next free version is assigned to them if NC data of the same name, type and
version already exist.
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4.3.2 Release/Trial cut identifier

General

For version management, DNC uses two identifiers:
* Release identifier: NC data have been released (approved) for production.
e Trial cut identifier: NC data must still be tested before they can be released.

Edit/store NC data

The parameter settings in database table DNCGLOBALSETTINGS determine how
edited NC data are stored. There are two possible store options:

e Store with the same version

e  Store with the next-higher version (default).

The release and trial cut identifiers are adjusted according to the selected store

option:
e If the data are stored with the same version, the existing identifier remains
unchanged.

¢ If the next free version is assigned, it obtains the edited version’s identifier.

Import NC data

One of the following applies depending on whether the NC data files are imported
with or without header data:
e Without header:
The imported NC data are not released.
e With header:
+ [f the header contains an identifier, then this is valid.
< If there is no identifier set in the header, then the imported NC data are not
released.

Upload NC data from the machine

When NC data are uploaded, the release identifier is assigned depending on the
configured version/identifier strategy in the DNCGLOBALSETTINGS database
table.

One of 6 strategies can be selected (see also: Chapter 10.3.2); the default is
strategy 1.
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Paste NC data

When you paste NC data, the release identifier is reset and the modification
date is updated. The version may also be increased (see below) to the next-higher
free version. All other NC data properties remain unchanged.

NC data from Cut/Paste or Copy/Paste operations retain their version within the
relevant node environment only if they are pasted to another group, which does not
contain any NC data file of the same name, type and version. When they are
copied/pasted to the same group, the version is increased to the next-higher free
version number.

See also: Machine-specific version management.

Note

If the parameterized maximum number of versions is exceeded, the "Delete
Version" dialog is displayed to allow you to delete an old version.
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4.4 DNC Compare

DNC Compare provides two functions:
¢ Match NC programs
e Match machines for SINUMERIK 840D/840Di/810D

4.4.1 Match machines for SINUMERIK 840D/840D1/810D

General

The "match machines" function can be used only if the DNC Compare option is
installed. A separate copy must be purchased for each installation.

The purpose of the "match machines" function for SINUMERIK 840D/840DI1/810D
is to check whether the NC programs on the machine match the corresponding
programs stored in DNC.

This function can be used only for SINUMERIK 840D/840Di or 810D with the
PCU50/70 operator interface.

Note

The “match machines” function requires additional configuration settings. For
more detailed information, please refer to Chapter 10 - Configuration.

Perform a machine match

You can match single machines or machine groups.

To do so, select a machine with the SINUMERIK 840D/840D1/810D transmission
module and select Machine Alignment->Compare.

If you select a group, the match machine process is performed for every machine
with the SINUMERIK 840D/840D1/810D transmission module.

The comparison result for each machine is saved to a file and remains there until
the machine is next matched. The file name matches the name of the machine
configuration file with the extension TXT. All these files are stored in directory ...
DNC\CmpResult.

Note

The date and length of the file are compared, but not the content.
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Display the comparison result

Select the relevant machine, which has already been matched. Select Machine
Alignment 2> Display Result to display the result file for the machine.

Table 4-3 Sample file of a comparison result

13.11. 2000 11:13:46
MACHI NE44

NC data i n machine only
MPF. DI R
CYLI NDERHEAD4713. VPF
DRI VI NGGEAR4713. MPF
mpf . di r\ DPWP. | NI
SPF. DI R
CUT- OFF- CYCLE. SPF
FI NE- GRI NDI NG- CYCLE. SPF
VKS. DI R\ GEARBOX4713. WPD
VKS. DI R\ GEARBOX4713. WD\ GEARBOX4713. MPF
VKS. DI RA GEARBOX4713. WPD\ GEARBOX4713. SPF

NC data in DNC systemonly
4- VALVE- CYLI NDER- HEAD 2. MPF
CUS_1. ARC
GEARBOX0815\ GEARBOX0815_1. MPF

Di vergent NC data
6- VALVE- CYLI NDER- HEAD_ 3. MPF
GEARBOX4712_1. SPF

GEARBOX0815\ GEARBOX0815_3. SPF
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The NC data single comparison function can be used to compare two NC data files
(e.g., a modified/optimized NC program with the original NC program).

Changes are highlighted in color and the number of changes is displayed. NC
program block numbers can be suppressed.

E Filecompare !E
P1_6.MPF F3_2.MPF
1 %_H_P1_MWPF 1 %_N_P1_HWPF ii
2 :$PATH=-_W_MWPF DIR 2 : $PATH=~_N_MPF_DIR
3 WO E_HEAD(268439551,0..0..0.,150.
3 WO E_HEAD(268439551.0..0..0..1
4 W5 E_TS({"'FRAESER20", "FRAESER10".1 | 4 N5 E _TS("FRAESER20", "FRAESER10
g Wi0 GO0 G90 X-12. V-12. ;#5M g Hi0 G0 G90 ¥-12. ¥-12. #SM
3 W15 GO 390 Z-5. ;#SH & W15 GO 90 Z-5. #SH
7 W20 Gl 90 G41 ¥5. ¥5. 94 F100. 7 W20 G1 G90 G41 E5. Y5, G94 F1l0
g W25 G111 X30. ¥75. #S5H g W25 G111 X30. Y75, #5H
9 W30 Gl RP=20. AP=176. #SH 9 W30 G1 RP=20. AP=176. #SH
10 W35 G2 AP=90. ;#SH
11 W40 Gl 90 X120. :#5SH 10 W40 G1 G90 X120, #SM
12 W45 G111 X120, Y75, #SH 11 W45 G111 X120, ¥75. [ #5M
13 W50 G2 AP=4. #SH 12 W50 G2 A&P=4. #SH
14 W55 Gl 90 X145, ¥5. :#SH 13 W55 G1 90 X145, ¥5. #SM
15 W&l G1 G90 X-20. #5M 14 Hel G1 G950 ¥-20. #5H
16 M30 ;#SH 15 M30 ;#SH
|| 3 | KA _'l_I
oK | & NEXT | 9 PREV WAELL
| Leftorly | Moved | Right onky  [TotalLines : 17 |DifF: 3 [ Vv
Fig. 4-14 NC data single comparison
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4.5 Archiving (manual)

4.5.1 General

You can archive single machines or machine groups. Manual archiving uses the
same configuration data as automatic archiving (see also: Chapter 12 > Auto
Archive).

To do so, select a machine with the SINUMERIK 840D/840D1/810D transmission
module and select menu options Machine Alignment->Archive.

If you select a group, archiving is performed for every machine with SINUMERIK
840D/840D1/810D.

Each time it is started, archiving creates or replaces a comparison result in a file.
This file is found in the directory ... \DNC\CmpResult. Its name comprises the
name of the machine followed by " AArch.txt".

Note

In order to execute the Archive function, DNC IFC SINUMERIK must be installed
on the machine with SINUMERIK 840D/840DI/810D.

4.5.2 Comparison results

The result files are in English and the following results are listed:

e Group and machine name (listed in order)

e Date (at beginning and end)

* An "NC Data in machine only" area, under which files are listed that have been
found on the machine only.

« A"different NC data" area, under which machine files are listed, which deviate
from the corresponding files in the DNC system.

e The "NC Data in DNC system only" area, under which files are listed that have
been found in the DNC system only, but are not on the machine.

Note

This section is generated only when start parameter "SHOW_FILESONDNC" is
set. The Auto Archive identifier is set to 2 for NC data included in this section and
located in the upload directory.

On completion, the end result indicating whether any archive errors have occurred
and the number of archived files is also displayed.

Note

If no errors have occurred and this machine is configured for archiving, all
differences are reduced.
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4.6 Data organization

4.6.1 Database

General

DNC organizes its data in the following manner:

The management data are organized in the database.

The database of the local DNC Cell is MSDE or SQL server

The database of the DNC Plant server version is MSDE or SQL server.
Another option is to use an Oracle database.

The actual NC data files are managed in the file system.

Database structure

The DNC database is administered in the following tables:

NODETABLE (plant configuration together with
DNCNODEINFO)

DNCNODEINFO (plant configuration together with
NODETABLE)

DNCDATA (management of NC data)

DNCDATATYPE (file type management)

DNCWORKPIECE (management of workpieces)

DNCGLOBALSETTINGS (global settings such as version strategy,
etc.)

DNCLISTDESCRIPTION (description of list display)

DNCFORMDESCRIPTION (description of screen display)

DNCTABLECOLUMNNAME (language-specific translations in DNCDATA
columns)

DNCFILTERHEADER (management of individual filters)

DNCFILTERCOLUMN (management of individual filter criteria)

DNCFILTERASSIGN (management of filter assignments)

DNCLOG (log book)

USERGROUPBASETABLE (management of users in MCIS)

USERGROUPPERMISSIONTABLE "

USERBASETABLE "

USERPROFILETABLE "

PRODUCTTABLE (management of installed MCIS products)
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DNCDATA *

BESEE
NODETABLE * | |nopem
7 [MODEID f | |ncoatanamE DNCDATATYPE *
" |MoDETYPE L DNCDATATYPE I E——————pr DNCDATATYRE
| |mopEmamE | |veRsION H CRDERMLM
PARENTID WORKPIECE
" |mopEIcon || TRIALCUTID
| |mopEoPTIONS | |RELEASEID
| |PropucTs | |LEnGTH
TREECRDER LOADCOUMTER
— - |LasTLOAD
T |LockuaME
| DEVELNAME
| |cEvELDATE
| MODNAME
 |MoDDaTE
| aDMINMaME
| apMINDATE
- |LoaDD
- |LoADORDER
- |auToRRCHLY
Fig. 4-15 Database structure of machine, NC and NC type data

Global settings

System-wide setting data are managed in database table
DNCGLOBALSETTINGS:

FBDN1/4-76

Maximum permissible number of versions

Version strategy for uploads

Version allocation after editing (old/new version)
Machine-specific version management

Maximum number of NC data blocks, which can be displayed.
Invalid characters for NC data identification
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List description

Database table DNCLISTDESCRIPTION determines the layout of the list display

as a function of the display group.

The fields contained in the NC data management table can be defined for each
display group for the list display in the right-hand screen window on the DNC
interface in accordance with the following criteria:

¢ Order of fields

¢ Display column width

Note

DNC provides the List Editor (see also: Configuration), in which the list display
can be created and edited.

Only configured fields are displayed.

i are | § | Type | '\-*er&i-:nl Felease Id.l Trial-:ulil:ll Lenath

0033 Flangia motare ’ 2 F10

fine-gnnding-cycle SPFF 3 0 0 ED

ke ayp-rilling-cycle 5PF 3 a 0 GO
rmotor

Fig. 4-16 Variant of list display on operator interface

Screen description

Database table DNCFORMDESCRIPTION stores the layout information for screen
(form) displays of the NC data properties dialog as a function of the display group.
The fields contained in the NC data management table can be defined according to
display group for the screen display of the NC data properties. These include:

« Assignment of database fields to particular tabs in screens

¢ Positioning of field contents on screen

« Definition of output field type

Note

DNC provides the Screen Form Editor (see: Configuration), in which the
Properties screen definition can be created and edited.
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Plant configuration

Database tables NODETABLE and DNCNODEINFO determine how the plant
configuration is displayed.
DNCNODEINFO contains additional configuration data for the various nodes.

NC management data

Database table DNCDATA describes the NC management data. It includes
branches to the NODETABLE and DNCNODEINFO tables in relation to the plant
configuration, as well as branches to DNCDATATYPE, with reference to the data

type.

The following database fields are configured by default:

Table 4-4 Database table DNCDATA

Database field Description Field length and type
NCDATAID Internal database field Long integer
NCDATANAME NC data name 40-character string
DNCDATATYPE NC data type 3-character string
VERSION Version number of the NC data Long integer
NODEID* Internal database field Long integer
WORKPIECE** Workpiece 40-character string
TRIALCUTID Trial cut identifier value Long integer
range 0/1
RELEASEID Release identifier value range 0/1 | Long integer
LENGTH Length of the NC data Long integer
LOADCOUNTER Number of accesses Long integer
LASTLOAD Date/time of the last transfer operation Date/time
LOCKNAME Locked by the user... 32-character string
DEVELNAME NC data developer 32-character string
DEVELDATE Date of development Date/time
MODNAME NC data modifier 32-character string
MODDATE Date of maodification of the NC data Date/time
ADMINNAME Administration data modifier 32-character string
ADMINDATE Administration data modification date Date/time
LOADID Load identifier value range 0/1 | Long integer
LOADORDER Load order for workpieces Long integer
AUTOARCHIV Identifier indicating whether data have Long integer

been uploaded via the auto archive
function

* Foreign key for NODETABLE database table. The name of the node is
determined via this key.

** As ¥, if the NC data belong to a workpiece.

Note

Variable fields for specific projects can be added to the table.
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NC data type conversion

Database table DNCDATATYPE contains all the file types permitted by the
configuration.

Table 4-5 Database table DNCDATATYPE

DNCDATATYPE ORDERNUM Description
MPF 1 MainProgramFile NC main program
SPF 2 SubProgramFile NC subprogram
TOA 3 ToolOffsetActiv._ Tool offsets
ZOA 4 ZeroOffsetActiv_ Zero offset
RPA 5 R-ParameterActive Memory area for R parameters in the
NCK
WPL 6 WorkPLan ASCII file for tool diagrams
JOB 7 Job Order lists
BMP 8 BitMaP Graphics file for clamping drawings, etc.
ARC 9 ARChive Archives
INI 10 INItialization Initialization program
COM 11 COMment Comments
AWB 12 Display description
LST 13 Display LiST Display list
TOP 14 TOolPlan Tool plan
CEC 15 Sag/angularity
EEC 16 Measuring system error compensation
QEC 17 QuadrantErrorCompensation
Quadrant error compensation

Note

Other NC data types can be added to the table if necessary.
The WPD data type must not be used!

Management of workpieces

Database table DNCWORKPIECE manages workpieces. It defines the location of
each individual workpiece in the plant topology.
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User management

User management is shared by all MCIS programs.
Users and user groups are defined and users are assigned to user groups for this
purpose.

The following settings are DNC-specific:

Display group

The list and screen layout of the display group selected by the user are
displayed on the operator interface. The display group must be assigned to a
user group.

Starting level

The starting level defines the tree structure view and is user-specific.

Station assignment

Station assignment is only evaluated for the server variant.

Display size of operator interface

Management of filters
Database table DNCFILTERHEADER is used to manage individual filters.

It is structured as follows:

FBDN1/4-80

FILTERNAME contains the unique filter name.

FILTERCOMMENT defines the comment.

TABLENAME defines the table, to which the filter belongs (DNCDATA or
DNCLOG).

USERNAME defines the name of the user, for whom the filter was configured,
or who created the filter.

USERGROUPID defines the user group, for which this filter was configured.
DISPLAYGROUP defines the display group, for which the filter was configured.
STATION defines the station, for which the filter was configured.
APPLICATION defines the application, for which this filter was configured.
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Management of filter criteria

Database table DNCFILTERCOLUMN is used to manage individual filter criteria.
This table contains a data record for each filter criterion. There are thus x data
records in DNCFILTERCOLUMN for each data record in DNCFILTERHEADER.

It is structured as follows:

FILTERHEADER_ID is the assignment of a criterion to a filter in table
DNCFILTERHEADER.

ROWNUMBER defines the order of criteria as they are viewed in the filter
criteria dialog.

COLUMNNAME defines the filtering column name.

TYPE defines the data type of the column name. Possible types are, for
example, date, integer, flag, character, etc.

OPERATOR defines the operator (equal to, not equal to, greater than or equal
to, etc.).

CONDITIONVALUE defines the filtering value.

FLAGS specifies whether this criterion is activated or not (tick in checkbox in
filter criteria dialog).

Management of filter assignments
Database table DNCFILTERASSIGN is used to manage filter assignments.

It is structured as follows:

FILTERASSIGN_ID is a system-internal variable, which is assigned
automatically.

FILTERHEADER_ID is the assignment of a criterion to a filter in table
DNCFILTERHEADER.

NODEID is used to assign a filter to a machine for DNC IFC SINUMERIK.
STATION defines the station, for which the filter was configured.
TABLENAME defines the table, to which the filter belongs (DNCDATA or
DNCLOG).

USERNAME defines the user, for which this filter was configured.
APPLICATION defines the application, for which this filter was configured.
SUPPLEMENT1

SUPPLEMENT2

Language-specific translations of column names of database tables

Database table DNCTABLECOLUMNNAME contains the language-specific
translations of the columns in table DNCDATA. This table is used for the Filter, List
Editor and Screen Editor functions.

The table is structured as follows:

Assignment between the data block and a table

Assignment between a data block and a column name in the table
Language code (GR, UK, FR, SP, etc.), which assigns the data record to a
language

Translation of column name to the relevant language
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4.6.2 File system

The file system is a mirror image of the plant configuration:

The DNC configuration elements Group, Machine, Link, and Workpiece are stored
as directories in the file system and the NC data as files. The directory structure of
the file system is analogous to the tree structure in the left-hand window of the
operator interface.

£+ DNC - Terminall

File Edit ‘“iew Options Machine dlignment Help
(@] & BB« X b v
| Filter =]

J Address
S M arne [+ L Twpe |ve

e ﬁ area motors _ E-valve-cylinder-head # MFF
B {1 group B cylinders cub-off-cycle SPF
N S— macE!ne gi-fr fine-grinding-cucle SPF
............. mal:hlne Sa-ip E Plcture_l BMP
s = Picture] “ BMP
machine 44-en E T TOA

e machine 49-dt |'= " .

B group 8 cylinders valve-cylinder-head MFF
machineg 1 =] Zo2 204
maching 2 Q cylinder-head

Ezl .......... .ﬁ area gea[
1| | ]

| T 2

Fig. 4-17 Tree structure on operator interface

Table 4-6 Standard directory icons

D

Group g Workpiece

Machine (serial unsecured NC file

transmission)

Machine with transmission module ﬁ] NC file with comment (analogous
"SINUMERIK 810D/840DI/840D" to: SPF, etc.)

Network file systems

Link

w i E
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Group/Machine/Workpiece

NC data

Link

These organization units of the plant structure are represented by directories in
the file system. Groups can contain subdirectories in the form of groups, machines
and workpieces. Workpieces can be stored under machines as subdirectories. All
folders can contain NC data files.

This directory structure can be found in the NC data master directory. The NC
data master directory is stored in the Data subdirectory (in the data directory),
which you specified when you installed the system.

Example: C:\Siemens\MCIS\DNC\Data

The actual NC programs, subprograms, tool setting data, graphics data, etc., are
files in the file system; the associated management data are stored in the
database. NC data can be stored in all directories of the DNC system (group,
machine and workpiece).

The file name of an NC management data record comprises the NC data name,
the version number and the NC data type.
Example: Data name_13.MPF

Links provide visual access to the files in the linked directory. Users with the
appropriate access rights can use these files as if they were stored in the DNC
NT-2000 file system.
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4.7 Consistency check

4.7.1 General

The purpose of the consistency check is to find and eliminate any inconsistencies
between the existing NC management data sets in the database and the NC data
files in the DNC file structure.

A quick consistency check is performed every time you start DNC Admin. An
inconsistencies message window will appear if any inconsistencies are detected.

Inconsistencies can occur, for example, if you load an older backup of the
database so that the database contains either too many or too few entries.

Inconsistencies should not occur in "normal operation". Normal operation means
that the database is not exchanged and that the DNC file structure is modified only
by DNC. However, should inconsistencies be detected regularly, please call our
helpline.

Note

With the DNC Plant variant, we recommend that you perform the consistency
check/debugging routine on the server as the check routine covers all existing NC
management data of all groups and machines.
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4.7.2 Consistency check on DNC Admin startup

The consistency check performed on DNC Admin startup counts all the files in the
DNC file structure. This number of files (see Fig. 101 NC data files) is compared
with the number of NC database entries (see Fig. 96 NC management data
records). The message box below appears only if these two values are different.

DNCAdmn |

95 ML management data blocks but
101 MC data files.

Fig. 4-18 Consistency check at DNC Admin start

Note

Since only the number of files is checked, inconsistencies can still exist even if
the message box does not appear. If you wish to ensure that all inconsistencies
have been eliminated, you must open the consistency check dialog (see below).

4.7.3 Consistency Check dialog

The Consistency Check dialog displays a list of all inconsistencies detected and
indicates means of eliminating them.

Note

The Consistency Check dialog display is not rebuilt until you open the dialog. This
means that any changes (debugging) not performed in this dialog will not be
visible until you close and the reopen the dialog. Switching between the dialog
options described below does not cause the consistency to be checked again, as
this would cause long delays if you were working on a large installation.
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Missing files

Consistency check result |

Mizzing fles

clziemensimeizidncidatalarea gearslautomatic gearlaasas_1 .mpf

chsiemens\meisidncidatalarea gearslautomatic gearblablabla_1 mpf
chziemenzsimcizidnc\dataiarea gears\automatic gearimachine 1bohringen_authingung_122_1 =spf
cziemens\meiztdncidatatarea gearslautomatic gearimachine 1 weellekhbd?11 _1 mpf
chsiemensimeiztdncidatalarea gearslautomatic gearimachine 1khbt3_1 mpf
chziemenzsimciztdnc\dataiarea gears\automatic gearimachine 1motor_z2_1 mpf

— Congigtency optioh:

____________________________ \ Delete |
= iMiszing files " Miszsing DB entries for directornies
[Ereate |
' Migsing database entries = Wizsing workpiece in WP table
Ext |
Fig. 4-19 Consistency Check dialog: Missing files

This dialog displays management data records, from which the file is missing.

The complete path, from which the file is missing, is displayed. This path comprises
the NC data master directory (in this example: C:\DNC\Data) and the
subdirectories for group, machine and workpiece. The file name of an NC
management data record comprises the NC data name, the version number and
the NC data type.

Example: Data name_13.MPF

You can delete selected management data records from the database by clicking
the Delete button.

You can also use the Microsoft Explorer to insert the missing file at exactly this
location. The file name is not case-sensitive. If you choose to use this method, you
must close and then reopen the Consistency Check dialog to remove the
inconsistency from the dialog.
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Missing database entries for NC data

Consistency check result

Mizzing databaze entries

c=iemensimeizidneidata harea motorsharoup B cylindershmachine 43 dismotor_z2 7. mpf
cheiemensimcisidncidatatarea motorshgroup B cylindershmachine 39_ithcastro_7.mpf
oigiemensimoizidncidata harea maotarzaroup B cylindershmachining centrebclamping zetup_1.mpf
cheiemensimcisidncidatatarea motorshagroup B cylindersimachining centrebcut-of-cycle 4. zpl
chmiemenzimcisidneidatatarea motorsgroup B cylindershmachining centrebcylinder. cts

o siemensmoizidncidata harea matars\agroup B cylindershmachining centrebclamping setup_ 2. mpf
ohgiemensimoizdncidataharea motorzsmotorh4-valve-cylinder-head_12 mpf

— Caonsistency option;

Delete |
" Miszing files £~ Mizsing DB entries for directories
Create |
% Mizzing database entries = tizsing workpiece in WE table
Est |
Fig. 4-20

Consistency Check dialog: Missing database entries for NC data

This dialog displays any files contained in the NC data master directory without a
corresponding management data record in the database.

The complete path of the file without a management data record is displayed.

You can delete selected files from the NC data master directory by clicking the
Delete button.

You can create a management data record for the file by clicking the Create
button. The Properties dialog is displayed for each file.
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Missing database entries for directories

Consistency check result |

Mizzing DB entries for directaries |

emensimoizidncdatahare

chsiemensimcisidnchdataimporttest

— Congigtency optioh:

a r|'||:|t|:|l:5:"-.|r|:||_1 1 3 eylinderstmachine 37 ©

Delete |
€ Migsing files % tdizsing DB entries for directones
[Ereate |
' Mizsing database entries £~ Wizsing workpiece in WP table
Est |
Fig. 4-21 Consistency Check dialog: Missing database entries for directories

This dialog displays directories contained in the NC data master directory, but not
in the database as a group, machine or workpiece.

The complete path is shown.

You can delete selected empty directories from the NC data master directory by
clicking the Delete button.

Empty directories that contain no files are identified by an "*" after the directory
name. You will only be able to delete directories identified in this way.

To eliminate the inconsistency, you can also create a group, machine or workpiece
of the same name using DNC Admin in configuration mode.
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Missing workpieces in the database workpiece table

Consistency check result
Group § Machire I work piece I
HG1WUGET_HGTh1 rrakar

— Caongigtency optior:

[Velete |
£ Mizsing files ™ Migsing DB entries for directories
Create |
" Mizsing database entries % tdicsing workpiece in WP table
Est |
Fig. 4-22 Consistency Check dialog: Missing workpieces in the database workpiece table

The optional "Missing workpiece in WP table" button is activated only if
inconsistencies have been detected in the workpiece data.

Note

If inconsistencies in workpieces do occur, we recommend that you eliminate the
"missing files" inconsistencies before you correct the workpiece inconsistencies.

A workpiece inconsistency will occur automatically if you try to use an MCIS
database from an earlier version of DNC. You can also use this dialog to update
your older 2.x version database for workpiece data. To do this, select all your
workpieces and click the Create button to update the database.
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Notes
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5.1 Structure of user administration

User-specific data are defined using the user administration settings under
Options>User Management. This function is available only in DNC Admin and
can only be accessed by authorized users. Each user must be assigned to a user
group.

User groups

A user group combines users with the same user rights and the same display
group. This means that each individual user within a user group has the same DNC
user rights and the same list and screen display.

Users

Users must be configured with a password to permit individual access to the DNC
software. Other special parameters are assigned to each user (see also: Chapters
5.2,5.3).
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5.2 Manage user

5.2.1 General

When starting user administration, all user names are displayed in a list together
with their user group, language and product.

When you click on Change and New, a dialog for managing users appears in
which you can edit existing user data or define a new user. The selected user can
be deleted using the Delete button. User-specific filter assignment can be carried
out with the Assign Filter button.

M ame | qroup I language | product selection |

dnc ADMIM GR ]

Helper IJSER GR ]

Prograrmmner PROG 1K OMC

Test ADMIMN GR DHE Mew
Work.er IMFO GR ]

Delete

Azzign filter |

Fig. 5-1 Overview of existing users
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5.2.2 Create new user/Change user properties

The user definition dialog is called using the New or Change button on the user
screen. A new user can then be created, or the properties of a selected existing
user can be edited. The following parameters are available:

¢ User name

¢ Full name

¢ Access password

e User group, to which the user belongs

« Language (only relevant for MCIS Web)
¢ Product (only relevant for MCIS Web)

e Area to be displayed

The MCIS module (product) is predefined on the DNC.
The operator interface big view and the filter can be activated via two checkboxes.

Uszer [ ] |
User name: IF'n:ngrammer ok I
Caomplete name: ILDgin for programmer Cancel |
Faszword: I’“‘“

Confirm pazssword: I“““
Ilzer group: IPHDG j
|lzer groups
Languange: K -
Praduct: DMC v
Area displayed: I j
Filter active: v Large displaw: |

Fig. 5-2 Screen for creating or editing users

User name

The user name is the DNC login name.
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Full name
To specify the user name in more detail, extra text can be entered in the Full name
input field. The text can only be viewed here.
Password
The password identifies the user and is required to log on. For added security, the
password must be confirmed in the Confirm password field.
Note
A DNC user with administrator rights is always defined prior to delivery.
Before first use, a new administrator should be created and the DNC user deleted
or at least a new password entered.
User group
An existing user group can be selected for the assignment of user rights and the
display group in the User group selection box. If no user group with the desired
access rights or the desired display group exists, a new user group will need to be
created. The dialog for creating or editing user groups is selected using the User
Groups button.
See also: Managing user groups.
Language
This setting is only relevant for MCIS Web.
The language selected in the selection box is set once MCIS Web has started up
and the user has logged on.
DNC is available in the following languages:
e GR > German
e« FR > French
e IT > Italian
e SP - Spanish
e UK > English
e RU > Russian
e CH > Chinese
Product

This setting is only relevant for MCIS Web.
The MCIS module selected in the selection box is called once MCIS Web has
started up and the user has logged on. At present, DNC is the permanent default.
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Area displayed

The combo box for the displayed area controls the user's view of the tree structure.
The view can be restricted to any group or subgroup from across the plant.

If no selection is made, the entire plant is displayed.

Selecting a group or subgroup means that only that restricted area is displayed for

the user.

Filter active

If the Filter active box is checked, then the last filter assigned or used by the
relevant user is activated on logon.

Note
If no filter has been defined, this user has an unfiltered view of all NC data.

Large display

The Large display checkbox controls the display size of icons and text on the
operator interface. For users working in the factory, the big view option can
improve screen visibility at greater distances.
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5.2.3 Filter assignment for a user

Filter aszsignment

E3
Uzer | filter name | application | zkation | machine | Cloze I
DT MPF Filter DMCIFC ... b achine:
DMC SPF Filker DMC Admi... - Delete |
1 M achine:
siemens SPF Filter DMC -
ziemens SPF Filter DMC Admi...

Table
zelection

Filter name : IMF'F B j Pogsible users - i
~DNC DLE
[ oHE Statian: [ helper . Change
. [ HKIE.eyPasitiond
 DriC fehuin =1 | O HmikeyPosiiont fosept

~DNC IFC SINUMERIK
% | D I S [l Machine2

[ HMIE.eyPasition2

HbdlE.epPozition3 il
1 | E

[Fance]

Lk

Fig. 5-3 Filter assignment

The filter assignment is made via the Options>User Management menu option
and Assign Filter button.

Filter assignment can be used to assign a filter to users. The assignment can be
made for the normal DNC operator interface, and for the DNC Admin program, as
well as for machines with DNC IFC SINUMERIK.

You can create, edit or delete filter assignments using the filter assignment dialog.
The dialog screen is divided into two sections:

In the top section you select or delete an existing filter assignment. Use the "Select
Table" button to select the database to which the filter assignment is to apply.

In the lower section you can edit or create assignments.
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Table Selection

The filter assignment database is selected using the Table selection button. You
can choose one of the following two databases:

¢ Management data (NC management data)

* Log data (management of all errors and messages)

Delete filter assignment

To delete a filter assignment, you must first select the assignment to be deleted
and then click the Delete button. You can only select and delete one filter
assignment at a time.

To select a number of filter assignments, first sort the list so that all assignments to
be deleted are listed one after the other. Select the first entry to be deleted, then
continue through the entries until they have all been deleted.
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Add or change a filter assignment

One or a number of new filter assignments can be created by clicking the New
button. When you click the Change button, the selected filter assignment changes
and one or a number of new filter assignments may be created.

The following settings must be made:

Select the filter name

The names of the users who are entitled to use the filter are then displayed in
the list of possible users. Access may be restricted to just a few users
depending on how many limits you set when you configured the filter. (see
also: Create or edit a filter).

Assign a user
You must activate the corresponding checkbox for each user to which the filter
is to be assigned.

Select application(s)

After you have selected at least one application (DNC IFC SINUMERIK, DNC
or DNC Admin) in which the filter is to be assigned to the selected users, you
must choose an entry in the combo box on the right.

DNC/DNC Admin

If you leave the DNC and DNC Admin Station name combo box empty, the
filter assignment will apply to all stations. Entering a station restricts the filter
assignment to this station only.

DNC IFC SINUMERIK

If you select a group for DNC IFC SINUMERIK, a filter assignment is created,
or an existing assignment edited, for all SINUMERIK 810D/840D1/840D
machines in this group.

Accept data
New filter assignments are created, or existing assignments edited, when you
click the Accept button.

Note

There can only be one filter assignment per user, application (DNC IFC
SINUMERIK, DNC and DNC Admin) and machine or station. This means that if a
filter assignment already exists and a new one is defined nevertheless, the old
filter assignment will be replaced with the new one. This process is automatic.
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5.3 Manage user groups

5.3.1 General

When the user group administration is launched, all user groups and a comment
are displayed in a list.

When you click Edit and Change, a dialog for managing user groups is displayed
in which you can edit existing user group data or define a new user group. A

selected user group can be deleted with the Delete button if all the users within this
user group have been deleted previously.

5.3.2 Create new user group/Change user group properties

User groups E |
M ame | Comment | Close |

ADAIM adminiztrator groug
IMFO only dizplay rights
IISER Lzer

Delete

Mew

Fig. 5-4 Overview of existing user groups

The user group administration dialog is accessed via the User Groups button in
the Create User/Change User Properties dialog. A new user group can be created
here, or the properties of an existing user group can be edited.

The following user groups are defined in the standard version of DNC:

¢ Administrator ADMIN
e Users USER
* Information user INFO
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Uszer group E |

M ame: IF'FH:IG

Cancel

Comment: IF'ru:ugrammer graLp |

|Jzer rights - Dizplay graup

Configure/plan

Create MC data and workpieces
Import MC data

Ewport MC data

Change MC management data

[¥] E dit MC data -
al | _>I_I

Fig. 5-5 Screen for managing user groups

e GROUPAD =]

Caution

Any changes made to the properties of a user group affect all users within the
group.

The following data has to be entered to create or edit a user group:

5.3.3 Name of user group

The name of the user group is shown in the user group overview
and in the dialog for creating or editing a user.

5.3.4 Comment

The comment is shown in the overview of all user groups and provides more
detailed information about the user group.
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5.3.5 User rights

The purpose of assigning user rights in this screen is to enable or disable menu
options in DNC or DNC Admin for users in the relevant user group.

Configure/Plan

Check this box to authorize the user to switch to the DNC Admin configuring mode
for the purpose of configuring the system (View menu option).

Create NC data and workpieces

Check this box to enable the user group to create new NC data and workpieces via
the File > New menu option or via the popup menu.

Import NC data

Check this box to enable manual import of NC data for the user group (File menu
option).

Export NC data

Check this box to export NC data for the user group (File menu option).
Edit NC management data

Check this box to edit the NC data properties dialog.
Edit NC data

Uncheck this box to that only a read-only copy of an NC data file is opened when it
is selected. Users will not be able to make or save any changes to the original file.

Copy/paste NC data in NC data
Check this box to copy and paste NC data (Edit menu option and popup menu).
Copy/paste NC data in link

Check this box to copy and paste links (Edit menu option and popup menu).

Note

Both rights must be assigned for a user to be able to copy and paste data from a
link to management data or from management data to a link.
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Delete NC data

Check this box to delete NC data. The ability to delete versions in the Delete
Version dialog is not affected by this setting.

Cut NC data
Check this box to cut NC data files (Edit menu option and popup menu).
Download NC data with release ID

Check this box to enable a user is to download NC data (File menu option, popup
menu and icon in toolbar) with a set release identifier.

Download NC data with trial cut ID

Check this box to enable a user to download NC data (File menu option, popup
menu and icon in toolbar) with a set trial cut identifier.

Upload NC data

Check this box to enable a user to upload NC data (File menu option, popup menu
and icon in toolbar).

Compare NC data

Check this box to enable a comparison of two NC data files and enable Match
machines with SINUMERIK 810D/840DI/840D.

However, this function is only available if the DNC Compare option has been
installed.

Reset release IDs

Check this box to activate the Reset release identifiers function (with multiple
selections) in the Edit menu option and in the popup menu. However, you can still
set the release identifier for a single item of NC data file in the Properties dialog.
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Configure list descriptions

Check this box to enable the list editor to be called (Options 2 List Editor menu
option).

Configure screen form descriptions

Check this box to enable the screen editor to be called (Options > Screen Form
Editor menu option).

Configure user

Check this box to authorize the user group to call the user administration function,
to set up users and user groups, to edit rights, or to delete users (Options - User
Management in DNC Admin menu options).

Note

If you as a user deactivate your own Configure User right, you will no longer have
access to the user administration function.

Change options settings

Check this box to enable the user group to carry out changes in the Options >
Settings menu option, e.g., changing the language.

Perform consistency check

Check this box to enable the user group to perform consistency checks. The right
to perform consistency checks should be reserved exclusively for administrators,
as the consistency check dialog displays not only a list of any inconsistencies
found, but also specifies means of eliminating them (Options menu option).

Configure filter

Check this box to authorize the user group to create, edit and select filters (View
menu option).
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Chnage filter

Check this box to authorize the user group to change the value of filters (View
menu option). The change is only effective temporarily, i.e., until the user exits
DNC again.

Note

If the Configure filter right is activated, deactivating Edit filter will have no effect.

Select filter

Check this box to authorize users in this user group to select various filters (View
menu option). If, however, the group is authorized to Configure filters, then
removing its right to Select filters will have no effect.

Activate/Deactivate filter

Check this box to enable the user group to activate or deactivate filters using the
filter icon.

Cross-area filtering

Check this box to enable cross-area filters the user group.

5.3.6 Display group

The drop-down list for the display group is generated from the
DNCFORMDESCRIPTION form definition table in the database. All display groups
defined in this table are listed in the User Administration screen.
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Notes
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6.1 General information about the dialog function

The dialog function (DNC IFC Dialog) is optional. With machines connected via a
serial interface, data can be uploaded/downloaded directly to/from the CNC
machine tool. Dialog programs for requests (created by editor on the control
system) and responses are exchanged between the

DNC and the machine server. These programs contain the data relevant for the
upload and download operations.

If a machine is configured with a dialog function (see also: Configuration), in
contrast to the general operating mode, when DNC programs are started, the
relevant machine server is started and runs until the end of the program. This
means that unlike in the general operating mode, the defined interface is
permanently assigned.

To meet special requirements, an external dialog interpreter in the form of an
ActiveX DIl can be integrated in addition to the standard dialog interpreter.

Important

The following control requirements must be met:

* It must be possible to store at least two NC programs on the control system.

* An NC program editor must be available for creating an NC dialog program.

* The machine control panel must include the alphanumeric characters in the
chosen NC program name.

If one or more of the above requirements cannot be, the dialog function can
be used in combination with an additional input terminal (handheld).

—ud)

Fig. 6-1 Dialog function with additional terminal
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6.2 Dialog program

6.2.1 Program structure

DNC IFC Dialog evaluates the following lines from section [DIALOGFUNCTION] in
the machine configuration file:

Program number

Dialog function identifier
%MPF9999

Command program line

Dialog function command
(S), (ST); (SL) or (R)

File name program line

File name
¢ Name (character string)
¢ (Wildcard)

e X999 (dummy alternative for controls, which cannot edit all characters)

File type program line

File type
e Type (character string)
¢ (Wildcard)

* Y001 (alternative for file type on controls, which cannot edit all characters.
Y001 stands for MPF files in standard NCDATATYPE.)

The program end identifiers MO0, M17 and M30 are evaluated indirectly.

Note

You can configure this section of the machine configuration file using the Config
dialog, which is described in more detail in chapter Configuration > Configuration
dialog = Dialog Function tab sheet.
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6.2.2 Examples

Table 6-1 Example of a download request with configuration parameters set to defaults

Sample file Meaning
9%VPF9999 Dialog program
Request from the CNC machining unit
() Request for download of a released NC data file
( TEST_1) File name of the requested file
( MPF) File type of the requested file
MBO Program end identifier

Table 6-2 Example of a standard request for transfer of an NC data files list

Example Meaning
file
YVPF9999 Dialog program
Request from the CNC machining unit
(SL) Request for transmission of an NC data files list
X999 Wildcard substitute for "*".
Y002 File type SPF, because 2nd field entry in standard DNCDATATYPE
MBO Program end identifier
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6.3 Dialog program responses
6.3.1 Program structure

Program number

Identifier of a response to a formulated request
%MPF9998

1! to nth program line

e List (response to a list request)
« Error message (response to a request for a program that cannot be supplied)

Program end identifier
M30

6.3.2 Examples

Table 6-3 Example of a response to a standard list request

Sample file Meaning

9%8vPF9998 Response identifier to a formulated
request

(nane size...nodified on) List header

(cyhd_1. npf 24096 06.05.99 17:59:04) List content

(cyhd_2. npf 28116 10.05.99 08: 03: 40) List content

MBO Program end identifier

Table 6-4 Example of a response to a program request that cannot be fulfilled

Sample file Meaning

%VPF9998 Response identifier to a formulated
request

Cannot find requested data! Request: Zkpf_2. npf Error message

VBO Program end identifier
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6.4 Configuration parameters

The configuration parameters for the dialog function are defined in the machine
configuration files (.MCF) in section [DIALOGFUNCTION]. The standard
configuration parameters and their meaning are listed in the following table.

Note

You can configure this section of the machine configuration file using the Config
dialog, which is described in more detail in chapter Configuration > Configuration
dialog = Dialog Function tab sheet.

Table 6-5 Configuration parameters for the dialog function

Configuration parameter Meaning Default
setting
DigScanLines Number of lines to be scanned after a DIgID 10

parameter in the NC data file, starting with line 1.

DigID Identifier of a dialog program for a formulated %MPF9999
request
DigiDSend Identifier of a response to a formulated request. %MPF9998

The response might contain the following:

e List (response to a list request)

e Error message (response to a request for a
program that cannot be supplied)

DlgSendEnd Program end of a response (list, error) from DNC | M30
to the machine

DigSendCmd "Download released NC data files" command. (S)

DIigSendTcCmd "Download NC data with trial-cut identifier" (ST)
command

DigReceiveCmd "Upload NC data files" command. Two programs | ( R)

are sent in succession:
¢ Request program
¢ Program to be uploaded

DlgSendListCmd "Send a list" command. The identifier must be on | (SL)
the 1st line of the NC data file.

DigWpdMark Identifier for workpieces in the dialog program. If | WPD
the connected control system cannot edit all
characters, positional data or preparatory
functions (e.g., Z888 or G040) can be
programmed instead.

DigExchangeCNCType Identifier for file types in the dialog program. If the | Y
connected control system cannot edit all
characters, positional data or preparatory
functions (e.g., Y001 or G02) can be
programmed instead. In this case, the character
is identified via the Dialog section. The numerical
part of the identifier refers to field ODERNUM in
the database table DNCDATATYPE.

© Siemens AG 2005 All Rights Reserved
FBDN1/6-112 Motion Control Information System DNC (FB) - 04.05 Edition



04.05 DNC Plan / DNC Cell (FBDN1)
6 Dialog Function

Configuration parameter Meaning Default
setting
DigExchangedummy Wildcard alternative for controls, which cannot X999

edit ™" (e.g., in the case of list requests for lists of
all data types or file names).

DigConverter An external dialog interpreter can be configured DNCDIgl.DNCCntrl
via this parameter.

DIigSubNumber This parameter can be set to attach an additional |0
mode of interpretation to the external dialog
interpreter.
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Notes
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7 Code Conversion Function

7.1 Code CONVEISION .......cueeieeiiieiieee e
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© Siemens AG 2005 All Rights Reserved
Motion Control Information System DNC (FB) - 04.05 Edition

7 Code Conversion Function

7

................... FBDN1/7-116

................... FBDN1/7-117

................... FBDN1/7-118

FBDN1/7-115



DNC Plant / DNC Cell (FBDN1) 04.05

7 Code Conversion Function

7.1 Code conversion

General

DNC works with NC programs in ASCII code. NC programs are always uploaded to
and downloaded from the CNC machine tool in the code requested by the
machine. For this reason, code may need to be converted. The code conversion
server of the DNC system supports 3 types of code:

¢ ASCIl code
« |SO code
¢ EIA code

To be able to upload/download NC programs in a particular code, code conversion
must be implemented via a code conversion table, allowing characters to be
converted or filtered out individually.

Code conversion tables

The CODES.TXT file in the program directory contains all code conversion tables.
One table is defined for each code type and transfer direction. It begins with its
name, which consists of code type and transfer direction (OUT = download; IN =
upload). The table content is enclosed in { }. Each table line consists of a series of
assignments, with each input value assigned to one output value. An input/output
assignment string is structured as follows: #2A AA ™'

# First assignment character

2A Two-digit hexadecimal input value
Blank as separator

AA Two-digit hexadecimal output value

Blank as separator

Mnemonic as comment

2 blanks as separator

Characters can also be filtered out via the code conversion table. This is done by
entering FF as the output value.

Note

The offset must never be altered as this may result in initialization failures or
errors.

Note

There is only one CODES.TXT code conversion file per station.
Modifications to one of the six code conversion tables only affect machines,
which operate with the type of code defined in the modified table.
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7.2 Examples

7 Code Conversion Function

Users can use the code conversion tables to create their own machine-specific
code. To do this, a different output value is assigned to an input value in the ASCII

code conversion table.

Table 7-1 Modified ASCII code conversion table

Original Modified
code conversion table code conversion table
ASCI T_oUT ASCI | _ouT
{
#0D OD ' CR #0D OA ' CR
Table 7-2 Filtered out "CR" character in ISO code
Original Modified
code conversion table code conversion table
1 SO_ouT 1 SO_out
{ {

#0D 8D ' CR
}

#0D FF ' CR
}
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7.3 Code conversion tables

Table 7-3 Code conversion table ASCII_OUT

ASCII_OouT

{

#00 00 NUL #01 01 SOH #02 02 STX #03 03 ETX #04 04 EOT #05 05 ENQ
#06 06 ACK #07 07 BEL #08 08 BS #09 09 HT #0A OA LF #0B 0B VT
#0C OC FF #0D OD CR #0E OE SO #OF OF Sl #10 10 DLE #11 11 DC1
#1212 DC2 #1313 DC3 #14 14 DC4 #15 15 NAK #16 16 SYN #17 17 ETB
#18 18 CAN #19 19 EM #1A 1A SUB #1B 1B ESC #1C 1CFS #1D 1D GS
#1E 1E RS #1F 1F US #20 20 SP #2121 #2222 ™ #2323 (1)
#24 24'¢$' #25 25 '%' #26 26 '&' #27 27 " #2828 '(' #2929")
#2A 2A ™ #2B 2B '+' #2C 2C"'' #2D 2D '- #2E 2E " #2F 2F /'
#3030'0' #3131'1 #3232 '2' #33 33'3 #34 34 '4' #35 35'5'
#36 36 '6' #37 37'T" #38 38 '8' #39 39'9' #3A3A" #3B 3B ;'
#3C 3C '<' #3D 3D '=' #3E 3E '>' #3F 3F '?' #4040'@' #41 41 A
#42 42 'B' #43 43'C' #44 44'D' #45 45'E' #46 46 'F' #47 47 'G'
#48 48 'H' #49 49'' #4A 4A')' #4B 4B 'K' #4C 4C 'L’ #4D 4D 'M'
#4E 4E 'N' #4F 4F 'O’ #50 50 'P' #51 51'Q’ #52 52 'R’ #53 53'S
#54 54 'T' #55 55 'U' #56 56 'V' #57 57 'W' #58 58 'X' #59 59'Y"
#5A 5A 'Z' #5B 5B ' #5C 5C '\' #5D 5D ' #5E 5E ' #5F 5F ' '
#6060 "' #6161 'a’ #62 62 'b' #63 63 'c' #64 64 'd' #65 65 'e'
#66 66 ' #67 67 'g' #68 68 'h' #69 69 'i' #6A 6A '} #6B 6B 'k’
#6C 6C'I' #6D 6D 'm' #6E 6E 'n' #6F 6F 'o' #7070 'p' #7171'q'
#7272'r #7373's' #7474 't #7575'U’ #7676 'V' #1777'W
#7878 'x' #7979y #TATA'Z #7B 7B (2) #7C7C" #7D 7D (3)
#7E TE '~ #7F 7F DEL

}

Table 7-4 Code conversion table ASCII_IN

ASCIL_IN

{

#00 00 NUL #01 01 SOH #02 02 STX #03 03 ETX #04 04 EOT #05 05 ENQ
#06 06 ACK #07 07 BEL #08 08 BS #09 09 HT #0A OA LF #0B 0B VT
#0C OC FF #0D OD CR #0E OE SO #OF OF Sl #10 10 DLE #11 11 DC1
#12 12 DC2 #13 13 DC3 #14 14 DC4 #15 15 NAK #16 16 SYN #1717 ET
#18 18 CAN #1919 EM #1A 1A SUB #1B 1B ESC #1C 1CFS #1D 1D GS
#1E 1E RS #1F 1F US #20 20 SP #2121 #2222 ™ #2323 (1)
#24 24'¢' #25 25 '%' #26 26 '&' #27 27" #2828 '(' #2929"')
#2A 2A ™ #2B 2B '+' #2C 2C"'' #2D 2D '- #2E 2E "' #2F 2F '/
#3030'0' #3131'1" #3232 '2' #33 33'3' #34 34 '4' #35 35'5'
#36 36 '6' #37 37'7T" #38 38 '8' #39 39'9' #3A3A " #3B 3B ;'
#3C 3C '<' #3D 3D '=' #3E 3E '>' #3F 3F '?' #4040'@' #41 41'A'
#42 42 'B' #43 43'C' #44 44 'D' #4545 'E' #46 46 'F' #47 47 'G'
#48 48 'H' #49 49'I' #4A 4A'J' #4B 4B 'K' #4C 4C'L' #4D 4D 'M'
#4E 4E 'N' #4F 4F 'O’ #50 50 'P' #51 51'Q’ #52 52 'R’ #5353 'S’
#54 54 'T' #55 55 'U' #56 56 'V' #57 57 'W' #58 58 'X' #59 59 'Y'
#5A 5A 'Z' #5B 5B ' #5C 5C '\' #5D 5D ' #5E 5E ' #5F 5F '’
#6060 "' #6161 'a’ #62 62 'b' #63 63 'c' #64 64 'd' #65 65 'e'
#66 66 'f #67 67 'g' #68 68 'n' #6969 'i' #6A 6A 'j' #6B 6B 'k’
#6C 6C 'I' #6D 6D 'm' #6E 6E 'n' #6F 6F 'o' #7070 'p' #7171'q'
#7272'r' #7373 's' #7474 't #7575 'U’ #7676 'V' #7777 'W
#7878 'x' #7979y #7TATA'Z #7B 7B (2) #7C7C" #7D 7D (3)
#7E TE '~ #7F 7F DEL

}
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Table 7-5 Code conversion table EIA_OUT

EIA_OUT

{

#00 FF NUL
#06 FF ACK
#0C FF FF
#12 FF DC2
#18 FF CAN
#1E FF RS
#24 FF '$'
#2A FF ™
#3020 '0"
#36 16 '6'
#3C FF '<'
#42 62 'B'
#48 68 'H'
#4E 45 'N'
#54 23 'T'
#5A 29'7'
#60 FF "
#66 76 'f
#6C 43 'I'
#7249
#78 37 'x'
#7E FF '~

}

#01 FF SOH
#07 FF BEL
#0D 80 CR
#13 FF DC3
#19 FF EM
#1F FF US
#25 0B '%'
#2B 70 '+
#3101 1"
#3707 7"
#3D FF '=
#4373°C'
#4979
H#A4F 460"
#55 34 'U'
#5B FF [
#6161 'a’
#6767’
#6D 54 'm’
#7332’
#7938y
#7F 7F DEL

#02 FF STX
#08 2A BS
#0E FF SO
#14 FF DC4
#1A FF SUB
#20 10 SP
#26 OE '&'
#2C 3B/
#3202 '2'
#38 08 '8'
#3E FF '>'
#44 64 'D'
#4A 51
#50 57 'P'
#56 25'V'
#5C FF 'V
#6262 'b’
#68 68 'h'
#6E 45 'n’
#7423 't
#7A 29 '

Table 7-6 Code conversion table EIA_IN

EIA_IN

{

#00 00 NUL
#FF 06 ACK
#FF OC FF
#FF 12 DC2
#FF 18 CAN
#FF 1E RS
#FF 24§’
#FF 2A ™
#2030'0
#16 36 '6'
#FF 3C '<'
#62 42'B'
#68 48 'H'
#45 4E'N'
#23 54 'T'
#29 5A 'Z'
#FF 60"
#FF 66 'f
#FF 6C T
#FF 727
#FF 78 '’
#FF 7E '~

}

#FF 01 SOH
#FF 07 BEL
#80 OD CR
#FF 13 DC3
#FF 19 EM
#FF 1F US
#0B 25 '%'
#70 2B '+
#0131'1"
#07 377"
#FF 3D '='
#7343'C'
#7949
#46 4F 'O’
#34 55'U'
#FF 5B
#FF 61 '
#FF 67 '’
#FF 6D 'm’
#FF 73 '’
#FF 79y
#7F 7F DEL

#FF 02 STX
#2A 08 BS
#FF OE SO
#FF 14 DC4
#FF 1A SUB
#10 20 SP
#0OE 26 '&'
#3B 2C ",
#02 32 '2'
#08 38 '8’
#FF 3E >’
#64 44 'D'
#514A'J
#57 50 'P'
#25 56 'V'
#FF 5C 'V
#FF 62 '’
#FF 68 'h'
#FF 6E 'n’
#FF 74 't
#FF 7TA'Z
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#03 FF ETX
#09 3E HT
#OF FF SI
#15 FF NAK
#1B FF ESC
#21 FF "
#27 FF ™
#2D 40 -
#3313 '3
#3919'9'
#3F FF '?'
#45 75 'E'
#4B 52 'K'
#5158 'Q’
#57 26 'W'
#5D FF 1T
#6373 'C
#6979 'f
#6F 46 '0'
#7534 'u'
#7B FF (2)

#FF 03 ETX
#3E 09 HT
#FF OF SI
#FF 15 NAK
#FF 1B ESC
#FF 217
#FF 27 ™
#40 2D -
#13 33'3'
#19 39'9'
#FF 3F '?'
#75 45 'E'
#52 4B 'K’
#58 51'Q’
#26 57 'W'
#FF 5D
#FF 63 'c
#FF 69 1
#FF 6F '0'
#FF 75 'U'
#FF 7B (2)

7 Code Conversion Function

#04 FF EOT
#OA FF LF
#10 FF DLE
#16 FF SYN
#1C FFFS
#22 FF ™
#28 1A ("
#2E 6B "
#3404 '4'
#3AFF '
#40 FF '@’
#46 76 'F'
#4C 43 'L’
#52 49 R’
#58 37 'X'
#5E FF '~
#64 64 'd'
#6A 51
#7057 'p'
#76 25 V'
#7C FF |

#FF 04 EOT
#FF OA LF
#FF 10 DLE
#FF 16 SYN
#FF 1CFS
#FF 22 ™
#1A 28 ('
#6B 2E '
#04 34 '4'
#FF 3A "
#FF 40'@'
#76 46 'F'
#43 4C 'L
#49 52 'R’
#37 58 'X'
#FF 5E '~
#FF 64 'd'
#FF 6A
#FF 70 'p'
#FF 76 V'
#FF 7C |

#05 FF ENQ
#0B FF VT
#11 FF DC1
#17 FF ETB
#1D FF GS
#23 FF (1)
#29 4A ")
#2F 31/
#3515'5'
#3BFF ')
#4161 'A
#47 67'G'
#4D 54 'M'
#5332'S'
#59 38'Y"
#5F FF "'
#6575 '’
#6B 52 'k’
#7158 'q’
#77 26 'W'
#7D FF (3)

#FF 05 ENQ
#FF OB VT
#FF 11 DC1
#FF 17 ETB
#FF 1D GS
#FF 23 (1)
H#AA 29 ')
#31 2F '/
#15 35 '5'
#FF 3B
#6141 'A
#67 47 'G'
#54 4D 'M'
#3253'S'
#3859'Y"
#FF 5F '
#FF 65 '¢'
#FF 6B 'k’
#FF71'q’
#FF 77 "W
#FF 7D (3)
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Table 7-7 Code conversion table ISO_OUT

ISO_OUT

{

#00 00 NUL
#06 06 ACK
#0C OC FF
#12 12 DC2
#18 18 CAN
#1E 1E RS
#24 24§’
#2A AA ™
#3030 '0"
#36 36 '6'
#3C 3C '<'
#42 42 'B'
#48 48 'H'
#4E 4E 'N'
#54 D4 'T'
#5A 5A 'Z'
#6060 "
#66 66 'f
#6C 6C I
#7272
#78 78 'x'
#7E 7E '~

}

#01 81 SOH
#07 87 BEL
#0D 8D CR
#13 93 DC3
#19 99 EM
#1F OF US
#25 A5 '%'
#2B 2B '+
#31B1'1"
#37B7'T'
#3D BD '='
#43 C3'C'
#49 CO I
#4F CF 'O’
#55 55 'U'
#5B DB T
#61E1'a’
#67 E7'g'
#6D ED'm’
#73F3's'
#T9F9'y'
#7F FF DEL

#02 82 STX
#08 88 BS
#OE 8E SO
#14 14 DC4
#1A 9A SUB
#20 AO SP
#26 A6 '&'
#2C AC''
#32 B2 '2'
#38 B8 '8'
#3E BE ">'
#44 44 'D'
#4A CA'J'
#50 50 'P'
#56 56 'V'
#5C 5C "'
#62 E2'b'
#68 E8 'h'
#6E EE 'n'
#7474t
#7A FA'Z'

Table 7-8 Code conversion table ISO_IN

ISO_IN

{

#00 00 NUL
#06 06 ACK
#0C OC FF
#1212 DC2
#18 18 CAN
#1E1ERS
#24 24§’
#AA 2A ™
#3030'0’
#36 36 '6'
#3C 3C '<'
#42 42 'B'
#48 48 'H'
#AE 4E'N'
#D4 54 'T'
#5A BA'Z'
#6060 "'
#66 66 'f
#6C 6C I’
#r272'r
#7878 'x
H#HIETE'~

}
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#8101 SOH
#87 07 BEL
#8D 0D CR
#93 13 DC3
#99 19 EM
#OF 1F US
#A5 25 '%'
#2B 2B '+
#8131 1"
#B7 377"
#BD 3D '='
#C343'C'
#C9 49 I
#CF 4F 'O’
#55 55 'U'
#DB 5B T
#E161 '’
HET 67'g'
#ED 6D 'm’
#F373's'
#F9 79y
#FF 7F DEL

#82 02 STX
#88 08 BS
#8E OE SO
#14 14 DC4
#9A 1A SUB
#A0 20 SP
#A6 26 '&'
#AC 2C ")
#B2 322
#B8 38 '8’
#BE 3E >’
#44 44 'D'
#CA 4A'J
#50 50 'P'
#56 56 'V'
#5C 5C '
#E2 62 'b'
#E8 68 'h'
#EE 6E 'n’
#7474 't
#FATA'Z

#03 03 ETX
#09 09 HT
#OF OF SI
#15 95 NAK
#1B 1B ESC
#2121
#27 27 ™
#2D 2D -
#3333 '3
#39 39'9'
#3F 3F '?'
#45 C5 'E'
#4B 4B 'K’
#51 D1'Q’
#57 D7 'W'
#5D DD T
#6363 'c’
#69 69 i
#6F 6F o'
#75 F5 U’
#7B 7B (2)

#03 03 ETX
#09 09 HT
#OF OF Sl
#95 15 NAK
#1B 1B ESC
#2121
#27 27 ™
#2D 2D '
#3333 '3
#3939'9'
#3F 3F 7"
#C5 45 'E'
#4B 4B 'K’
#D151'Q
#D7 57 'W'
#DD 5D 1
#6363 'c’
#69 69 'F
#6F 6F '0'
#F5 75U’
#7B 7B (2)

#04 84 EOT
#0A OA LF
#10 90 DLE
#16 96 SYN
#1C 9C FS
#2222™
#28 28 ('
#2E 2E
#34 B4 '4'
#3A3A "
#40 C0'@'
#46 C6 'F'
#4c cc'L'
#52 D2 'R’
#58 D8 'X'
#5E DE '~
#64 E4 'd'
#6A 6A '
#70 FO 'p'
#76 F6 'V'
#7CFC'I

#84 04 EOT
#0A OA LF
#90 10 DLE
#96 16 SYN
#9C 1C FS
#2222
#2828 ("
H#2E 2E '
#B4 34 '4'
#3A 3A "
#C040'@'
#C6 46 'F'
#CC4C'L'
#D2 52 'R’
#D8 58 'X'
#DE 5E '~
#E4 64 'd'
#6A BA '
#F0 70 'p'
#F6 76 'V'
#FC 7C |
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#05 05 ENQ
#0B 8B VT
#11 11 DC1
#17 17 ETB
#1D 1D GS
#23 A3 '0'
#29 A9 ")
#2F AF '/
#35 35'5'
#3B BB '}
#4141 'A
H#AT 47'G'
#4D 4D 'M'
#53 53 'S'
#59 59'Y"
#5F 5F ' '
#65 65 'e’
#6B EB 'K’
#7171'q’
HIT 77 W
#7D 7D (3)

#05 05 ENQ
#8B 0B VT
#11 11 DC1
#17 17 ETB
#1D 1D GS
#A3 230"
#A9 29')
#AF 2F '/
#35 35 '5'
#BB 3B "}
#41 41 A
#AT 47 'G'
#4D 4D 'M'
#53 53'S'
#59 59'Y'
#5F 5F '
#65 65 '’
#EB 6B 'k’
#7171'q’
HTT 77 "W
#7D 7D (3)
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8 System Platform

8.1 Hardware

8.1.1 Requirements for DNC Cell

Table 8-1 Hardware requirements for DNC Cell

Hardware component Requirement

PC At least a Pentium class processor PlIl|

RAM >512 MB

Hard disk = 1 GB for the system (operating system, database,
DNC, etc.)
plus disk storage for data to be managed

Screen resolution =800 x 600

Disk drive CD ROM

COM interfaces Optional, depending on the serial interfaces required:
4-port/8-port interface cards

Network card Optional for networking
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8.1.2 Requirements for DNC Plant

Table 8-2 Hardware requirements for DNC Plant

8 System Platform

Hardware component

Requirement of the server and
DNC HMI computer

Requirement of the station PCs

PC At least a Pentium class processor At least a Pentium class processor
PIll Pl

RAM =512 MB =256 MB

Hard disk = 2GB for the system (operating = 200 MB for the system (operating

system, database,

DNC, etc.)

plus disk storage for data to be
managed

system, database, DNC, etc.)
plus disk storage for data to be
managed

Screen resolution > 1024 x 768 =800 x 600
Disk drive CD ROM CD ROM
COM interfaces Optional, depending on the serial
interfaces required:
4-port/8-port interface cards
Network card yes yes

Backup medium

Depends on backup strategy

Raid system

Depends on availability requirements
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8.2 Software

8.2.1 Requirements for DNC Cell
Table 8-3 Software requirements for DNC Cell

Remarks

Software component

Operating system

Windows 2000 Professional/Server
Windows 2003 Server
Windows XP Professional

One operating system per networked
PC/SINUMERIK when server operating systems
are used

Client access license

MSDE required

Internet Explorer

Network protocol, optional for networking
(included in Windows)

TCP/IP

When appropriate modules are used

Driver software for multiple serial interfaces

MCIS database

» MSDE (license-free SQL server) — contained in
DNC Cell

e SQL server*

*

If an SQL server is already installed on the system, this is used as a data

management system and MSDE is not installed.

FBDN1/8-124
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8.2.2 Requirements for DNC Plant

8 System Platform

Table 8-4 Software requirements for DNC Plant computer

Remarks

Software component

Operating system

Windows 2000 Server
Windows 2003 Server

Per networked PC/SINUMERIK

Client access license

MSDE required

Internet Explorer

Network protocol, optional for networking
(included in Windows)

TCP/IP

When appropriate modules are used

Driver software for multiple serial interfaces

MCIS database

» MSDE (license-free SQL server) — contained in
DNC Plant
+ SQL server*

e  QOracle **

* If an SQL server is already installed on the system, this is used as a data
management system and MSDE is not installed.

** Qracle 9i (V9.2) can also be used as a data management system, rather than
MSDE/SQL server. This is not a default installation. See: readme.pdf

Requirements for station PCs and HMI computers

Table 8-5 Software requirements for stations PCs and HMI computers

Remarks

Software component

Operating system

Windows 2000 Professional/Server
Windows 2003
Windows XP Professional

Additional license of server operating system

Client access license

MSDE required

Internet Explorer

Network protocol, optional for networking
(included in Windows)

TCP/IP

When appropriate modules are used

Driver software for multiple serial interfaces
(not required with an HMI computer)

* If an SQL server is already installed on the system, this is used as a data
management system and MSDE is not installed.
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Notes
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9 Software Structure
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9 Software Structure

9.1 Software structure

The software structure diagram below shows the data flow between the DNC

operator interface, the servers and the machine.

All transmission functions are processed via the machine server. Any standard or
customer-generated code conversions can be optionally integrated in the process.
The DNC code conversion server or a customer code conversion server can be
called. The customer code conversion server can be programmed so that it calls
the DNC code conversion server on completion of its run. An external dialog
function can be used to implement the dialog function for specific projects, in which
case the data flows from the machine server to the dialog interpreter for code
conversion and then on to the machine.

Operator interface
DNC

£ DNC NT-2000 - Terminall
ter Ansict Zdras Hife

[ 528 % v | dose |

Legend

<==) dataflow

optional
application

2 optional
data flow

Bild 9-1 Software structure
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Machine server

eg.
SerIntSvr

Code conversion

server

External
dialog interpreter
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9.2 Machine server

DNC works with transmission functions implemented in machine servers for the
following reasons:

e The server can be replaced independently of DNC.

* Modifications to the server can be made independently of DNC.

All machine servers are OLE/COM servers with defined interfaces to DNC.

By default, DNC interfaces with serial machines via SerIntSvr. Separate machine
servers can be created for machines requiring a different mode of data
transmission.

9.2.1 SerintSvr

Function

By default, DNC features SerIntSvr for unsecured serial transmission. SerIntSvr
includes a dialog interpreter function and is capable of calling an additional external
dialog interpreter and code converter server if required.

9.2.2 Customized serial machine servers

If SerIntSvr cannot meet the requirements of a particular application, users can
create their own customized machine server.

Typical applications of customized servers are:

¢ Machines without a serial interface

¢ Machines, which require secure serial transmission

9.3 Code conversion server

DNC code conversion server

The DNC code conversion server supports three conversion codes: ISO, ASCII
and EIA. The conversion definition tables contain the file CODES.TXT. They are
stored together with the DNCConvSvr code conversion server in the DNC program
directory.

Customized code conversion server

If DNCConvSvr does not meet the relevant requirements, users can create their
own code conversion server. Possible applications include:

Conversion of another code

Further conversions, such as: A = AV
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9.4 External dialog interpreter

General

DNC features an optional interface for an external dialog interpreter, with which, for
example, names can be converted on a project-specific basis or the dialog program
can be interpreted in a particular way. The dialog interpreter must be implemented
as an ActiveX/DLL with Visual C++ or Visual Basic. It is called by the machine
server.

This is a different type of conversion than the method used on the code conversion
server, since it is configured only for the dialog function. Typical applications
include control systems, which cannot edit all characters. In this type of case, for
example, conversion from GOO to cylinder head, etc., could be implemented.

Note

A brief description of the external dialog interpreter can be found in
"ExternalDialoglnterpreter.doc” in directory IBS_Docu on the project CD.
Further information about the external dialog interpreter is available on request.

Configuring

The dialog interpreter is configured in the [DIALOGFUNCTION] section of the
machine configuration file.
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10.1 General

All configuration settings should be made by an authorized user. Data and settings
can and/or must be defined and configured in the following areas:

¢ Plant structure (software-based simulation of plant topology)

¢ Machine interfaces (machine interface type)

e Screen form definition for NC data properties and imports

e List definition

e Parameters for the dialog function

« User-specific data (access and display definition, see Chapter 5)

The "DNC Admin" program can be used to make the majority of configuration
settings. Very few configuration settings, such as the creation and editing of filters
and NC data, can be made in DNC.

10.2 Separate DNC Admin and DNC

10.2.1 General

The purpose of using a structure with separate DNC Admin and DNC programs is
to prevent you, the user, modifying the DNC configuration unintentionally. The
advantage of dividing the system into these two programs is that its configuration
can be changed only if you explicitly intend to do so. DNC is easier to operate with
the configuration functions removed.

DNC Admin should be operated only by authorized personnel, while DNC is
simple enough for anyone to use.

Note

DNC Admin can also be operated by other users. A precise distinction must be
made in respect of which user can do what, with each function assigned explicitly
to each user type. See also: Chapter 5 - User administration.

Some of the configurations implemented in DNC Admin do not become
operative until you restart the DNC program!

At first glance, both programs appear to be the same, but they each perform
different functions.
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10.2.2 Differences
Table 10-1 Differences between DNC and DNC Admin

Function DNC DNC Admin

Background color (default) White Light
blue/green

Configuration mode - X (green)

Consistency check and debugging -
Configure user -
Screen Form Editor -
List Editor -

XX | XX

Download NC data X -
Upload NC data X -
Machine Alignment X -

The background color should show you at a glance which program you are
working in and whether you have activated configuration mode (green). You can
alter the background colors in DNC Admin as part of the startup process. See
also: readme.pdf

Additional functions in DNC Admin

Configuration mode (View—>Configuration) enables you to set up and modify the
plant topology. In this mode, you can set up and delete groups, machines and
links, and parameterize machines. See also: Plant structure

Configure user (Options>User Management). In this screen, a user who is
authorized to configure other users can set up or delete users, or change their
rights, passwords, display groups, and other user-specific settings.

You can use the Screen Form Editor (Options—=>Screen Form Editor) to modify the
NC Data Properties dialogs and set up new display groups for dialogs of this type.

You can use the List Editor (Options—>List Editor), to change the appearance and
content of the list display and set up new display groups for list displays of this

type.

Note

These functions are available only if you have the appropriate authorization.
See also: User administration
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Additional functions in DNC

Download NC Data (File->Download) enables you to send NC data from the DNC
to the NC machine.

Upload NC Data (File->Upload) is the reverse process, i.e., for sending NC data
from the NC machine to the DNC data management system.

The Machine Alignment function enables you to identify the programs stored on
the machine, in comparison to those stored for this machine in the DNC data
management system. You can also compare the files on the machine with the files
in DNC. This function is only supported by machines with SINUMERIK
840D/840Di/810D and PCU50/70, as well as DNC IFC SINUMERIK.

Note

These functions are available only if you have the appropriate authorization.
See also: User administration
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10.3 Plant structure

10 Configuration
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Fig. 10-1 Plant structure in the file system
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The plant structure is configured via the DNC operator interface. Configuration

mode must be selected.

The directories and subdirectories in the file system correspond to the tree
structure displayed on the operator interface.

The file system is stored in path:

© Siemens AG 2005 All Rights Reserved
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10.4 Machine interfaces

The machine interfaces are configured in machine configuration files. If no
configuration file exists for the selected machine, the user is provided with a
selection of predefined template files for machine configurations. After a template
has been selected, the configuration file is named: MachineName.MCF.

See also: Templates for configuration files

You can choose between the following types of interface:

e Serial unsecured

«  SINUMERIK 840D/840Di/810D connected via Ethernet
¢ Via Windows file system

The entries in the machine configuration file differ accordingly.

Configuration files are divided into different sections, which are evaluated by the
corresponding servers. The MachineType entry in the [GLOBAL] section contains
the interface type. Other sections can be added to those already provided, in order
to connect other servers. Comment lines are preceded by a “;”.

You can edit the configuration file by clicking the EDIT button in the Editor.

You can edit the serially unsecured machine interface entry in the machine
configuration file by calling the configuration dialog. It is started with the Config

Dialog button. Each section is displayed on a separate tab sheet.
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Areal Machinel |
Configuration |
Configuration file: EDIT
b achinel.kCF
Config dialog

Transmigzion module: Drigplay araup far list:
ISeriaI withaut pratocal j [ Dislog function IMLlST‘I j
IJpload directory Search levels for HC data
ID I achine j ID b achine j

k. Cancel Help

Fig. 10-2 Machine properties in download mode: Serial unsecured

Note

If the machine properties are edited in DNC Plant on the server, you must assign
a station PC to the machine via the Station input field.
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Manual abort

You can control the system’s response to an active NC data upload being aborted

by checking the Manual abort box.

¢ When this box is checked, a dialog opens when a data receive operation is
aborted; this dialog asks you to confirm whether you wish the received data to
be accepted or discarded.

e Ifthe box is not checked, the upload is aborted with no dialog. None of the
received data are received.

See also: Uploading NC data from the machine

Areal SinB40D |
Configuration |
Configuration file: EDIT
Sing400. MCF
[Eantig dialog
Transmigzion module; Dvigplay aroup faor list:
| SINUMERIK. 8400 | [ Auto Compare |DELLIST =
[T Ao drchive
IJpload directary Search levels for HC data
IE:! tachine _‘:_I IE:! Group :_I
k. Cancel Help

Fig. 10-3 Machine properties in download mode: SINUMERIK 840D/840Di/810D
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10.4.1 Machine configuration files

Standard configuration files

DNC uses the following standard machine configuration files:

Dncmastd.MCF for machine interfaces with a serial, unsecured interface
SIN840DStd.MCF for SINUMERIK 840D/840D1/810D machine interfaces
When the Auto Compare and Auto Archive boxes are checked, the NC data
from SINUMERIK 840D/840Di/810D machines are compared with the NC data
in the DNC system. If deviations are detected, the machine data are
automatically downloaded to the DNC system.
With the file system machine type, it is possible to transfer NC data to and
from any shared network drives. Any network-capable control system can be
linked to the DNC system under Windows. There are two configurable
directories for uploading and downloading NC data. The version strategy is
used for uploading. The management data are refreshed as they are uploaded
or downloaded.

It is also possible to create any kind of machine server to make a link to
controls with other types of interface, e.g., OLE/COM, or special serial
protocols.

Note

No defaults are specified in the machine configuration files for some parameters
with string assignment. If you are using functions that contain parameters with
string assignments, the standard machine configuration file should be adjusted so
that all relevant entries are available. Separate adjustments do not then have to
be made for each individual machine.
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Templates for configuration files

Apart from the standard machine configuration files, you can also create your own

machine configuration file templates. The following supplementary conditions apply

in this context:

¢ The file extension must be .MCF.

e The files must include a [GLOBAL] section with a MachineType key
corresponding to the selected control type:

Table 10-2 Control types for machine configuration file templates

Template file

MachineType

Remarks

Dncmastd.MCF

Serial

For unsecured serial transmission

SIN840DStd.MCF

SINUMERIK840D

For SINUMERIK 810D/840Di/840D

DNCFSStd.MCF

File system

For transmission to network drives

| Important

You must store the templates in the ...config/template directory.

It includes the following 3 template files as standard:

¢+ Dncmastd.MCF, etc.
* SIN840DStd.MCF
« DNCFSStd.MCF

If the ...config/template directory contains several template files of the selected
machine type, you can click the Edit or Config Dialog button to open a template
selection dialog, in which you can select any of the stored template files. Various
template files are available for controls from different manufacturers.

Note

This selection dialog is displayed only if the template directory contains more than
one template file of the corresponding machine type.
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10.4.2 Standard machine configuration file for serial unsecured interface

Table 10-3 Example of a machine configuration file for the serially unsecured interface

; MCI'S DNC V2 Machi ne configuration tenplatefile

; Base: "__standard-serial . MCF"

; more infos see the machi ne configuration docunentation on
Instal | -CDROM i n "I BS_Docu\ Machi ne-confi gurati on-docu\*. pdf "

[ GLOBAL]
Machi neType=seri al
Machi neSer ver =Ser | nt Svr. Machi ne
[ SERI NTSVR]
; CNCConver t er =DNCConv. CodeConver t
CNCConverter=
; Server for Code conversion

CNCcode= (ASCl 1, | SO, El A)

; Serial COMport Paranter

;---CommPort---: 1=COML ... 16=COML6
ConPort = 2

; ---BaudRate---: 110, 300, 600, 1200, 2400, 4800, 9600, 19200, 38400 ;57600, 115200
Bd
BaudRat e = 9600

;---ByteSize---: 6,7,8
ByteSize = 8

;---StopBits---: 1, 2
StopBits = 1

;---Parity---: No=N, Gdd=0O, Even=E;, Mark=M Space=S
Parity = N

;---FlowCtrl---: DTRDSR, RTSCTS, XONXOFF, NONE
FlowCtrl = RTSCTS

;---XON XOFF---: in ASCl|-decimal - Code (0 ... 255)
XONChar =17
XOFFChar =19

;---Binary---: 0= NO 1 = YES (transfernode: 0=ASCl |, 1=binary)
Binary = 0

; Program Qut put Par anet er
[ SEND|

; Parameters in ASClI |- Dezinal- Code (0 ... 255)

;---Progranttart---: (character, added before each file)
Prograntt art =0

;---ProgrankEnd---: (character, added after each file)
Pr ogr anEnd=0

;---Comment Start---: (character which marks the begin of an conment)
Comment St ar t =40

; ---Coment End---: (character which marks the end of an comment)
Comment End=41

;---HeaderChar---: (character, added "HeaderSize"-tines before each file)
Header Char =0

;---TrailerChar---: (character, added "TrailerSize"-tinmes before each file)
Trail er Char =0

;---HeaderSi ze---: (Size in Bytes to add Paraneter "HeaderChar" before each file)
Header Si ze=0

;---TrailerSize---: (Size in Bytes to add Paraneter "TrailerChar" after each file)
Trail erSi ze=0

;---SpacerChar---: (character, added "SpacerSize"-tines before/after each

Spacer Mar k)
Spacer Char =0

;---SpacerSize---: (Size in Bytes to add Paraneter "SpacerChar" before/after each
Spacer Mar k)
Spacer Si ze=0

; ---Ski pFi rst SpacerMark---: 0= NO 1 = YES (to suppress Spacer before 1. NC Progranmm
Ski pFi r st Spacer Mar k=0

;---SpacerMarkers (max 16 Byte each)

;---SpacerMarkl..3 ---: (before each line in which these SpaceMarkers appear a
spacer wll be inserted)

; Spacer Mar k3=%FPF
Spacer Mar k1=
Spacer Mar k2=
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Spacer Mar k3=
;---SpacerMarklnsert Afterl..3 ---:(after each line in which this SpacerMarkers
appear a spacer will be inserted)
; Spacer Mar kl nsert Af t er 3=M30
Spacer Markl nsert After 1=
Spacer Mar kl nsert Aft er 2=
Spacer Mar kl nsert Aft er 3=

; ---ECBcode- - -: (This paranmeter is used for the end of |ine conversion to/from
CNO)
; 0=No, 1 =CR+CR 2 =CR+ LF, 3=LF+CR 4 =LF + LF
; 5=CR+ CR + CR 6 = CR+ CR + LF, 7 =CR+ LF + CR 8 = CR + LF + LF,
; 9= LF+CR+CR 10 = LF +CR+ LF, 11 = LF + LF + CR 12 = LF + LF + LF,
; 13 = CR 14 = LF
EOBcode=0
;---SuppressConment---: 0= NO 1 = YES (comments will not be transferred)
Suppr essComent =0
;---SendTinmeQut in mnutes---: O=infinite (job will be cancelled after that tine,
if machine is not in receive node)
SendTi nmeout =1
;---Different Baudrate for sending---: (SendBaudRate=0 = sane Baudrate as in [ COM
section)
SendBaudRat e=0
;---SendDel ay in seconds---: (the systemwaits for this tine before the data will be
send to the machine)
SendDel ay=0
; Program | nput Par anet er
[ RECEI VE]
;---Paraneters in ASClI |- Dezimal- Code (0 ... 255)---
;---ValidData---: (This charakter shows the first valid character of the NC program
Al'l charakters before will be cut)
Val i dDat a=0
;---Progranttart---: (character in ASCI| dec. added in front of each file after
upl oadi ng)
ProgranStart =0
;---ProgrankEnd---: (character in ASCI|I dec. trailed at the end of each file after
upload|ng)
Pr ogr anEnd=0
;---Eof Char---: (character, which indicates the end of uploading) O=none -> receive
ends after TimeQut (see bel ow)
Eof Char =0
; TimeQut in seconds. Uploading is stopped after this time, if no bit further nore is
received (1 ... 600, O=infinite)
Ti meCut =5
;---HeaderSi ze---: (Size in Bytes to cut from program header after receiving each
file)
Header Si ze=0
;---TrailerSize---: (Size in Bytes to cut fromprogramend after receiving each
file)
Trail erSize=0
;---NullDiscard---: 0 = NO1 = YES (binary NULL values will discarded everywhere in
the file)
Nul | Di scard=1
;---TestMode---: 0 = NO 1 = YES (received Tnpfile will not be del eted)
Test Mbde=0
;---NCSplit---: 0= deactivated 1 = SINUMERI K 840D 2 = any other CNC
NCSlet =0
; ---NCNaneLi nes---: (nunber of the signifcant lines, beginning with Iline 1)
NCNaneLi nes=5
;---NCNaneBegin---: Startmark in front of Namelnfo
NCNamaBeg|n #Nane#
; - --NCNaneEnd- - -: Endmar k behi nd Nanel nf o

NCNarreEnd #End#
;---NCNaneWPD- - - : seperator between WPD and Nane
NCNameWPD=
;---NCNaneType---: seperator between Nane and Type
NCNarTeType—
NCPr ogram®t art 1=%
NCPr ogranmtt art 2=
NCPY ogramtt art 3=
NCPr ogr ammEnd1=M30

NCPr ogr anmEnd2=ML7
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NCPr ogr ammEnd3=

[ DI ALOGFUNCTI ON]

; ---DlgScanLi nes---: (nunber of the signifcant lines, beginning with line 1)
Dl gScanLi nes=10

;---Paraneters in special ASClI-Character- Wrds---

;---DlglD---: (Nane of the dialogue file)
Dl gl D=%vPF9999

;---Dl gl DSend---: (Nane of the answer file (list, error), sent fromDNC_NT to
machi ne)
Dl gl DSend=%vPF9998
;---DlgSendEnd---: (Program End for the answer file (list, error), sent from DNC_NT

to machi ne)
Dl gSendEnd=M30

;---DlgSendCnd---: (character which indicades to download a file with rel easel D
Dl gSendCnd=( S)

;---DlgSendTcCnd---: (character which indicades to download a file with trialcutlD)
Dl gSendTcCrd=( ST)

s---DIgRecei veCmd---: ( character which indicades to upload a file from nachine to
DNC)
Dl gRecei veCnd=( R)

;---DlgSendListCnd---: ( character which indicades to download a filelist of the

machi nedi rectory in DNC)
Dl gSendLi st Cnd=( SL)

;---DlgWwhdMark---: (allows to change the shortcut of an workpi ece directory)
Dl gWwbdMar k=WPD

;if it is inpossible to wite MPF, SPF, TOA ... you can define a character followed
by a nunber

; YOO1 = MPF, Y002 = SPF, Y003 = TOA ... ordernunber as defined in Databasetable
NCDATATYPE

Dl gExchangeCNCType=

;in exchange for * if it is inpossible to wite *, eg. X999 (only for use with
Dl gSendLi st Cnd!)
DI gexchangeW | dcar d=

; Dl gConverter=DNCDI gl . DNCCnt r |
Dl gConverter=
Dl gSubNunber =0

; Cut Fr omNane=

* M ni DNC DNC_NT- 2000

; HRHHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHTHHHHE

; [com

; #1210 COM XONChar

; #1211 COM XOFFChar

; #1401 COM ConPort, or Paranter: [SEND] SendBaudRate
; #1402 COM FlowCtrl,

; #1403 COM BaudRate, Parity, ByteSize, StopBits
; #1501 CoM ConPort,

; #1502 COM FlowCtrl,

; #1503 COM BaudRate, Parity, ByteSize, StopBits
; not exi stent COM binary

; [ SEND|

; #1201 SEND] Progranttart

; #1202 SEND] Pr ogr anEnd

; not exi stent SEND] Comment St art

; not exi stent SEND|] Conment End

; #1205 SEND] Header Char

; #1207 SEND] Trail er Char

; #1204 SEND] Header Si ze

; #1206 SEND] Trail erSize

; #1209 SEND] Spacer Char

; #1208 SEND] Spacer Si ze

; not exi stent SEND] Ski pFi r st Spacer Mar k

; #1217 SEND] Spacer Markl

; #1218 SEND] Spacer Mar k2

; #1219 SEND] Spacer Mar k3

; #1220 SEND] Spacer MarklnsertAfterl
; not exi stent SEND| Spacer Markl nsert After?2
; not exi stent SEND] Spacer MarklnsertAfter3
; #1203 SEND] ECBcode

; not exi stent SEND] Suppr essComent
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; #1103
; #1401
; #1117

; [ RECEI VE]
; #1302
; #1303
; #1304
; not existent
; #1102
; #1301
; not exi stent
; #1324
; not exi stent

;[ DI ALOGFUNCTI ON]
; not exi stent
; #1109
; not existent
; #1123
; not existent
; #1124
; not exi stent
; not exi stent
; not existent
; not exi stent
; #1101
; not existent

SEND]
SEND]
SEND]

RECE! VE]
RECE! VE]
RECE! VE]
RECE! VE]
RECE! VE]
RECE! VE]
RECE! VE]
RECE! VE]
RECE! VE]

DI ALOGFUNCT! ON]
DI ALOGFUNCT! ON]
DI ALOGFUNCTI ON]
DI ALOGFUNCTI ON]
DI ALOGFUNCT! ON]
DI ALOGFUNCTI ON]
DI ALOGFUNCT! ON]
DI ALOGFUNCT! ON]
DI ALOGFUNCTI ON]
DI ALOGFUNCT! ON]
DI ALOGFUNCT! ON]
DI ALOGFUNCTI ON]

SendTi meout
SendBaudRat e
SendDel ay

Val i dDat a
Prograntst ar t
Pr ogr anEnd
Eof Char

Ti meQut
Header Si ze
TrailerSize
Nul | Di scard
Test Mode

gSendTcCrd

Dl gRecei veCnd

Dl gSendLi st Cnd

Dl gWwbdvar k

Dl gExchangeCNCType
Dl gExchangeW | dcard
Dl gConverter

DI gSubNunber

; Copyright (C) Sienens AG A&, ALL RI GHTS RESERVED
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10.4.3 Standard machine configuration file for interface type SINUMERIK
840D/840Di/810D

Table 10-4 Example of a machine configuration file for interface type SINUMERIK 840D/840Di/810D

[ GLOBAL]

Machi neType=SI NUMERI K840D

; NCU_Id=NCU ldentifier, only for NNMfunctionality

; NCU_I d=NCU_1

; Machi nel pAddr ess=195. 212. 26. xxx (or MMC Conput er nane)
Machi nel pAddr ess=127.0.0.0

; DHPath = Sharenane of the rel eased Network-Path of

; MMC/IPCU e.g. PCU50: the directory f:\dh is shared as

;  "data" --> DHPATH=dat a

DHPat h=c\ dh

; You can use FTP for Filetransfer, if you have an FTP-Server
;in your Subnet available. UseFTP 0=NO, 1=YES

; Note: You nust set the right ftp-path in your ftp-settings, to
; put the files in the DNC directory

UseFTP = 0

NC_LOG N=
DCOMDhs Wi t =20

[ FTP]

;  Hostl pAddress= (or DNC Conputernane)
Host | pAddr ess=127.0.0.0

User =7??

Passwor d=???

; Mbde (1=ASCl |/ 2=Bi nar)

Mode=2

[ COVPARE]

; Specify directories on the SINUMERI K 8100/ 840Dl / 840D/ 810D si de, whi ch have to be

conpared with
the directories in the DNC System

; Aut oArchive-function will archive mssing directories in the DNC System

; i f necessary, conpare or archive DH-directories (ARC...) with a pseudo-workpiece-
directory (*.DIR

; limt to special filetypes, if requested

; EXAMPLES:
; DHDI R2 = SPF. DI R; 0; SPF
N second DHDirecory. List all your DH D Rs. from 1-30, if necessary.

N

; DHDI R2 = SPF. DI R; 0; SPF

; ANAANAN SPE. DIR is the name of the DH-directory.

; Files belonging to DH SPF.DIR (SINUMERIK) will be
; conpar ed/ ar chi ved

DHDI R5 = CST. DI R, TRUE; AWB; COM SPF
; ANAN TRUE: specifies, that files fromthis DHdirectory will be
archived in a PSEUDO Wrkpi ece(*.DIR) (here: CST.D R)

; TRUE or 1: DHdirectory will be archived as a Pseudo-
; wor kpi ece-directory in DNC System

; FALSE or 0: files of the DHdirectory will be archived
; directly in the defaul t-upl oad-directory
in the DNC System

; DHDI R3 = WKS. DI R; 0; MPF; SPF; TOA

; ANNNNAANNAN NPE; SPF; TOA: Listing of filetypes,

; whi ch have to be conpared/archived.

; Caution: Al filetypes have also to be
configurated in the DNC dat abase!!

Excl ude special files from conparing/archiving-function.

;  EXAMPLES:

; DHDI R1= MPF. DI R; 0; MPF; CEC

; EXCLUDE_MPF.DIR = Test; Testl

; ANNNNAANNANNTest . mpf, Test. cec, Test 1. npf and Test 1. cec

; of the the DH-directory "MPF.DIR' will be excluded
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DHDI R1= MPF. DI R; 0; MPF
EXCLUDE_MPF. DI R =
DHDI R2= SPF. DI R; 0; SPF
EXCLUDE_SPF. DI R =

DHDI R3 = WKS. DI R; 0; MPF; SPF; TOA; ZOA; RPA; WPL; JOB; BMP; ARC; | NI
EXCLUDE_WKS. DI R =

DHDI R4= ARC. DI R; 1; ARC
EXCLUDE_ARC. DI R =

: Note: If you don't find the directory, you want in this list, please
; refere the MMJ PCU - Services and add the directory you want with the
; next free DHDIR - Number (e.g. 11).

; Si cherungsauftrag fir NC aktive Daten

" Archivauftragsdatei muss in sel ben Verzeichnis |iegen wi e der DHS. EXE
; ARCIOB=NCACT1

;zu erstellende Archivdatei in der Datenhal tung

; ARCFI LE=NCACT1. ARC

"Timeout in Mnutes

ARCTI MEQUT= 5

[ REMOTELOG N|
; Only necessary, if FTP is not used

| P- Address, DNS or NetBlI OGS nanme of the Renbte Network Server, default is
; the Nane of the Machine in the network |ike in [ GLOBAL] Machi nel pAddress
Renot eNane=PCUXXXXXXX

; User with read/wite access to the network share/directory of [ GLOBAL] DHPath
User =AUDUSER

; Password for the User with read/wite access the network share
Passwor g=*******x
; Domai nnane, where this user is assignet to, if it
; Wn NT or XP, sane |ike [REMOTELOG N] Renot eName
Domai N=PCUXXXXXXX

is a local user in e.g.
( PCUXXXXXXX)

[ ULOADDLG
; DHDI RL=MPF. D

I R
; DHDI R2=SPF. DI R

; Copyright (c) SIEMENS A&D, ALL RI GHTS RESERVED
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10.4.4 Configuration dialog for serial unsecured interface

General tab sheet/section [GLOBAL]

The General tab sheet describes the [GLOBAL] section of the machine
configuration file. The machine server to be used is configured here. The program
identifier (ProglID, consisting of ComponentName.ClassName) of the relevant
machine server must be entered for this purpose.

Note

The serial machine server is called: SerintSvr.Machine (default).

machine 44_en |
Interface Send I Feceive I Dialog function I Interpretation of data flow
General tachine zerver [SERINTSVE] I Code corverzion server [DMCCony]
M achine zerver: SerntSwr.hachine

] Cancel Help

Fig. 10-4 Config dialog/tab sheet: General

Extract from the machine configuration file:
[ GLOBAL]
Machi neSer ver =Ser | nt Svr. Machi ne
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Machine server tab sheet/section [SERINTSVR]

machine 44_en |
Interface | Send | Receve I Dialog function | Interoretation of data flow |
General Machine zerver [SERINTSYR] | Code converzion zerver [DMNCCony]

Code conwversion server: ||

k. Cancel Help

Fig. 10-5 Config dialog/tab sheet: Machine server

The Machine server tab sheet describes the [SERINTSVR] section of the machine
configuration file. The code conversion server to be used is configured here. The
program identifier (ProgID, consisting of ComponentName.ClassName) of the
relevant code conversion server must be entered for this purpose.

Note

The code conversion server is called: DNCConv.CodeConvert (default).
If you wish the code conversion server to be run by another machine server, we
recommend that you add a new section for this purpose.

Warning

If you do not want to perform code conversion, do not enter a code conversion
server.

© Siemens AG 2005 All Rights Reserved
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Extract from the machine configuration file:
[ SERI NTSVR]
; CNCConver t er =DNCConv. CodeConvert

Note

The extract from the machine configuration file shows a code conversion server
as comment text because no code conversion is to be performed.
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Code conversion server tab sheet/section [DNCConv]

machine 44_en |

Interface I Send I Feceive I Dialog function | Interpretation of data flow |
General | Machine zerver [SERINTSYR] Code corrersion server [DMCCony]

Code conwversion semver ||

] Cancel Help

Fig. 10-6 Config dialog/tab sheet: Code conversion server

The Code Conversion Server tab sheet describes the [DNCConv] section of the
machine configuration file. The type of code conversion is configured here. In this
case, NC is converted from ASCII (ISO, EIA) to CNC code for downloads and back
to ASCII (ISO, EIA) for uploads.

You can select the following code conversions in a combo box:

« ASCII

« [SO

« EIA
Note

If you do not want code conversion to be performed, simply omit the entry of a
code conversion server in the [SERINTSVR] section or on the tab.

; CNCConver t er =DNCConv. CodeConvert

Extract from the machine configuration file:
DNCConv]
CNCcode=I SO
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Interface tab sheet/section [COM]

The Interface tab sheet describes the [COM] section of the machine configuration
file. The serial interface parameters are set here:

Note

The entries on the Interface tab must match the settings of the serial interface of
the CNC machine.

machine 44_en |
General | tachine zerver [SERINTSVE] I Code corverzion server [DMCCony]
Interface | Send I Receive I Dialoa function I |nterpretation of data fow
COM interface: 7

Baud rate: 3600 v
Mumber of data bits: | 3 bits v
Mumber of stop bitz: |1 bit 7
Farity: Mone

Flows contral: RTS/CTS =
#0M contral char: 17

#0FF contral char: |19

HERENNNN

Transmizzion mode: [ A5CI i

k. Cancel Help

Fig. 10-7 Config dialog/tab sheet: Interface
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« COM interface
The COM interface is the machine interface. Interfaces 1 to 16 can be
assigned.

1= COM1
16= COM16

Extract from the machine configuration file:

[CoM
ComPort = 2

Note

ComPort=0 is not a valid interface.

« Baud rate
The baud rate defines the transmission speed of the interface.
Baud rates between 110 and 256000 can be selected.

Extract from the machine configuration file:
BaudRate = 9600

¢« Number of data bits
6, 7 or 8 bits can be evaluated as data bits.

Extract from the machine configuration file:
ByteSize = 8

¢ Number of stop bits
1 or 2 bits can be evaluated as stop bits.

Extract from the machine configuration file:
StopBits = 1

e Parity
The following parities can be defined:

Table 10-5 Parity of the serial interface

N=No No parity check
0=0dd Odd parity
E=Even Even parity
M=Mark Logical 1
S=Space Logical 2

Extract from the machine configuration file:
Parity = N
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¢ Flow control
The flow control defines the handshake procedure setting. You can define the
following parameters:

Table 10-6 Flow control of the serial interface

DTRDSR (DTR/DSR) Hardware handshake
RTSCTS (RTS/CTS) Hardware handshake
XONXOFF (XON/XOFF) Software handshake
NONE No handshake

Extract from the machine configuration file:
FlowCtrl = RTSCTS

¢ XON control character/XOFF control character
If control systems with a different code type are connected, the XON or XOFF
character can deviate from the character specified here. If flow control is
controlled with XON/XOFF, the control character for XON/XOFF must be
defined to suit the control.

Extract from the machine configuration file:

;XONChar =17
; XOFFChar =19
Note

If the control characters for XON/XOFF are deactivated as comment text in the
machine configuration file, the internal defaults apply.

e Transmission mode
This defines the mode of transmission. The following transmission modes are
available:

Table 10-7 Transmission modes of the serial interface

ASCII
Binary

=0

Note

The transmission mode forwarded 1:1 and no editing is performed prior to
transmission.

Extract from the machine configuration file:
Binary = 0
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Send tab sheet/section [SEND]

The Send tab sheet describes the [SEND] section of the machine configuration file.
The transmission parameters of the machine server are set here.

machine 44_en |
General I Machine zerver [SERIMTSYR] I Code converzion zerver [DMNCCony]
Interface | Send | Feceive I Dialog function I Interpretation of data flow
—— Program (D Comrment Header Trailer
Start; IE Start; IH Length: IEI Length: IEI
End: ID Erd: IF Char.: ID Char.: ID
[ Suppress
— Spacer
Start of program (D End of program 1D
Length: IEI 1: I 1: I
Char.: Ilj o I o I
& I 2 I

End of line character; INu:une "’I Send timeout; I'I [miiri]
Send baud rate:; IEI Send delaw: IEI [zec]

Fig. 10-8 Config dialog/tab sheet: Send

Note
The ASCII characters are entered in decimal code (0 to 255).

© Siemens AG 2005 All Rights Reserved
FBDN1/10-154 Motion Control Information System DNC (FB) - 04.05 Edition



04.05

DNC Plant / DNC Cell (FBDN1)

10 Configuration

Program start ID

The program start identifier defines the program start marker inserted in front
of every NC data file as an ASCII character in decimal code (0 to 255).
(Example 065 for A)

Extract from the machine configuration file:
Progr antt art =65

Program end ID

The program end identifier defines the program end marker added at the end
of every NC data file as an ASCII character in decimal code (0 to 255).
(Example 069 for E)

Extract from the machine configuration file:
Pr ogr anEnd=69

Comment start

The comment start identifier defines the comment start marker inserted in front
of every comment as an ASCII character in decimal code (0 to 255). (Example
075 for K)

Extract from the machine configuration file:
Comment St art =75

Comment end

The comment end identifier defines the comment end marker added at the end
of every comment as an ASCII character in decimal code (0 to 255) (example
101 for e).

Extract from the machine configuration file:
Pr ogr anEnd=101

Suppress comment
This box can be checked to suppress comments when NC data are
transmitted.

Table 10-8 Comment during transmission

Comment is transmitted with other data

=[O

Comment is suppressed

Extract from the machine configuration file:
Supr essConment =1
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Header length
The leader length is specified in bytes. It describes the number of header
characters to be inserted.

Extract from the machine configuration file:
Header Si ze=8

Header character
The header character is inserted with the “header length” factor as an ASCII
character in decimal code (0 to 255) (example 072 for H).

Extract from the machine configuration file:
Header Char =72

Note
The header then looks like this: HHHHHHHH

Trailer length
The trailer length is specified in bytes. It describes the number of trailer
characters to be appended.

Extract from the machine configuration file:
Trail erSize=6

Trailer character
The trailer character is inserted with the “trailer length” factor as an ASCII
character in decimal code (0 to 255). (Example 078 for N)

Extract from the machine configuration file:
Trail er Char=78

Note
The trailer then looks like this: TTTTTT

FBDN1/10-156
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Spacer

If a file contains several NC programs to be downloaded together to the
machine, on some controls it will be necessary to insert a spacer between the
individual programs.

A spacer consists of a configurable number (SpacerSize) of identical
characters (SpacerChar).

Note

Spacers are converted when code conversion is selected (unlike the header and
trailer, which must be configured directly according to the code type).

Up to 6 strings can be configured to search for a location to insert a spacer.
Three strings are for the search for a program start identifier (SpacerMark1.. 3)
and three for the search for a program end identifier
(SpacerMarkinsertAfter1..3).

Note

Searches should be configured either for program start identifiers only or for
program end identifiers only. Mixed searches can cause two spacers to be
inserted between the NC programs.

With a program start identifier search, the spacer is inserted in front of the line
with the start identifier.

With a program end identifier search, the spacer is inserted after the line with
the end identifier.

Spacer length
The spacer length is specified in bytes. It describes the number of spacer
characters to be inserted.

Extract from the machine configuration file:
Spacer Si ze=15
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Spacer character
The spacer character is added to the “spacer length” factor as an ASCI|I
character in decimal code (0 to 255) (example 090 for Z).

Extract from the machine configuration file:
Spacer Char =90

Note
The spacer then looks like this: SSSSSSSSSSSSSSS

Up to 6 strings can be configured to search for a location to insert a spacer.

Three strings are for the search for a spacer program start identifier
(SpacerMark1..3) and three for the search for a spacer program end identifier
(SpacerMarkinsertAfter1..3).

Note

Searches should be configured either for spacer program start identifiers only or

for

spacer program end identifiers only. Mixed searches can cause two spacers

to be inserted between the NC programs.

FBDN1/10-158

Spacer start of program ID
The spacer is inserted in front of the line containing the program start identifier.
Program start identifiers can be up to 16 characters long.

Extract from the machine configuration file:
Spacer Mar k1 =%PF

Spacer Mar k2 =%SPF

Spacer Mark3 =

Spacer end of program ID
The spacer is inserted after the line containing the program end identifier.
Program end identifiers can be up to 16 characters long.

Extract from the machine configuration file:
Spacer Markl nsert Afterl =MB0O
Spacer Markl nsert After2 =ML7
Spacer Markl nsert After3
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* End-of-line character

The end-of-line character is the character, which identifies the end of a line. If

conversion of the end-of-line character is selected, SerIntSvr will proceed as

follows:

* When data are transferred to the machine, all end-of-line characters are
converted to CR-LF.

* When data are transmitted back from the machine, all CR-LF and LF are
converted as follows:

Table 10-9 End-of-line character conversion during transmission

End-of-line character |Meaning

0 Not converted
1 CRCR

2 CRLF

3 LF CR

4 LF LF

5 CRCRCR
6 CRCRLF
7 CRLFCR
8 CRLFLF
9 LF CRCR
10 LF CRLF
11 LF LF CR
12 LF LF LF
13 CR

14 LF

Extract from the machine configuration file:
ECBcode=0

» Send baud rate
The send baud rate specifies the transmission rate for transferring data, which
deviate from the interface definition ((COM] section). If the send baud rate is
set to 0, the baud rate of the interface definition ((COM] section) is used.

Extract from the machine configuration file:
SendBaudRat e =0

¢ Send timeout
The send timeout specifies the time in minutes at the end of which the send job
will be aborted if the machine is not ready to receive. The value 0 stands for
unlimited waiting.

Extract from the machine configuration file:
SendTi meout =1

e Send delay
The send delay specifies the time in seconds by which the send job to the
machine will be delayed.

Extract from the machine configuration file:
SendDel ay=0
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Receive tab sheet/section [RECEIVE]

The Receive tab sheet describes the [RECEIVE] section of the machine
configuration file. The return transmission parameters of the machine server are

set here.
machine 44_en |
eneral I tachine zerver [SERINTSVR] I Code corverzion server [DMCCony]
Interface I Send Receive I Dhaloa function I Interpretation of data Flow
Header length: Im— ¥ |gnore ZERD walues
Trailer length: ID— [T Test mode
First walid character: IEI—
Start of pragram character: IEI—
End of program character; IEI—
End of tranzmizzion character: II:I
g
k. | Cancel Help

Fig. 10-9 Config dialog/Receive tab sheet

Note

The ASCII characters are entered in decimal code (0 to 255).

¢ Header length
The header length is specified in bytes. It describes the number of header
characters to be removed after receiving.

Extract from the machine configuration file:
Header Si ze=8

© Siemens AG 2005 All Rights Reserved
FBDN1/10-160 Motion Control Information System DNC (FB) - 04.05 Edition



04.05 DNC Plant / DNC Cell (FBDN1)
10 Configuration

¢ Trailer length
The trailer length is specified in bytes. It describes the number of trailer
characters to be removed after receiving.

Extract from the machine configuration file:
TrailerSi ze=6

e First valid character
This is the first valid character of the NC program as an ASCII character in
decimal code (0 to 255) (example 086 for V). It is searched for in the header
range. All characters before this first valid character are cut off.

Extract from the machine configuration file:
Val i dDat a=86

e  Start of program character
This is the program start character as an ASCII character in decimal code (0 to
255) (example 083 for S). It is placed at the start of the file before each NC
program is received.

Extract from the machine configuration file:
Prograntt art =83

¢ End of program character
This is the program end character as an ASCII character in decimal code (0 to
255) (example 069 for E). It is placed at the end of the file before each NC
program is received.

Extract from the machine configuration file:
Pr ogr anEnd=69

¢ End of transmission character
This is the end-of-transmission character as an ASCII character in decimal
code (0 to 255) (example 4 for EOT). Reception is terminated when this
character is received.
If EOFChar=0, there is no monitoring for an end-of-transmission character and
reception is terminated on timeout.

Extract from the machine configuration file:
EOFChar =4

Note

If the machine does not send an EOFChar, uploading is terminated on timeout.
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End of reception after last character

This is the time in seconds at the end of which transmission will be terminated
if no further characters have been received. Values between 1 and 600 can be
entered. If a value of 0 is entered, no time monitoring is performed and
reception is only terminated by the end-of-transmission character.

Extract from the machine configuration file:
Ti meQut =10

Ignore ZERO values
This parameter specifies whether binary ZERO values in the transmission file
must be discarded.

Extract from the machine configuration file:
Nul | Di scard=1

Test mode

If the text mode is switched on (TestMode=1), temporary files in the
parameterizable temporary directory (default: ...Dnc\Tmp) are not deleted. This
allows the data transmitted and received to be compared.

Extract from the machine configuration file:
Test Mbde=0
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Dialog Function tab sheet/section [DIALOGFUNCTION]

The Dialog Function tab sheet describes the [DIALOGFUNCTION] section of the
machine configuration file. The parameters for the dialog function are set here.

machinel |
General I b achine zerver [SERINTSYR] | Code converzion zerver [DNCCor]
|nterface I Send I Receive Dialog function | |nterpretation of data Fow
Murber of zsignificant lines: Wiorkpiece |D: WP

Request 1D EMPF3333  File tvpe |D:

Rezponze |0 EMPFI938 0 Wildcard alternative:

ilil ]
|

Rezponze end ID: k430

Request far MC data command Lit request commard

I LL
With release 10: L] (LL]

Ilpload command

Wit trial cut 10 [LT] Ir

Esternal dialog interpreter;

1

| nterpretion type:

] | Cancel Helg

Fig. 10-10 Config dialog/Dialog Function tab sheet

Note

The ASCII characters are entered in decimal code (0 to 255).

If a machine is configured with the dialog function, the machine server is started
when the program is launched and runs until it ends.

You can see some examples of this in the Dialog programs and Dialog program
responses chapters.
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e Number of significant lines
This parameter defines the number of lines (starting at line 1) within the NC
data file, which are scanned for request identifier DIgID.

Extract from the machine configuration file:
Dl gScanLi nes=10

« RequestID
This parameter defines the identifier of a request sent by the CNC machining
unit using the dialog function.

Extract from the machine configuration file:
Dl gl D=9%PF9999

¢ Response ID
This parameter defines the identifier of the response to a request sent by the
CNC machining unit using the dialog function.
The response might contain the following:
List (response to list request)
Error message (response to a nonexecutable program request)

Extract from the machine configuration file:
Dl gl DSend=%vPF9998

« Response end ID
The end identifier for the response to a request made via the dialog function is
formulated with the DIgSendEnd parameter. It terminates either a list or an
error message.

Extract from the machine configuration file:
Dl gSendEnd=MBO

¢ Request for NC data command with release 1D
DIgSendCmd defines the command for requesting NC data with release
identifier using the dialog function. The parameter is a string that must be
formulated in accordance with the NC program.

Extract from the machine configuration file:
Dl gSendCnd=( S)

¢ Request for NC data command with trial cut ID
DIgSendTcCmd defines the command for requesting NC data with trial cut
identifier using the dialog function. The parameter is a string that must be
formulated in accordance with the NC program.

Extract from the machine configuration file:
Dl gSendTcCnd=( ST)
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List request command

DIgSendListCmd defines the command for requesting a list of NC data files
using the dialog function. The parameter is a string that must be formulated in
accordance with the NC program. It must be in the first line of the NC data file.

Extract from the machine configuration file:
Dl gSendLi st Cnd=( SL)

Upload command

DIgReceiveCmd defines the command for responding to a request. The
parameter is a string that must be formulated in accordance with the NC
program. Two programs are sent in succession:

Request program

Program to be uploaded

Extract from the machine configuration file:
Dl gRecei veCnd=(R)

External dialog interpreter

This parameter contains the name of an optional dialog interpreter. Using the
external dialog interpreter, it is possible to performed project-specific name
conversions. The program identifier (ProglD, consisting of
ComponentName.ClassName) of the relevant dialog interpreter must be
entered for this purpose.

Extract from the machine configuration file:
DI gConvert er=DNCDI gl . DNCCnt r |

Interpretation type
This parameter can be set to attach an additional identifier for code conversion
mode to the external dialog interpreter.

Extract from the machine configuration file:
DI gSubNunber =0
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Workpiece ID

Parameter DIgWpdMark defines the workpiece identifier in the dialog program.
For control systems, which are unable to edit all characters, combined
axis/numerical identifiers (e.g., Z888) can be used instead.

Extract from the machine configuration file:
DI gWhdMar k=WPD

File type ID

The file type identifier parameter specifies the identifier for file types in the
dialog program. For control systems, which are unable to edit all characters,
combined axis/numerical identifiers (e.g., Y002) can be used instead. The
character is communicated in the DIgExchangeCNCType parameter. The
numerical part of the identifier refers to the sequence of file types in database
table DNCDATATYPE, starting at 001, increment=1.

Extract from the machine configuration file:
Dl gExchangeCNCType=Y

Wildcard alternative

This parameter specifies the wildcard alternative in the dialog program for

control systems, which are unable to edit the * character. The parameter is
important for list requests, for example, to request lists of all data types or

filenames.

Extract from the machine configuration file:
Dl gExchangedunmy=X999
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Interpretation of Data Stream tab sheet/section [RECEIVE]

The Interpretation of Data Stream tab sheet is controlled in the [RECEIVE] section
of the machine configuration file.

machinel |

General I b achine zerver [SERINTSYR] I Code converzion zerver [DNCCony] |
Interface I Send I Feceive I Dialog function Interpretation of data flow

Interpretation mode 0. Deactivated

Mumber of significant lines:

Start D #Mamett

YWiorkpiece / MC name delimiter

MC name ¢ type delimiter

411

End D HEnd#t
Start of program (D End of program |0
1: |?; 1: |M3n
2 | 2 Ih-ﬂ?
El I i I
] Cancel Helg

Fig. 10-11 Config dialog/Interpretation of Data Stream tab sheet

Note

If the number of significant lines (NCNameLines) is > 0 when separator strings for
workpiece and type identifiers have not been defined, the machine configuration
is interpreted as containing an error (red dot on machine symbol).

If the dialog function and the interpretation of data stream are both active, the
data stream interpretation has priority over the dialog function, even when a
request program has been received immediately beforehand.

The data received are rejected if they are not a request program and do not
contain the identifiers (start identifier, workpiece identifier, etc.) for interpreting the
data stream.

If the received data contain a type, which DNC does not recognize, they are
rejected with an error message. None of the data are saved.
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Interpretation mode

Interpretation mode (NCSplit parameter) controls how data received are distributed
among the connected control systems. This parameter can have 3 settings:

Table 10-10 Interpretation of data stream: Interpretation mode: NCSplit parameter

Interpretation mode Description

NCSplit = 0 Deactivated

NCSplit = 1 SINUMERIK 840D/840Di/810D:
This setting activates the name assignment in accordance
with the SINUMERIK convention. The parameters for
determining the file name are irrelevant. The program start
and program end identifiers must be parameterized.

NCSplit =2 Other control:

The parameters for determining the file name as well as the
program start and program end identifiers must be
parameterized.

If a variety of external non-Siemens controls (other controls) is connected, the
syntax of the lines to be interpreted is not clearly defined.

In this case, you must set configuration parameters to specify how separator
symbols in the data and the name and type of the NC program file are stored.

Parameters for determining the file name

Table 10-11 Interpretation of data stream: Parameters for configuring NC data files for other types of

control (NCSplit=2)

Parameters Type |Meaning
Number of significant |integer | Number of lines (from start of program), which are scanned for the
lines (NCNameLines) name string
0 = Function deactivated (default)
Start ID string | String for identifying start of file name
(NCNameBegin)
Workpiece/NC name | String | Separator string between workpiece and NC program name
delimiter
(NCNameWPD)
NC name/type String | Separator string between NC program name and type
delimiter
(NCNameTyp)

End ID (NCNameEnd)

String for identifying the end of the NC program name

Note

It is essential for each individual NC program to have a name with identifiers
(start identifier, workpiece identifier, etc.) so that the data stream can be
interpreted. Failure to use proper identifiers can cause mix-ups and problems!

If a program file does not have the necessary identifiers, the name of the
previously stored NC program is used and identified uniquely by a serial number
as follows: _i (i=1, 2, 3, etc.). The file name (of the complete data stream)
assigned by the user is assigned to the first NC program in a data stream.

FBDN1/10-168
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Start of program ID/End of program ID (NCProgramsStart.../.NCProgramEnd...)

3 strings can be defined for the start and end of the program respectively; any
combination of start and end strings is valid.
Data can be split according to several different principles:

1.

Start identifiers are the only defined identifiers

The data preceding the first start identifier are ignored. The data located
between the first identifier and the next identifier are stored in the first file, the
data between the second and third identifier are stored in the second file, and
so on, until the end of the file is reached.

If a start identifier cannot be located, all the data are discarded and an
appropriate message is generated.

End identifiers are the only defined identifiers

All data from the beginning of the data stream up to and including the line
containing the first end identifier are stored in the first file. Data in the
subsequent lines are saved to the next file - up to the next end identifier, etc.
The last block is stored even if no more end identifiers are found. Similarly, the
entire data stream is stored if the file does not contain any end identifiers.
Both start and end identifiers are defined

Each data set located between a pair of start and end strings (including the
lines containing the identifier strings) is stored in a separate file. Data located
outside these string pairs are ignored.

The system searches alternately for either a start string or an end string:

The system initially searches only for the string containing the start identifier. Once
it finds the beginning of the program, it continues to search only for the string with
the end identifier, i.e., further start strings are ignored. Once it finds the end
identifier, it starts to search for the start string again.

The data are discarded if a start identifier cannot be found. If the final end identifier
cannot be found, all data up to the end of the file are stored.
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File interpretation on SINUMERIK 840D/840Di/810D

Data received serially from a SINUMERIK 840D/840Di/810D/802D/840C control
always contain information about the storage path as well as the file names in the
data management system on the control. The NC program name and file type of
these serially received data in the DNC are determined by the information used to
interpret the data stream. The syntax is specified by the SINUMERIK
840D/840Di/810D. If the files are received from a workpiece directory on the
control, then this directory information is also evaluated, in which case a
corresponding workpiece is created, or the NC program files are saved to a
workpiece directory with the same name (if one exists).

Note

All control lines contained in the data are always interpreted and the data thus
distributed among several files if necessary.

Important

The number of significant lines must be less than the number of lines in the
shortest NC program!
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Example

Start ID: #Name#
Workpiece/NC name delimiter  #SWPN#
NC nameltype delimiter #SNT#H
End ID #End#

Table 10-12 Example of data stream interpretation

File content 'Meaning
#Name#4-VALVE-CYLINDER-HEAD.MPF#End#

NC program:
4-VALVE-CYLINDER-HEAD.MPF

#Name#MOTOR#SWPN#4-VALVE-CYLINDER-HEAD.MPF#End#

Workpiece:

Motor

NC program:
4-VALVE-CYLINDER-HEAD.MPF

#Name#MOTOR#SWPN#4-VALVE-CYLINDER-HEAD.MPF#SNT#MPF#End#

Workpiece:

Motor

NC program:
4-VALVE-CYLINDER-HEAD.MPF
File type:

MPF

Internal syntax for SINUMERIK 840D

Number of significant lines: 3
Start of program ID: %
End of program ID: M30
End of program 1D2: M17
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10.4.5 Configuration file for interface type SINUMERIK 840D/840Di/810D

General tab sheet (machine configuration SINUMERIK 840D/840Di/810D)
[GLOBAL]

The General tab sheet defines the [GLOBAL] section of the machine configuration
file for SINUMERIK 840D/840DI/810D machine interfaces.

machine? |

Comparizon directanes I Job archive server I Rerate [ogin
General | FTP | Upload dislog

tachine IP addresz

DH path

Paszword I
NCU 1D |
DHS waiting time IE':I
FTP r

] 4 Cancel Help

Bild 10-11  Config dialog 840D/General tab sheet

¢ Machine IP address
The IP address or name of the machine (control) is entered here.

Extract from the machine configuration file:
Machi nel pAddr ess=PCU50

+ DH path
This input field contains the path to the data management system on the
control. An enable (share) must be set up on the control to permit the control’s
data management system to be accessed from the DNC computer.

Extract from the machine configuration file:
DHPat h=f $\ dh

- Password
In order to be able to access SINUMERIK 840D/840Di/810D operating with a
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high protection level from the DNC, the protection level for downloading and
uploading must be set accordingly on the DNC. To do this, the password can
be entered in the MCEF file. If this is configured, the machine’s protection level
is read out prior to downloading/uploading and, if necessary, the configured
password is set and reset after the download/upload procedure.

Using DNC to change the protection level also affects the SINUMERIK
operator interface, i.e., the machine operator has access to all the possible
operations afforded by this protection level.

Extract from the machine configuration file:
NC_LOG N=
NCU I D

+  Control identifier (ID) with M:N functionality

Extract from the machine configuration file:
NCU_| d=1

«  DHS waiting time
Time input for monitoring calls to the sag control server. (Accept default value,
if possible.)

Extract from the machine configuration file:
DCOMDhs Wi t =20

- FTP
If the FTP checkbox is activated (UseFTP=1), the download is performed via
FTP. Settings must also be made on the FTP tab.

Extract from the machine configuration file:
UseFTP = 1
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FTP tab sheet (machine configuration SINUMERIK 840D/840Di/810D) [FTP]

The FTP tab sheet defines the [FTP] section of the machine configuration file for
SINUMERIK 840D/840DI1/810D machine interfaces. The settings for downloading
data via FTP are made on this tab.

Note

The FTP checkbox also needs to be activated on the General tab sheet.

machine2 |

Comparizon directarnies | Jab archive server I Remate login
General FTF | Ilpload dialog

Haost IF addrezs

I1zer

Paszword
tode
ASCI i
Binany (o

] Cancel Help

Fig. 10-12 Config dialog 840D/FTP tab sheet

« IP host address
This input field contains the IP address or the name of the DNC computer.
(The computer must be configured as an FTP server.)

Extract from the machine configuration file:
Host | pAddr ess=127.0.0.0
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User and password
The user name and password required for FTP are entered here.

Extract from the machine configuration file:
User =
Passwor d=

Mode

This defines the mode of transmission. The following transmission modes are
available:

1: ASCII

2: Binary

Extract from the machine configuration file:
Mode=2
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Upload Dialog tab sheet (machine configuration SINUMERIK 840D/840Di/810D)
[UPLOADDLG]

The Upload Dialog tab sheet defines the [UPLOADDLG] section of the machine
configuration file for SINUMERIK 840D/840DI1/810D machine interfaces.

Note

The SINUMERIK 840D840D1/810D directories, which the user views when
uploading from SINUMERIK 840D/840D1/810D, are defined here.

mackine2 |

Comparizon directarnies I Job archive server | Fermate [ogin |
3eneral I FTP Ilpload dialog

Selected DH directories

[P T TR YT Tr R ITIITrTITTITFrrrreT

ARC.DIR

Cka.DIR

COM.DIR

CST.DIR

CUS.DIR

DEF.DIR B
DGE.DIR —I
DH.DIR

DR.DIR £4
H5.DIR —I
HME.DIR

MPF.DIR

DEM.DIR

FDADIR

SPF.OIR

SYF.DIR

Wark pieces

k. Cancel Helg

Fig. 10-13 Config dialog 840D/Upload Dialog tab sheet

The list on the left-hand side contains all possible 840D directories. Selected
directories can be transferred to the list of selected DH directories on the right-hand
side, or removed from that list, using the arrow keys.

Extract from the machine configuration file:
DHDI RL=NPF. DI R
DHDI R2=SPF. DI R
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Compare Directories tab sheet (machine configuration SINUMERIK
840D/840Di/810D) [COMPARE]

The Compare Directories tab sheet defines the [COMPARE] section of the
machine configuration file for SINUMERIK 840D/840DI1/810D machine interfaces.
The SINUMERIK 840D/840D1/810D directories to be compared with the
corresponding DNC system directories are specified on this tab sheet.

Note

The directories specified here are used for the Upload, (manual) Archive, Auto
Archive and Match Machines functions.

machine? |
General | FTP I Ilpload dialog
Comparizan directaries | Job archive server I Fiemate login
Selected DH directaries
ARC.DIR
- | Chid DIR
CST.DIR
CUS.DIR
Y | MPF.DIR
SPF.OIR
Workpieces
Pzeudo workpiece [
[ ata types I
File excluzsion I
] 4 Cancel Help

Fig. 10-14 Config dialog 840D/Compare Directories tab sheet

The list on the left-hand side contains all possible 840D directories. Selected
directories can be transferred to the list of selected DH directories on the right-hand
side, or removed from that list, using the arrow keys.
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Pseudo workpiece

If data from a selected DH directory are to be compared with a pseudo
workpiece called name.DIR, or archived in a pseudo workpiece, this checkbox
must be activated.

Note

If the Pseudo workpiece checkbox is activated, it is also taken into account
when uploading data.

If DNC IFC SINUMERIK is also installed on the relevant machine, the pseudo
workpiece identifier has to be set on that machine for the same data
management directory during configuration.

FBDN1/10-178

0: No pseudo workpiece
1: Pseudo workpiece

Data types
The data types to be taken into account when comparing and archiving are
specified here for the selected directory.

File exclusion

If certain files are to be excluded when comparing and archiving, they can be
specified in the File exclusion field.

e.g., EXCLUDE_MPF.DIR =Test1

Extract from the machine configuration file:
e.g., directory WKS.DIR (no pseudo workpiece), files of types MPF, SPF, TOA,
etc., are taken into account, file WKSA1 is excluded

DHDI R1 = WKS. DI R; 0; MPF; SPF; TOA; ZOA, RPA; WPL; JOB; BVP; ARC, | NI
EXCLUDE_WKS. DI R =WKSA1l
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Archive Server Job tab sheet (machine configuration SINUMERIK
840D/840Di/810D) [COMPARE]

The Archive Server Job tab sheet defines the [COMPARE] section of the machine
configuration file for SINUMERIK 840D/840DI1/810D machine interfaces.

As part of the Auto Archive process, NC active data (a subset of the series startup
data to be defined) from the control are to be secured as required. The relevant
settings are made on this tab sheet.

Note

The Auto Archive and Auto Compare boxes in the machine configuration must
also be checked in the machine’s Properties dialog.

machine? |
General I FTP | Ilpload dialog
Comparizon directaries Jab archive server Fiemate login
Juab file [

Archive fle |

"Wt aiting time |5 [Minutez]

] 4 Cancel Help

Fig. 10-156 Config dialog 840D/Archive Server Job tab sheet
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Job file

Job data for Auto Archive are stored in the job file. The data must be stored on
the PCU50/MMC103 in the add_on directory (same directory as DHS.EXE).
The name of this job file must be entered in the appropriate input field.

Extract from the machine configuration file:
ARCJOB=aaa

Archive file

This field contains the name of the archive file to be created. It is first created
on the machine's data management system and then uploaded to the DNC
system. If no name is specified, the name of the job file is used as the name of
the archive file.

Extract from the machine configuration file:
ARCFI LE=

Waiting time

Auto Archive is time-monitored, i.e., if no completed message is output for an
individual archive job within the specified wait time, Auto Archive continues
with the next subtask. This is recorded in the form of an appropriate entry in
the log file (ARSERVER.TXT in add_on\tmp).

Extract from the machine configuration file:
ARCTI MEOUT=5

| Important

Please call our hotline if you have any questions about setting up this function
(particularly regarding definition of the job file).
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Remote Login tab sheet (machine configuration SINUMERIK 840D/840Di/810D)
[REMOTELOGIN]

The Remote Login tab sheet defines the [REMOTELOGIN] section of the machine
configuration file for SINUMERIK 840D/840DI1/810D machine interfaces.

Remote login is necessary for downloading data if the download is not performed
via FTP and the data management directory on the control is enabled (share), but
the user logged onto the PC does not have access rights to the control.

Remote Login permits the user on the DNC PC to log onto the control using the
name and password set on this tab sheet.

machine? |

General I FTP I Ilpload dialog |
Comparizon directaries I Job archive server Remate lagin

Remote computer

Diamain IF'ELI BN
MName |ﬁ«LIDLISEFI
Pazswaord I’“"“““m

] 4 Cancel Help

Fig. 10-16 Config dialog 840D/Remote Login tab sheet
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Remote computer
This input field contains the IP address or the name of the Remote Network
Server.

Extract from the machine configuration file:
Renot eName=PCU50

Domain
The domains to which the user is assigned are specified here. If the user has
local access only, this matches the name in the Remote computer field.

Extract from the machine configuration file:
Dormai n=PCU50

Name and password

The name and password used to access the data management system on the
control are entered here

(see DHPath path in General - [GLOBAL] section).

Extract from the machine configuration file:
User =AUDUSER
Passwor d=****x**
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10.4.6 Configuration dialog for file system interface type

General

The file system machine type can be used to transfer NC data to and from any
shared network drives. Any network-capable control system can be linked to the

DNC system under Windows. Two directories must be configured for downloading
and uploading NC data.

File zystem properties

Send directony

I'x'xMau:hine_E'xlnputDir

Receive directony

I'x'xMau:hine_E'xDutputDir

Fig. 10-17 Config dialog, File System

Note

Only users with project design/configuration user rights are authorized to define
directories for the file system machine type.

Send directory
This is the directory to which NC data are downloaded.
Receive directory

When uploading, NC data transfer the specified receive directory taking the version
strategy into account.

Note

The directory specification is not computer-dependent if the directories are
specified using UNC notation, e.g., \Server1\DNC\Data.
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10.4.7 Dialog function

General
To configure the dialog function, the Dialog function box on the Configuration tab in
the Machine Properties dialog must be checked. The dialog function remains active
until it is unchecked again in configuration mode.

GroupA machinel |

Configuration |

Configuration file: Edit
machinel tHCF
Config dialog
Transmigzion module: Drigplay araup far list:
| Serial without protocl ~| ™ Dialag function |DELLIST =l
¥ Manual abart
IJpload directory Search levelz for MC data

I_n machinel j I_l machinel j

k. Cancel Help

Fig. 10-18 Machine properties/tab: Configuration
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Display groups for response lists

= LISTDESCRIPTION : Tabelle M=l E3

DISPLAYGROUP | LPOS| COLUMNNAME |FIELDNAME_GR|FIELDNAME_UK CDLWIDTHI
| |GROUFAD 1 NCDATANAME  MName MName 20
| |GROUFAD ZMNCDATATYPE Twp Type G
| |GROUFAD 3 VERSION Yersion Yersion 7
| |GROUPAD 4 RELEASEID Freigabekennung Release 1d. 10
¥ |GROUPAD STRIALCUTID Einfahrkennung  Trialeut Id. 10
| |GROUFAD 6 LENGTH Lange Length 10
| |GROUFPAD TAREA Bereich Areg 5
| |MLISET 1 NCDATANAME  Mame Mams 1
| |MLIET ZMCDATATYFE Twp Type 1
| |MLIETT 3 VERSION Yersion Yersion 1
| |MLIST 4 RELEASEID Freigabekennung Release I1d. 1
| |MLISTY 5 LENGTH Langes Length 1
& 0
Datensatz: 14| ¢ || 5 | r1 e von 12

Fig. 10-19 List description for dialog function lists

The display group of the list refers to response lists requested via the dialog
function.

You can edit the list display of a display group in the List Editor. The List Editor
can also be used to set up a new display group if no suitable list display is
available. Display groups are defined via the DNC database table
DNCLISTDESCRIPTION.

Display groups can be selected from all defined lists, even those created for the
customized list display in the right-hand window of the operator interface.

Depending on the options available in the Control System Editor, it can be
advisable in some instances to select short list displays for the dialog function.

Note

The contents in displays of response lists requested via the dialog function for
links are predefined as follows:

« Name

 Size

« Changed on
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Downloadlist.txt - Notepad -0l =|
File  Edit Search Help
%MPF9998 -
{Hame Type Release Id. Trialcut Id. Length)
(Bielle-moteur MPF 1 a 1487 )
{Cycle-filetage-B11 SPF 1 a 254}
{up SPF 0 1 17 )
H3 g
Kl A

Fig. 10-20 Response list for a dialog function request

Search levels for NC data

The search directory configured for the dialog function is machine-specific, i.e., all

requested programs and lists can only be copied from this defined section. The

search directory is configured via a combo box offering the following search areas:

e Link (When the “Link” option is selected, a second combo box appears
displaying all the links configured on the machine. One link for the
configuration must be selected from this list.)

¢ Machine

¢ Machine, group (search area is machine and higher-level group)

Upload directory

The upload directory configured for the dialog function is machine-specific, i.e., all
uploaded programs must be copied from within this defined section. The search
directory is configured via a combo box offering the following search areas:

e Link (Upload directory: Link assigned to the machine; the file is stored here

without management data.)

« Machine

e Group (Upload directory: Group superordinate to the machine)

Note

DNC generates management data for uploaded files stored in a Machine or
Group directory. All automatic processes regarding data versions and
release/trial-cut identifiers are applied.

FBDN1/10-186
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Configuration errors on the machine server in connection with the dialog function
are indicated by a red square on the machine icon on the operator interface.
Communication errors in the dialog function are caused by configuration errors on

the machine server.

The following situation is an example of how a communication error can occur on a
machine when the dialog function is activated:

Machine 1 and machine 2 are both working with the dialog function. The machine
server for machine 1 is configured at COM port 1 and the machine server for
machine 2 as well. In this instance, the operator interface displays a

communication error on machine 2.

#= DNC - Terminall

File Edit “iew Exhaz Help

J & Eaii | e X e
Ik

Adress I

area robars
group B cylinders
machine 43 dt
machine 44_en
machine 39_it

E| D group 8 cylln-:ler

E| ﬁ area gears
: manual gear

autamatic gear
=i SKF
EI {1 Gidsmeister

P ~rarnos

mach

[

Hame | Tupe | Ve,

BMF 1

ine?

T

Fig. 10-21 Communication error on machine server with active dialog function
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10.5 Global settings

The following global settings are defined in database fields NAME and INTVAL in
database table DNCGLOBALSETTINGS:

¢ Maximum permissible number of versions (default: 5)

¢ Version strategy for uploads (default: 1)

» Store strategy after editing (default: 1 (new version after editing))

e Maximum number of NC blocks displayed in a list (default 1000).

Note

In order to change the default value of 1000, the “ReadMaxRecords” entry may
have to be recreated.

« Invalid characters for NC data identification
« Version strategy for automatic import
e Other entries for special options

An integer value INTVAL or a string STRINGVAL is assigned to the key of the
NAME field for this purpose.

10.5.1 Maximum permissible number of versions

The maximum permissible number of versions is assigned via the MaxNCVersions

key.

Table 10-13 Global settings for maximum permissible number of versions
Database field NAME Database field INTVAL
MaxNCVersions >1
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10.5.2 Versions strategy for uploads
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The version strategy assignment is defined via the VersionStrategy key.

Table 10-14 Global settings for version strategy for uploads

Database field NAME

Database field INTVAL

VersionStrategy

1..6

One of 6 strategies can be selected:

Table 10-15 Version strategy for uploads

Configurable
numbers for

version strategy

Version strategy for
uploaded NC data

Release strategy for
uploaded NC data

Delete strategy when max.
no. of versions
is reached

1 (default) The next free version is | The release identifier is not | The version with the oldest
assigned. set.* modification date and not
released is deleted.
2 " " The "Delete dialog" version
is displayed.***
3 " The release identifier is The version with the oldest
set.** modification date and not
released is deleted.
4 " " The "Delete dialog" version
is displayed.
5 The highest version is The release identifier is not
replaced. set.*
6 " The release identifier is

set.*

The existing release identifier from an older version remains unchanged.
The existing release identifier from an older version is reset.
The dialog function does not support a Delete Version dialog, for reasons

of automation. Strategy 1 or 3 is therefore applied when version strategy 2

or 4 is configured.

Version strategies do not apply to links since no management information is
available in the database for link NC data.

Note

The version strategy is set once when the software is installed. Any subsequent
changes should be made by Siemens to avoid inconsistencies in the data

management system.
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10.5.3 Store strategy after editing

The assignment of the store strategy after editing is defined via the
NewVersionAfterEdit key.

Table 10-16 Global settings for store strategy after editing
Database field NAME Database field INTVAL

NewVersionAfterEdit 0/1

One of 2 strategies can be selected:

¢ 0= Unchanged version and existing identifiers
* 1 = Next free version with identifiers from the edited version
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10.5.4 Machine-specific version management

General

Machine-specific version management uses version ranges to define the hierarchy
level at which NC data with the same name (same name, same type and same
version) are permissible. Defining a version range ensures that the same program
will always be used for processing within the version range.

Version ranges are always defined on higher-level nodes (Groups or Subgroups).
The node on which the version range is defined and all lower-level nodes (Groups,
Subgroups, Machines) comprise the version range.

Note

The plant root (at the very top) is a node, but not a group.

Version ranges can only be defined on nodes (Groups, Subgroups) and not at
machine level.

Defining a version range means that all lower-level objects are directed by these
nodes (including NC data located directly underneath that node).

Note

If no version range is defined, every object (all nodes and all machines) forms a
separate version range. This is the default setting.
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Upload

Setting a version range resets all lower-level version ranges. Version ranges
cannot be set on lower-level nodes of the version range that has been set.

Nodes marking the start of a version range are indicated by a white field with a “V”
in tree view.

The version range is defined via the PROCESSINGRANGEID field in the
DNCNODEINFO table.

The NODEID of the node, which defines the version range, is entered here.
The NODEID of the node on which the version range is based is entered in the
PROCESSINGRANGEID field for this node and all lower-level nodes.

The version range is taken into account when uploading an NC data file. Before
uploading begins, a check is performed to see whether the maximum permissible
number of versions of this NC data has already been reached within this version
range.

If this maximum has been reached, an older version is deleted or the Delete
Version dialog is activated automatically before uploading, regardless of the
version strategy. The user can delete versions manually using the Delete Version
dialog.
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10.6 List Editor

10.6.1 General

The appearance of the list display is also stored in the database. This means that
it can be adapted to suit the individual requirements of users and machines
(display groups). You can create one list display in several languages for each

display group.
Mame | * | Tupe | Yersion | Trialcut Id | Release Id | Length
=] cut-off-cycle SPF 4 1 0 a7
cut-off-cycle SFF 3 0 747
cut-off-cycle SPF 2 1 0 707
manual_gear MPF 3 1 0 4365

@ gear-yellow

Fig. 10-22 Variant of list display on operator interface
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List descnption editor

Screen form defaulks ok,

Dizplay group: GROUPAD j LE = Cancel 1

Save

Delete

el

Colurmmn name: |, ]Name Coalurmn: INamE

[
IGH j IName Index: I‘I_ . | | 2
IFH j IN-:um du programme-pigce Wwdidth: IT Delete curr. colurmn |
I arne | Tup | We. . | Rele... | Trial... | Lengthl Area |

Fig. 10-23 List Editor

The List Editor is divided into 3 parts:

Part 1: Defaults with buttons, which relate to the complete list display for the
display group in question. Complete list display means that the list of all
existing languages for one display group is saved, deleted or left
unchanged (with Cancel).

Part 2: Data entry section with edit buttons and input fields.

Part 3: Preview of list display based on default settings

Note

Changes to the list display currently in use do not take effect until the next
time you start the DNC or DNC Admin program.

For the sake of clarity, not all available languages have been displayed in this
dialog. It is also unlikely that all the languages supported by DNC would be used
in one production plant.
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10.6.2 Description of part 1 of the List Editor

General

The defaults define the preview that can be viewed in part 3 of the Editor. The
display group also determines the complete list definition (see above) that will be
modified and saved currently.

You can choose between existing display groups in the Display group combo box.
When you change display groups, you must also decide whether you wish to save
the changes you have made.

You can choose between the available languages in the Language combo box.
This field determines the language for your preview.

Create a display group

To create a new display group, enter the name of the new display group in the
Display Group combo box. Save this group immediately.

Note

Before you create a new group, select one with a list display that is similar to the
one you want to create. Use this list display as a basis for the new one so that
you don't have to start right from the beginning.

A new display group must also have a screen definition before you can assign
it to a user.

Delete a display group

/N

When you select the Delete button, the complete list display is deleted in all
languages for this display group.

Caution

Before you delete a display group, make sure that it is not current in use by
another user or a machine (see Dialog function)!

The list definition of the DELLIST display group is absolutely essential for DNC
IFC SINUMERIK. Do not delete the DELLIST display group if you want to use
DNC IFC SINUMERIK.

The GLOBAL list definition is used for the cross-area filter function. If you delete
this list definition, then the currently active list definition of the relevant user
becomes operative.
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10.6.3 Description of part 2 of the List Editor

Calurn: IName j

Indes: I‘I_ £ | S, |
Wfidth: IT Delete curr. u:u:ulumnl

Fig. 10-245 Right-hand section of List Editor (part 2)

Select a column

In the Column combo box, you can select which of the existing management data
for the NC data will be included in future in the list display and choose a column for
editing.

You can also select the Column (management data) using the mouse in the
preview.

Index

The Number after index indicates the position of this column in the list display.
You can use the arrow keys to change the position of the column.

Width

You can enter the column width directly as it must appear in the list in all
languages. Alternatively, you can specify a width directly in the preview using the
mouse. However, since you can set the width more accurately with the mouse, we
recommend that you check the width setting. To do this, enter the width again and
then select another field with the mouse, monitoring the relevant field as you do so.
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Delete a column

To delete the column currently selected in Column, select the Delete current
column (see above) button. This will delete the column in all languages!

Add a column

To add a new column, you must select a management data in the Column
selected combo box. Then enter the column names in the relevant language (see
below). Click on one of the Index buttons (the arrow keys) to set the index and
then set the column width. The new column will now be displayed in the preview.

Column name

Colurmn name: g ]Name

IGH j IName

IFH j INDm du programne-pigce

Fig. 10-256 Left-hand section of List Editor (part 2)

In the window shown above, you can enter the column name as it must appear in
the list for the appropriate language. The fields for languages: GR for German, UK
for English and FR for French can be viewed here (see also: Languages).

Here, you can transfer, extend, truncate or completely redefine the column name
as it appears in the right-hand section (see screenshot above: Right-hand part of
List Editor (part 2)).

Note

You can leave empty the input fields of languages that you do not know.
However, it is recommended that you fill out these fields in your own language. In
this way, no empty list headers result if the language is changed.
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10.7 Screen Editor

10.7.1 General

The appearance of the Properties screens for NC management data is also stored
in the database, which means that you can adapt the screen display to suit your
own requirements. You can create one screen display in several languages for
each display group. Properties screens have a predefined resolution of 360x160

pixels.
I
Field Edit ‘“iew
Screen form defauls 1] 4 |
Dizpl | e
e R S = F O IPAD Screen fnrmINew MC data j
Save |
[ Large display UK | » PaQEZIGeneraI j Cancel I
Field: IName j {:iEM IEdit box E j Dielete curr. fieldl
VDE:
|1 EET: field [Editbox  E =l Refresh |

Coordinates

Field ] IN ame

| [N
||3F| J I ame "

ISP j IN:::mI:ure programa Length: |

"

e IE

17

=
=

Fig. 10-26 Screen Editor

The Screen Editor is divided into 3 parts:
Part 1: Defaults with buttons, which relate to the complete screen display for the
display group in question. These defaults also determine the preview.

Part 2: Data entry section with edit buttons and input fields for the displayed
preview
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Fig. 10-278 Screen Editor - Preview

Part 3: Preview of screen display based on default settings

Note

Changes to the screen display do not take effect until you restart the DNC
program. Changes take effect immediately in DNC Admin.

For the sake of clarity, not all languages available in the Screen Editor are
displayed at the same time. It is also unlikely that all the languages supported by
DNC would be used in one production plant.
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10.7.2 Description of part 1 of the Screen Editor

General

These defaults determine the displayed preview. The display group also
determines the complete screen definition that will be modified and saved
currently. Complete screen definition means that the definition is saved for all
existing languages.

Field Edit iew

Screen form defaults (] |
Dizplay group:

GROUPAD Screen fu:urml Mew MC data j |

Save

[T Large display UK = Page: IGeneraI j Cancel I

Fig. 10-289 Screen Editor — Part 1

You can choose between existing display groups and create new ones via the
Display group combo box. When you change display groups, you must also
decide whether you wish to save the changes you have made.

All other fields are used to set the preview.

You can select the type of screen you want to create and display in the preview via
the Screen type combo box. Select NC Data New to create a screen for setting up
a new NC management data set. Select Display/Edit to configure the screen in
which you can view or edit existing NC management data.

Check the Big view box to display the preview in enlarged format rather than in the
standard display format. If "Big view" is checked for the selected display group, you
must check this box to ensure that screens are displayed and configured in the
correct size.

You can toggle the displayed preview language via the Language combo box

You can toggle the tab sheet displayed in the preview via the Tab Sheet combo
box.

The menu options under View provide you with the same functionality as the
combo boxes.

Select Edit>Tabulator Sequence to display and edit the tab sequence of the

displayed screen. The Tabulator field in part 2 of the Screen Editor can then be
edited.
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Create a display group

To create a new display group, enter the name of the new display group in the
Display group combo box. Save this group immediately.

Note

Before you create a new group, select one with a screen display that is similar to
the one you want to create. Use this screen display as a basis for the new one so
that you don't have to start right from the beginning.

A new display group must have a list definition before you can assign it to a
user (see List Editor).
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10.7.3 Description of part 2 of the Screen Editor

General
Field: IName j {:iEhj IEu:Iit box E j Delete cum. fieldl
WOe:
1 Few field ? - |
I_ tvpe: |E|:||t bow E J Refrezh
Fild LK IName Coordinates
% |5 ne |42
GR =| |Mame —
e = | i
ISF' j INDmI:ure programa Length: [40
Fig. 10-29 Screen Editor — Part 2
In part 2 of the Screen Editor you can edit the screen display for the relevant
display group.
Field

In the Field combo box you can select the management data to be included in
future in the screen display and choose a field for editing.

Delete current field

This button deletes the field selecting in the Field combo box from the screen
definition.

Refresh

This button refreshes the preview.
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The Editor includes two combo boxes for the selection of field types.

The upper Field type combo box is provided for the "Display/Edit" screen type.

The lower New field type combo box is provided for the "NC Data New" screen

type.

You can choose between the following field types:

Table 10-17 Field types

Field type Function Display example
Edit box Input field :

P Werzion I
Combo box Combo box 1

Type I -

Checkbox Checkbox TrialcwtdD ™
Output field Inactive input field Length |—
Output field checkbox Inactive checkbox Triglcut-0 |—
Static text Text field Name

The combo box is intended for the program type only, as a data selection list is
required. This is possible only for the program type in the current version.

Please note that checkboxes can display only "0" or "1".

The Edit box and Output field (inactive input field) field types can be used for

every field.

The Static text (text field) cannot display a data value. It can be used for every

field.
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Tabulator

This input field, which can be edited by selecting Edit->Tabulator Sequence,
displays the tabulator index of the field selected in the Field combo box.

When you open the Properties screen, the field with the lowest tabulator index is
automatically selected. As you move from field to field using the tabulator, the
cursor always jumps to the field with the next-higher tabulator index, until the field
with the highest index has been reached. The cursor then goes to the buttons in
the screen. Finally, it will return to the field with the lowest tabulator index.

Note

Tabulator indices need not be arranged sequentially (1,2,3,4,....10) and the
tabulator sequence can also contain gaps (1,3,5,6,7,10). The advantage of this is
that you do not need to sort all the fields again if you change the tabulator
sequence.

Field names

Figld 1K, IN ame

IGH j IName

ISF‘ j INDmI:ure programa

Fig. 10-301 Screen Editor - Field names

In the window shown above, you can enter the field name as it must appear in the
screen for the appropriate language. The fields for languages (GR for German, UK
for English and FR for French) can be viewed here (see also: Languages).

Here you can transfer, extend, truncate or completely redefine the name shown in
the Field combo box.

Note

We recommend that you specify names of approximately the same length in the
different languages as the coordinates apply to all languages in the field. This is
not the case in the above screenshot and the French field name is truncated in
the screen display.

You can leave the input fields of languages that you are not familiar with empty.
However, we do recommend that you enter your own language in these fields, so
that field names will be displayed in the Properties dialog when you switch
languages.
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Coordinates

Coordinates

w |5
w o [5
Length: '4|:|

Fig. 10-31 Screen Editor - Coordinates

You can select the display position and size for every field selected in the Field
combo box in the window shown above.

System of coordinates:

* x goes from left to right (1 to 350 in pixels)

ey goes from top to bottom (1 to 150 in pixels)

e Top left-hand corner of tab sheet is the origin (x=1;y=1)

x is the horizontal start position for the field name.
y is the vertical start position for the field name and input/output fields.
x2 (1 to 350 in pixels) is the horizontal start position for the input and output fields.

The field name comes before this (coordinate x). x2 is relevant only for edit boxes
(input fields), output fields (inactive input fields) and combo boxes.

K Y

General | About | Extensions | Comment |

Fig. 10-323 Screen Editor - Positioning a screen field
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The length must be at least 1 (1 to 80 letters wide in normal view). "Length" with
respect to edit boxes (input fields), output fields (inactive input fields) and combo
boxes refers to the length of the input field or combo box without the field name.
Length is irrelevant for other field types (exception: Length = 0 = means field will
not be displayed !!)

Feldlange LEN

Comment

Fig. 10-334 Screen Editor - Length

Note

Fields positioned outside screen borders will be truncated!

With new fields it is useful to note the positions of the other fields so that you can
structure the screen symmetrically.
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10.7.4 Saving the screen display in the database

General

Database table DNCFORMDESCRIPTION defines the screen display of the
Properties screen for the NC data and import function. All other screen forms have
a predefined layout.

Table 10-18 Screen definition table DNCFORMDESCRIPTION

DISPL. COL. FIELD .. |DLG PAGE | X Y |X2 |[LEN |FIELD
GROUP NAME N._GR ORD. TYPE
GR_AD NCDATA Name 1101 1 5[ 5| 42 40 | E
NAME
GR_AD DNCDATA Type 1102 3 5125| 42 3|/COB
TYPE
GR_AD RELEASEID |Release 1103 1 5180| 42 1| CKB
ID
Group1 VERSION Version 2108 2| 150] 25| 200 3|E
Group1 TRIALCUTID | Trial-cut 2109 1| 15080 | 200 1| CKB
ID

Field DISPLAYGROUP

DISPLAYGROUP: The display group defines the user group to which the screen
display will apply. The name of the DISPLAYGROUP can be freely defined.

Field COLUMNNAME

COLUMNNAME assigns the form field to the field with the same name in database
table DNCDATA.

Note
COLUMNNAME evaluates only field names from DNCDATA.
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Field FIELDNAME_<LANGUAGE>

These database columns contain the language-specific field names.

FIELDNAME_GR contains the German field designation,
FIELDNAME_UK contains the English field designation, etc.

Field DLGORDER

DLGORDER defines the classification number of the fields in the form display. This
number must be unique. We recommend that numbers are assigned on the
following basis:

Display group Tab sheet Tabulator sequence

"

1 2 0 8

Fig. 10-345 Classification numbers for fields in screen display

1208 thus means:

e Display group 1 -> GROUPAD

e Tab sheet?2 - About

e Tabulator sequence 0-8 —> Field is reached on eighth actuation
Field PAGE

PAGE defines the tab sheet (page) on which the field is to be positioned. The
assignments are as follows:

¢ 1> General tab sheet

e 2-> About tab sheet

¢ 3 Extensions tab sheet

Note

The tab labeled Comment is reserved for comments about NC data. It cannot be
configured via the DNCFORMDESCRIPTION table.
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Fields X,X2 and Y

The X and Y fields define the pixel coordinates at the top left-hand corner of the
display field, along with the field designation.

The X2 and Y fields define the pixel coordinates at the top left-hand corner of the
display field, without the field designation.

Field LEN
LEN specifies the length of the field in characters.

Field FIELDTYPE

FIELDTYPE defines the type of screen field in the NC data Properties screen form.
The following field types can be defined in DNC:

¢ Output field >0

« Edit field 2> E

e« Combo box -> COB
¢ Checkbox -> CKB

e Output checkbox -> OCKB
e Static output field > STXT

Field FIELDTYPE_NEW

FIELDTYPE_NEW defines the field type for data acquisition (Import and New NC
Data screen).

This special field type for data acquisition makes it possible to define

input fields, which appear only as display fields in the normal Properties dialog, i.e.,
which cannot be altered by the operator following data acquisition.

e Output field >0

e Edit field 2> E

e Combo box -> COB
e Checkbox -> CKB

¢ Output checkbox -> OCKB
e Static output field -> STXT
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Notes
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11.1 General

11.1.1 Central log book

DNC provides a central troubleshooting facility, which is operative across all
applications.

Log messages (errors and messages; not traces) from all DNC applications (DNC
IFC SINUMERIK, DNC Cell, DNC Plant plus Auto Archive and Auto Import) are
recorded in a central database table. These applications exclude those such as
SerlIntSvr (machine server) or DNCConvSvr (code conversion server), which are
not linked to the database.

All errors and messages generated in response to relevant events are stored.

11.1.2 Separate error/message file

If the database is not available when an error/message occurs, the error/message
is saved in a separate error/message file.

11.2 Functions of the central log book

You can view the error/message entries in the database in DNC or DNC Admin.
Call this function by selecting Options > Log Book. Filter definitions can be
applied to control the data view. Errors/messages can be deleted from DNC Admin
and exported to a text file.

The following processes are recorded in the log book:
¢ User login (system message)

« Create/delete users

* Create/delete NC data

¢ Import/export NC data

¢ Download/upload NC data

e Set/reset version ranges

¢ Result of automatic archiving

¢ Activate optional packages

 Etc.

© Siemens AG 2005 All Rights Reserved
FBDN1/11-212 Motion Control Information System DNC (FB) - 04.05 Edition



04.05

DNC Plant / DNC Cell (FBDN1)

11.2.1 Display of messages

shown below:

11 Error Management

All messages and errors in the database are displayed in chronological order as

T | Timestamp | Errarmnu.. | Text | Station | Application [=]

S 0F072003092734 0 Log-in DMC b achinez? DMC IFC SIMUMERIE. =

Mo 07.07.200309.21:27 0 ki Filker b achinez2 DML IFC SINUMERIE

S 0r.0720030921:25 0 Log-in HMISystem b achinez2 DML IFC SINUMERIE

S 07.0720030921:24 0 Log-in HMISystem b achinez2 DML IFC SINUMERIE

S 0707200309217 0 log-out HMISystem tachinez2 LML IFC SINUMERIE

Mo 070720030913:39 0 Import von: FADME_IFC_SINAT mphat. . DML Admin

WMo 07.0720030915%41 0 Impart von: EAMCIS_PHP stark gf - - DML Admin

5 07 .07 2003 031467 0 Anmeldung siemens DM Admin

M 07.07 2003090908 0 kein Filter tachine? DML IFC SINUMERIE.

S5 07.07200309.0904 0 Log-in HiISystem tachine? DML IFC SINUMERIE.

S 07.07200309.0904 0 Log-in HiISystem tdachine? DML IFC SINUMERIE. j
[efete Erpmrt * j Filter |

Fig. 11-1 Log file

Table 11-1 Log book display

Displays Meaning

E/M/S Error/Message/System message

DD.MM.YYYY HH:mm:ss Time stamp
Error code

Text Error text/message text
Station

DNC IFC SINUMERIK Application

DNC Cell

DNC Plant

DNC Station

Auto Archive

Auto Import

Note

By clicking once on the column header, you can sort messages in ascending or
descending order based on these categories.
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11.2.2 Filtering log data

Click the Filter button to open the filter editor. All the functions of the filter editor
are available for selection (see also Chapter 3.2). If you have activated a filter, only
filtered data will be displayed.

11.2.3 Export errors/messages

In DNC Admin, you can export errors/messages from the central log book to an
external text file for use elsewhere if necessary. The export file generated is stored
in ...DNC\Export.

Note

If you apply the default settings, the Export directory is rerouted to the Import
directory.

File name of export file

The file name of the exported error/message file is: LogyyyyMMdd_x.TXT (the
index x is incremented by 1 for each file if several export files are created on the
same day. The first file has the index 1).

Structure of export file

E| 2002- 09- 25 10: 36: 43. 183000000] - 1| Error ReadFi | t er Col urm| DNC Admi n| Ter mi nal 1|

The columns in the error/message list are represented by the | character in the
export file.

Caution

If you have applied a filter to the log file, only the data displayed (filtered) will be
exported!
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11.2.4 Delete errors/messages
You can delete errors/messages from the central log book in DNC Admin.

A Caution

The delete operation applies to all data displayed! To protect some log data
against deletion, you must apply a filter beforehand. The delete operation always
deletes all the log data displayed!
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11.3 Separate message file

If the database cannot be accessed when an error/message occurs, messages are
saved to the ProgramName.log file, which is independent of the database.

The size of this separate message file is set to 10 KB. A new message file is
created if the original file is not large enough to hold all the messages (while the
database is inaccessible). The old data remain stored in file ProgramName.old until

the current file is filled again.

You can view these alternative ProgramName.log and ProgramName.old log files
by opening them in a text editor.

Note

Data from separate message files are not transferred to the database
automatically.
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12.1 Functions performed by DNC Auto Archive

# DNC - C:\SiemensSMCISA\DNCATmp

File Edit ¥iew Options Machine Alignment Help
|& d R« Xl 7 || | =l
JAddress |
ﬁ MCIS || Mame | * | T_l,lpel Versionl Hele.l Lengthl Alchivl
E{:l area gears ) 4-valve-cylinder-head-1 MPF 1 1 1787 1
- (B NC programming system ) cut-off-cycle SPF 4 0 EW 2
=3 automatic gear Sl fire-grinding-cycle 1 1
; machine 1 T -
% s picture] BMP 2 0 40018 0
-2 machine 3
ED manuel gear
. W machine 4 LI
4 | | | 7

Fig. 12-1 List display with Auto Archive identifier

Note

Archiving can also be activated manually via the operator interface for a machine

or machine group.

See also: Chapter 4.5 - Manual archiving

FBDN1/12-218
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12.1.1 General

The Auto Archive function compares the NC data on SINUMERIK
810D/840DI/840D machines with the data in the DNC system and transfers items
automatically to the DNC system in the event of deviations.

The Auto Archive function requires DNC IFC SINUMERIK to be installed on the
SINUMERIK 810D/840D1/840D control. Automatic archiving also includes NC data
loaded in the NC data management system of the SINUMERIK 810D/840DI/840D.
As well as main programs, subprograms and workpieces, all other data
management server files and NC active data can also be archived.

The Auto Archive function downloads NC data and NC active data created or
edited on the SINUMERIK to the DNC server automatically, where they are
archived. This ensures that data created or edited on the SINUMERIK (e.g.,
following loss of data on the SINUMERIK) are available and up-to-date on the
server.

Note
DNC Auto Archive is available for PCU 50/70, but not for MMC 103.

12.1.2 Auto Archive identifier

Archived files are assigned an identifier (the Auto Archive identifier). The Auto
Archive identifier is shown in the DNC list display, in the Archive column (see Fig.
12-1).

The following Auto Archive identifiers are possible:

Table 12-1 Auto Archive identifier

Auto Archive Meaning

identifier

0 File has not been archived or
archiving was set to 0 by current archiving operation.

1 File has been archived and is available on the
SINUMERIK. This program is the most up-to-date
version.

2 File has been archived previously, but is no longer
available on the SINUMERIK.
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12.2 Configuring Auto Archive

12.2.1 General

In order to configure SINUMERIK 810D/840DI1/840D machines for automatic
comparison and archiving, it is necessary to activate the machine’s Auto Archive
checkbox in DNC Admin. The upload directory is always the machine directory.

Basis of comparison for Auto Archive

NC data from the machine directory in the DNC system, whose Auto Archive
identifier is set to 1 or 2, are compared with NC data from the machine directory
on the relevant SINUMERIK 810D/840DI/840D. If no version is found with an Auto
Archive identifier, enabled NC data from the search level in the DNC system are
compared with NC data from the machine directory on the relevant SINUMERIK
810D/840D1/840D.

The comparison is performed on the basis of modification date and the length of
the files to be compared.

For each individual machine, you must configure the DM directories for the
machine and the file types from these DM directories to be compared or archived.

Time of Auto Archive

In order to specify the times at which automatic comparison and automatic
archiving are performed, you must add DNC Auto Archive to the Windows task
scheduler (2000, XP).

These configurations are explained in more detail in the following chapters.
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12.2.2 Configuration in DNC Admin

With DNC Admin in configuration mode, the properties of the machine must be
configured for Auto Archive.

Note

These functions are available only if you have the appropriate authorization.
See: User administration

Areal Sin840D |

Configuration |

Configuration file: EDIT
Sing400. MCF
[Earfigdialoa
Transmigzion module: Drigplay araup far list:
| SINUMERIK 2400 | ¥ Auto Compare |DELLIST =
v Auto Sichive
IJpload directory Search levelz for MC data

ﬁ machirne 5 __‘_‘“_j r maching 3 ._:j

k. Cancel Help

Fig. 12-2 Machine properties in configuration mode

You must first set the transmission module "SINUMERIK 810D/840D1/840D".
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Auto Compare/Auto Archive checkboxes
To use only the compare function, only check the Auto Compare box.

To archive NC data from the machine to the DNC system, check the Auto Archive
box as well.

Note

Only one of the Auto Compare and Auto Archive boxes should be checked at
once. If both are checked, the comparison will be performed twice before the
archive operation is performed.

The Upload directory is set to Machine automatically when Auto Archive is
selected and the NC data search level of the machine can be modified.

Points to be noted about the NC data search level

The configured search level is machine-specific. It determines the levels at which
searches are performed for NC data for comparison purposes.

Note

The search for Workpieces is restricted to the machine directory. However, an
entry is made in the Log database and the Log trace file if a workpiece of the
same name is located within the search level. This is to prevent “half” workpieces
being generated in the machine directory with separate program versions.

The search directory is configured in a combo box offering the following search
areas:

e Machine

e Machine, group (search area is machine and higher-level group)

Note

The upload directory must be located within the search level or a new version
of the same program will be set up every time it is archived.
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Points to be noted about Auto Archive

If workpieces are included in the Auto Archive run, then they are uploaded to the
machine directory, even if workpieces of the same kind are located within the
search level, but not in the machine directory. This is designed to prevent half
workpieces being created in the upload directory.

Whether or not the archived NC data are released will depend on the version
strategy (see Configuration). Their version is determined accordingly. The “Delete
Version” dialog is not displayed, so that the archive operation is fully automatic
without operator intervention. The version strategy is therefore changed
automatically from 2 - 1; from 4 - 3 in DNC Auto Archive.

The search directory is configured in a combo box offering the following directories:
¢ Machine
e Group (upload directory: of the higher-level group of the machine)

Note

DNC creates management data for uploaded files. All automatic processes
regarding data versions and release/trial-cut identifiers in DNC are applied.

The Auto Archive function also sets the auto-archive identifier to 1 for archived
data. If the machine directory already contains NC data with the same name and
type, their Auto Archive identifier may be reset to 0.

If the upload directory for the machine contains NC data that cannot be found on
the machine, the Auto Archive identifier is set to 2 for NC data, which were
previously either released or had Auto Archive identifier = 1.

The NC data Auto Archive identifier is only set or reset within the machine
directory. Otherwise, it could be set/reset by several machines, rendering the
assignment unclear.
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12.2.3 Configuration in the machine configuration file

General

DHDIR...

A machine is to be configured with DNC Admin. To do this, start DNC Admin
configuration mode, select the machine and open the Machine Properties
dialog. Use the Edit button to open the correct machine configuration file. If no
configuration file has yet been stored for this machine, a configuration file with the
standard parameters for the SINUMERIK transmission module will be set up and
opened.

The [COMPARE] section is reserved for Auto Archive. The DM directories to be
matched as part of the archive process with the DNC system are listed in this
section. Parameters are also set for each DH directory specifying whether files
from the directory are to be archived to a pseudo workpiece with workpiece name
*.DIR and which file types are involved in the archive process. Furthermore, it is
also possible to exclude individual files in each DH directory from the comparison
and archive runs.

The individual parameters of a DH directory are separated by “;".

Note

Automatic archiving is station-dependent. This means that only machines on the
relevant station are compared and archived.

You can set this parameter to define up to 30 DM directories for each machine
(DHDIR1 ... DHDIR30).

The numbering determines the sequence in which DM directories are compared
and archived.

Directories do not need to be numbered consecutively.
Extract from the machine configuration file:

DHDIR1 = MPF.DIR;0; MPF
DHDIR3 = SPF.DIR;0; SPF
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DH directory name

The first entry after the equality sign contains the name of the DH directory to be
compared and archived.

Extract from the machine configuration file:
DHDIR1 = MPF.DIR;0; MPF

Note

If the DH directory contains another subdirectory, this subdirectory will not be
included in the comparison or archive operation.

Pseudo workpiece

The next entry is the "yes/no" identifier, which determines whether this DH
directory must be compared or archived in a pseudo workpiece. This will be
necessary if the different DM directories to be archived contain files, which have
the same name and type. Pseudo workpieces are clearly assigned to the source
directory of the data. They also prevent a version explosion.

A pseudo workpiece can be identified by its name, which is the same as the DH
directory (*.DIR workpiece identifier).

Value range:
0; FALSE : Files are placed in an upload directory directly.

1; TRUE : Files are placed in a pseudo workpiece with the same name as
the DH directory in the upload directory, and are also searched for there in the
DNC system for comparison purposes.

Extract from the machine configuration file:
DHDI R5 = CST. DI R TRUE; AWB; COM SPF
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File types

The files types to be compared and/or archived in this DH directory must be
defined after the pseudo workpiece "yes/no" identifier. File types are also

separated by ";".

Note

Please note that only file types entered in the DNC database table
DNCDATATYPE can be selected.

Extract from the machine configuration file:
DHDIR3 = WKS.DIR;0; MPF;SPF;TOA;ZOA;RPA;WPL;JOB;BMP;ARC;INI

Exclude specific files

Files to be excluded from the automatic comparison or archive operation can be
specified for each DH directory. The syntax comprises the keyword: "EXCLUDE_"
and the DH directory.

Extract from the machine configuration file:
DHDIR1 = MPF.DIR;0; MPF; CEC
EXCLUDE_MPF.DIR = Test; Test1

In this case, test.mpf, Test.cec; Test1.mpf and Test1.cec are excluded if such files
are stored in the MPF.DIR directory.
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12.2.4 Save control NC active data

NC active data

In principle, Auto Archive can only archive data from the control, which can also be
saved in a file in the operator interface’s file system. The Save NC active data
function can be used to partially cancel this restriction.

Data, which are only found in the NCU/NCK, are consolidated in a data archive,
which is recreated by DNC for each archive operation, and saved there in ASCII
format. These data, which cannot be recorded individually (e.g., drive data or GUD
variables), are referred to in this document as NC active data.

As part of Auto Archive, a previously defined subset can be used to create a data
archive using data from the NC, the PLC and the file system, before the actual
archive run is performed. This archive is stored in the data management system
archive directory (ARC.DIR), and is archived using the Auto Archive mechanism.
Exactly one archive file, which is set up in the archive directory prior to the archive
operation, can be defined for each machine. If a file already exists, it is overwritten.
An input file is used to define the data be included in this archive file.

Settings for this function must be made on both the control and the DNC master
computer.

This function supports the creation of standard archive files.

The subareas of the NC active data to be taken into account by DNC Cell/Plant via
Auto Archive and to be read anew during every archive operation and stored in the
archive file can be defined.

This function expands the Services server (ARServer.EXE) interface.

Note

It is not possible to create series startup archives or upgrade archives.

Important

The Save control NC active data function can only be implemented on the
PCU50.
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Creating the input file for Auto Archive from the derived data:

The PCU50 Services function can be used to generate the input file for creating an
archive manually.

Use the Select key to select the desired data areas (e.g., “Machine Data -
Channel1”, “Setting Data — Axis2” and “Tool Offsets”).

Next, generate an archive manually (Archive button).

Once an archive has been generated, the F:\tmp directory contains an input file
named ARCHIVEXX.IN, in which the parameters used in generating this archive
are entered.

This file can then be copied to the F:\add_on directory 1:1 and, if necessary,
renamed as something more meaningful, e.g., NCACTDATA.IN. This name must
be entered in the relevant machine configuration file under the ARCJOB parameter
(see Chapter 10.4.5 Configuration dialog for interface type SINUMERIK

840D/840Di/810D).

Note

Please call our hotline if you have any further questions about the Services
server.
Services CHAN1 JOG Ref

KHB_TEST.MPF
Program aborted

. Channel reset

8022 : Option 'activation of more than 768kB SRAM' not set m

Programs/fdata: SOURCE L NC_ACT.DIR
| Name |Type| Luadedl Lengthl Dﬁtel Enﬂblel _
P=r Archive DIR 19/05/2005 X ~! IRs232C
i NC-active-data DIR 06f11f2002 x

| Machine-data DIR X 0140171980 X _

- Meas.-system-error-comp. DIR X 0170141980 X

-/ Option-data DR X 010171980 % P

- Protection-zones DIR X 0170171980 b

- Quadrant-error-compensation DIR X 01/01/1980 X _

- R-variable DIR X 0170171980 ® Disk/

| Setting-data DIR x 0170171980 s Card

-3 Tool/magazine-data DIR X 0170141980 X

-0 User-data DIR X 0170141980 ® _

e Work-ofisets DR X 0170141980 X T

=E Initialization-program-{INI} INI X 0 01/01/1980 ®

E) Sag/angularity-complete INI P 0 o//1980 X _
| Part-programs DIR x 0170171980
) Subprograms DIR X 010171980
| User-cycles DIR x 0440372004 x LI
Free memory: Hard disk:  2.970.134.b28 NCU : 148.680

Job is ready

Data out
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Settings on the master computer

Settings are made on the master computer via the Archive Server Job tab sheet
(machine configuration SINUMERIK 840D/840Di/810D) in the configuration dialog
for interface type SINUMERIK 840D/840Di/840D (see Chapter 10.4.5 Configuration
dialog for interface type SINUMERIK 840D/840Di/810D).

Settings on the control

Data found only in the NCU or the PLC on the control system and not compatible
for transfer to the hard disk unless an archive file has been created should also be
saved using Auto Archive.

These data come from the following areas:

« GUD (Global User Data)
e TEAdata (axis machine data)
¢ R parameters

*  Work offsets

¢« Compensation data

¢ Option data

e Setting data

We do not recommend that you save all the data from the areas mentioned above.
Only data, which could change during operation, should be saved in an archive file.
Data generated automatically by setting devices or tool offsets are not relevant for

the backup.

Data, which have a fixed directory on the control’s hard disk and can also be
transferred to the hard disk by the NC, if necessary, do not have to be saved in this
way. This data is better archived using standard Auto Archive of compressed data.
This includes the following data and directories, for example:

MPF.DIR (parts programs)
SPF.DIR (subprograms)
WKS.DIR (workpieces)
CUS.DIR (user cycles)
CMA.DIR (manufacturer cycles)
CST.DIR (standard cycles)
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12.2.5 Auto Archive start parameters

The Auto Archive function uses two start parameters:

ONLYCOMP

This parameter determines whether the machine setting for archiving is valid, or
whether it must be skipped so that only a comparison process is performed.

If this start parameter is not set, the archive function is performed according to the
machine setting.

If the start parameter "ONLYCOMP" is set, comparison without archiving is carried
out on all machines configured for “Auto Compare”, regardless of whether they are
also configured for the “Auto Archive” function.

Call:
DNCAArch.exe ONLYCOMP

SHOW_FILESONDNC

This parameter determines whether NC data in the DNC system, but not in the
SINUMERIK machines, must be displayed in the comparison result.

If this parameter is not set, these NC data are not displayed in the comparison
result as they are generally of less interest in relation to Auto Archive.

These NC data are displayed when start parameter "SHOW_FILESONDNC" is set.

Call:
DNCAArch.exe SHOW_FILESONDNC
DNCAArch.exe ONLYCOMP SHOW_FILESONDNC
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12.2.6 Starting Auto Archive automatically
You can use the Windows Task Scheduler (Utility: Task Scheduler) (2000, XP) to
start Auto Archive automatically at specific times.

To use the Task Scheduler, it must be running (in the background) and you must
specify the start times for DNC Auto Archive using AT commands.

Example:
C:\> AT 01:00 /every:M,T,W,Th,F,S,Su "C:\Siemens\MCIS\DNC\DNCAArch.exe”

Automatic archiving starts every day at 1 am.

C\> AT
The list of scheduled commands is displayed

Status ID Day Time Command line

1 EveryMTW Th F...01:00 AM C:\Siemens\MCIS\DNC\DNCAArch.exe

Note

For more information about the task scheduler, in the Windows Help (Start>Help
and Support Center), please refer to index entry: Task scheduler — AT
command (scheduled tasks and AT command).

Automatic archiving can also be started via Start/Settings/Control
Panel/Scheduled Tasks/Add Scheduled Task.
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12.3 Comparison results

Each time Auto Archive is launched, it creates or replaces a file with the
comparison results for every archived machine. These files are stored in the DNC
data directory in subdirectory: CmpResult, with the machine name and extension
"_AArch.txt".

The files are in English.

The file content is as follows:

1. Group and machine name (listed in order)
2. The date (at beginning and end)

3. "NC Data in machine only", listing files that have been found on the machine
only.

4. "Different NC data", listing machine files, which deviate from the
corresponding files in the DNC system.

5. "NC Data in DNC system only", listing files that have been found in the DNC
system only. This section is generated only when start parameter
"SHOW_FILESONDNC" is set. The Auto Archive identifier is set to 2 for NC
data included in this section and located in the upload directory.

6. On completion, the end result indicating whether any Auto Archive errors have
occurred and the number of archived files is also displayed. If no errors have
occurred, and if this machine is configured for archiving, then all the above files
must be archived, which means that no further deviations will be found when
DNC Auto Archive is next launched, provided that the data on the machine
have not been edited again by that point.

12.4 Tracking the Auto Archive process

Since Auto Archive has no operator interface, the central log book is the only
means of checking the Auto Archive sequence.

The comparison results can also be used to trace the Auto Archive history.
However, these results are reset each time Auto Archive is launched, so that no
history can be traced. They display only the last actions taken for each machine.
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1 Introduction

1

SINUMERIK DNC IFC SINUMERIK software is used to interface (via an Ethernet
network) CNC machines running SINUMERIK 810D/840D/840Di (PCU50/70 (or
MMC103, only available on a project-specific basis and on request)) with the DNC
Plant or DNC Cell NC program management system.

1 Introduction

DNC IFC SINUMERIK provides operator interfaces on the SINUMERIK operator
panel, via which you can request NC data such as NC programs, workpiece data
(e.g., in graphical format) from the DNC Cell/Plant archive. You can also upload
NC data, e.g., optimized NC programs, to the DNC archive.

This software, therefore, gives you speedy electronic access to the up-to-date NC
data and information (including graphics) you need on your SINUMERIK system.

DNC Cell/Plant

Ethemnet " "

SINUMERIK 840D/840Di/810D

Fig. 1-1 SINUMERIK with DNC IFC SINUMERIK link to DNC on an Ethernet
network.
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2 System Requirements

2

2 System Requirements on SINUMERIK

D I o =T e V7= T = FBDNZ2/2-8

2.2 SOMWAIE ...t FBDNZ2/2-8
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04.05
2 System Requirements

2.1 Hardware

DNC IFC SINUMERIK is compatible with SINUMERIK 810D/840D/840Di with the
following hardware:

» PCU 50/70 with OP 010/012/015

¢ MMC103 with OP 031/032 (only possible on a project-specific basis, on
request)
also:
- PCI/ISA adapter
- Ethernet network interface

2.2 Software

The following SINUMERIK software is required for DNC IFC SINUMERIK:

« HMI software version 6 or higher on Windows NT/XP on PCU 50/70
* MMC software version 4.04.17 or higher

(only possible on a project-specific basis, on request)
on Windows 95 on MMC 103

Note

Only possible on a project-specific basis, on request
Functionality is restricted when using MMC 103 (e.g., no archiving).
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3 Operator Interface

3.1 DNC IFC SINUMERIK operator interface
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3 Operator Interface

DNC IFC SINUMERIK is integrated into SINUMERIK HMI and can be started via
the DNC IFC function key.

3.1 DNC IFC SINUMERIK operator interface on the SINUMERIK
system

The basic user interface comprises the following elements:

FBDN2/3-10

DNC management

for displaying the NC programs stored in the DNC Cell/Plant DNC archive and
for transferring NC data to the SINUMERIK

MMC/PCU data management

for displaying NC programs stored in the SINUMERIK data management
system and for uploading these data to the DNC Cell/Plant DNC archive
Log book

for displaying NC program downloads and various system messages, for
example

Filter

for selecting and editing NC data filters in the DNC Cell/Plant DNC archive
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3.2 Structure of the operator interface

3.2.1 General

3 Operator Interface

DNCIFC  [CHAN1 Jog

Channel reset

Program aborted

Contents of PCU/MMC --- area motorg/group 6 cylinders/machining centre

— DMC target
Target in DMC

|machining cenitre

= MMC/PCU Name

| T_l,lpel L| Length | Changed

; el P art-programs
-3 Subprograms

EIB‘ ok pieces
-3 GEAR.WPD

B MCASING.WPD

-3 MOTOR.WPD

03 Archive =] 44/ALVE-CYLINDER-HEAD

MPF 14 1040142002
MPF 7490 2811420
MPF 7490 28/411/200

zelect all

Transfer

DNC PCU/MMC Logbook
management; JEETTIUTI

Fig. 3-1 DNC IFC SINUMERIK operator interface

Structure

Logout

The DNC management screen is divided into the following areas:

(1) SINUMERIK HMI header
(2) Title bar

(3) DNC IFC SINUMERIK screen content

)
)
(4) Vertical softkeys

(5) Horizontal softkeys
(6) Message line

(7) Direction of transfer

Header (1)

The header is an integral component of SINUMERIK HMI. The most important
machine states, the numerical control status and the alarms of the alarm server are

displayed here.
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3 Operator Interface

Title bar (2)

The title of the relevant screen window is output in the title line. It also shows the
NC data archive structure of the machine in the DNC archive. In the above
example, we are managing the machine data in the DNC archive in the area
motors group, the group 6 cylinders subgroup and the machining centre
machine.

Note

The NC data archive structure of the machine is implemented in the configuration
program (DNC_IFC.INI) on the PCU50/70 or MMC 103.

Screen content of DNC IFC SINUMERIK (3)

The screen always comprises a source area and a destination area. The DNC data
management is always displayed in the upper part of the screen; depending on the
screen, this will either be the destination or the source.

DNC IFC SINUMERIK offers two views of the NC data stored in the system:

* DNC management

¢ MMC/PCU data management system

Selected NC programs can be downloaded via softkeys.

Other functions can also be activated via softkeys:
¢ Log book

e Filter

¢ Detail view of NC data

Message line (6)

Error and operational messages (e.g., for downloading) are displayed in the
message line.

“wr

The “” symbol, used to call up online help, is located on the right-hand side.
Transfer arrow (7)

A directional arrow appears where the upper and lower areas of the screen meet to
indicate the direction of transfer for the transmission of NC data.
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3.2.2 Refreshing the displayed NC data

In active system operation, the NC programmer can add NC programs to the DNC

archive and release or delete NC programs, etc. So that these changes in the DNC

archive are displayed in DNC IFC SINUMERIK, the screen is refreshed:

* Automatically when DNC IFC SINUMERIK is switched to the foreground

e Cyclically if configured in the configuration interface. The time between the last
operator action to the first refresh and the time between two refresh cycles can
also be set.

3.3 Online help

Operator support for DNC IFC SINUMERIK software is available via the Info key,
which opens the online help. This help provides information about the active
screen as well as about how to use the system.

3.4 Languages

If the language is changed on the control system, DNC IFC SINUMERIK is
automatically adapted to the new language, provided that it is available for DNC
IFC SINUMERIK.

DNC IFC SINUMERIK is supplied in German, English, French, Spanish, Italian,
Chinese and Russian. Online help is available in German, English (for the English,
Chinese and Russian DNC IFC SINUMERIK), French, Spanish and Italian.
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Notes
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4.1 Interface with DNC Cell/Plant

DNC IFC SINUMERIK is used to access NC data are archived and managed in
DNC Cell/Plant. DNC IFC SINUMERIK enables the user to upload or download
NC data from the control system via an Ethernet network.

4.2 Downloading NC data from DNC Cell/Plant to the
SINUMERIK control

4.2.1 View of the DNC Cell/Plant data management system

DNC IFC  [CHAN1 Jog

MFPFD

Channel reset

Program aborted

Contents of DHC - area motors/group b cylinders/machining centre
—DMC Source k4 | M PF-Filter
Marne | # | Tvp | \erzsion | Fiel... | Trialcutid | Length |
4-valve-cylinder-head MFF 3 1 1] 430
clamping setup = BMP 1 1 0 40018
SousoiR
cut-off-cpcle SPF 4 1 0 710
cylinderheadyG45 * MPF 2 1 1] 1732
drivinggear 3368 * MPF 2 1 0 1793
fine-grinding-cycle SPE 4 0 0 E780 Transfer to
kepwap-milling-cycle SPF 4 i} 0 455
okar

Target in PCUAMME ar HCE ' Free Space
{workpieces\MOTOR

E1374464 Byte

DNC
management:

PCU/MMC

Services

Logbook Logout

Fig. 4-1 DNC management

General

The DNC management screen provides the machine user with a user interface for
viewing the available NC programs and for downloading NC data.
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Selecting the system topology hierarchy level in DNC

Depending on the system topology, NC data can be stored on several hierarchy
levels (group, subgroup, etc., machine) in the DNC Cell/Plant archive. Using the
appropriate vertical softkeys, you can navigate these hierarchy levels in order to
view the NC data on these and higher levels.

The hierarchy assignment of the NC data in the DNC Cell/Plant system topology is
recorded in the * column. The assignment is as follows:

Table 4-1 Assignment of NC data in DNC system topology

* Column Meaning
Machine

* Group

** Higher-level group
Source

NC data, which are available for the SINUMERIK in the higher-level DNC

Cell/Plant archive, are displayed as a tabulated list towards the top of the screen.

The list shows all the available NC data and workpiece directories of DNC in

alphabetical order.

Table 4-2 Symbols used in DNC data management in DNC IFC SINUMERIK

Identification Meaning

Symbol for NC data

ﬂ Symbol for workpieces/pseudo workpieces
Target

The standard target for the transfer is displayed towards the bottom of the screen.
Depending on how DNC IFC SINUMERIK is configured, the NC data are
transferred:

¢ tothe PCU/MMC (Transfer to PCU/MMC)

or

e directly to the NCK (Transfer to NCK).

The target path is determined by the NC data type, except in the case of
workpieces and pseudo workpieces.
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4.2.2 NC data download (default)

NC data can be selected in the source area and downloaded to the SINUMERIK.

In this case, the NC data can be:

« stored on the operator panel with integrated PC (PCU or MMC) (PCU Transfer
softkey)

or

» loaded directly to the NC area (NCK = NC kernel) (NCK Transfer softkey).

You can switch between download targets PCU/MMC or NCK if the Transfer to
PCU/NCK Select key (configurable in the configuration interface) has been
configured.

Individual NC data files from the DNC source are downloaded to the relevant
PCU/MMC type directory or to the NCK. In the control, NC data associated with a
workpiece is also transferred to the relevant workpiece directory, whatever its file
type. Ongoing copy operations are shown in the message line.

Table 4-3 Correlation between NC data type in DNC and the target path on PCU/MMC or NCK

NC data file type in DNC Target directory in PCU/MMC or in NCK )*
.MPF Parts programs

.SPF Subroutines

.ARC Archives

NC data in workpieces Workpieces

)* If no pseudo workpiece is defined. Files from pseudo workpieces are downloaded in each case to data
management directories of the same name.

If a type conversion is configured in the configuration interface of DNC IFC
SINUMERIK, file types are converted according to the conversion tables when they
are downloaded to the PCU/MMC or the NCK.

NC data downloads from DNC to the control system are independent of the system
topology in DNC.
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4.2.3 NC data download (with change in target, name and type)

4 Functions

A
DMC IFC  [CHAHN1 Jog MPFD
Channel rezet
Program aborted
Transfer from DNC to --- area motors/group & cylinders/machining centre
— DMC Source
ame | * | Tvp | Version | Rel... | Trialcutid | Length |
2] cylinderheadyE45 MPF 4 0 i 455
@:‘ MMCAPCL MHame | Typel L| Length | Changed
E' Archive 4-valve-cylinder-head MPF 7452 21.11.2000
-8 Part-prorams dvabve-cylinder-head MPF 104 21.11.2000
g E\;‘bim_g'am clamping setup WP mator EMP 4008 21.11.2000
B orkoieces |5
- t-aff-cpcl SFF 36 21.11.2000
£ GEARWFD peeeE
03 MCASING . WPD
- A
-1 WMOTOR WPD 4| |_,|
Diirectom T arget file name Type
|motor |cylindelhead\-f545

Screenform

DNC
management

PCU/MMC

SeIvices

Logbook

Fig. 4-2
example, a workpiece directory)

General

Downloading NC data to a selectable target on the SINUMERIK (in this

Using this function (Transfer to softkey), when downloading NC data, you can:

¢ Change the name of the target file

« Change the type of target file and target directory
* Save the NC file to a workpiece directory

« Change the workpiece name in the target system

You can also download the NC data to the PCU/MMC, or load them directly to the

NCK, as described above for the default download.
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4.2.4 Delete

Click the Delete softkey to delete unreleased NC data files from the DNC
Cell/Plant archive (if you have the appropriate user rights).

DNC IFC  [CHAN1 Jog :‘PFD

Channel reset

Program aborted

Contents of DNC --- area motors/group 6 cylinders/machining centre

—~DMC Source 7 | WPF-Filter
| Mame I * I Tup I W ersion I Rel... I Trialcutid I Length I
4-valve-cylinder-head MPF 3 1 0 7440
clamping setup = BMP 1 1 0 40018
Scus piR
cut-off-cycle SPF 4 1 ] 710
cylinderheadvids = MPF 2 1 a 1792
drivinggear3368 *  MPF 2 1 0 17493
fine-grinding-cycle SFF 4 0 0 B7a0

SPF 4 0 0 455

' DK delet
Target in PCUAMMC ar MCK Free Space elete

Wwiortkpigces\MMOTOR

E1374464 Byte

DHNC
management

PCU/MMC
services

Logbook

Filter

Fig. 4-3 Delete NC data
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4.3 Uploading NC data from the SINUMERIK to DNC Cell/Plant

4.3.1 View of PCU/MMC data management system

General

Target

Source

DNCIFC  [CHAN1 Jog

Channel reset

Program aborted

Contents of PCU/MMC --- area motorg/group 6 cylinders/machining centre
— DMC target
Target in DMC

|machining cenitre

&= MMC/PCU Name | Twpe [ L] Length | Changed
00 Archive =] 44ALVE-CYLINDER-HEAD HPF 14 104012002
-progrars £] CYLINDERHEADVE4S MPF 7490 28/11/2001
23 Subpragrams 2] DRIVINGGEAR336S MPF 7440 284112000
=5 Workpieces
£ GEAR WPD
£ MCASING WP
EI MOTOR S/PD zelect all

£ MOTORBLOCK WP

Transfer

DHC PCU/MMC Logbook Logout
management ST U

Fig. 4-4 PCU/MMC data management system

The PCU/MMC data management screen provides the machine user with a user
interface for viewing the NC programs available on the SINUMERIK control and for
uploading NC data.

The upper section of the screen displays the target in the DNC Cell/Plant archive.
This target area (group, machine) is set in the configuration interface.

The lower area of the screen displays the PCU/MMC data management structure
in a hierarchical tree and list view.
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4.3.2 NC data upload (default)

You can select NC data (e.g., optimized NC programs) in the source area and
upload them to a target area on the DNC Cell/Plant archive.

This target area (group, machine) is set in the configuration interface.

The NC data belonging to a workpiece are transferred (irrespective of their NC data
type) to the relevant workpiece directory on the configured hierarchy level (group,
machine) in the DNC archive.

NC data from data management directories, for which a pseudo workpiece is
configured in DNC, are uploaded to the appropriate pseudo workpiece.

If a type conversion is configured in the configuration file, file types are changed
according to the conversion tables when they are uploaded to the DNC system.

The message line indicates copy operations in progress.

Before an NC data file is uploaded, a check is made to determine whether the
maximum number of versions of these NC data is already stored in the DNC
archive. If this is the case, depending on the version strategy selected, data are
either deleted automatically prior to the upload or the "Delete Version" dialog
appears to prompt the user to delete one of the existing older versions. Following
deletion, the user can choose whether to resume or abort the transfer initiated.
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4.3.3 NC data upload (with change in target, name and type)

General

DNCIFC  [CHAN1 Jog

Channel reset

Program aborted

Retransfer from PCU/MMC to ---area motors/group 6 cylinders/machining centre/MOTOR
—DMC Target

[ ame | * | Typ | Yersion | Rel... | Trialcutid | Lenagth | ;l
E CYLINDERHEALWEAS MPF 11 ] 1 74490

drivinggear336a = MPF 1 0 i] i]

fine-grinding-cycle SFF 4 0 i] &0

il SPF 1 1 0 B0

Drefault target for DMC
Diirectory “Workpiece Target file name Type

Imachining Certne |MDTDFI | IWF‘Dj

4YALVE-CYLINDER-HEAD MPF 7432 28/11/200
CUT-OFF-CvCLE SPF 3E 2811520

PCU/MMC

services

DNC

management

Logbook

Fig. 4-5 Uploading NC data to a selectable target in the DNC (in this example: target
workpiece MOTOR)

Using this function (Transfer to softkey), when downloading NC data, you can:
¢ Change the name of the target file

« Change the type of target file and target directory

e Save the NC file to a workpiece directory

NC data can be uploaded to any selected location in the system topology (group,
machine).

Change the workpiece directory via the input field in the target directory

When the workpieces are new, this does not exist in the DNC archive and is not
displayed in the list view. You have to enter the name of the new workpiece.
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4.4 NC data detail view

General

FBDN2/4-24

DNCIFC  |CHAN1 Jog

MPFO

Channel reset D etail

General

Program aborted

Detail General ---clamping setup.BMP

~DMNC
Mame |clamping setup Type IBMP *I
YWarsgian |1 WwWirkpiece |
Release- 1D ~ Trialcut- 1D r
Length |4gm a Avta Archiv ID
Develname  [ojemens Develdate [21.09.93 1542:07
tModname I roddate I
Loadcounter  [77 Lastload J21.11.0011:2014

DNC
management

Fig. 4-6

PCU/MMC

services

Logbook

Detail dialog

Apart from the program name, further management/detail information is recorded
about every NC program and can be viewed in DNC IFC SINUMERIK.

As with DNC Cell/Plant, the screen layout is user-dependent. The screen
description is managed by DNC Cell/Plant.

The Detail dialog box can contain up to four detail screens, each of which is called
up using the vertical softkeys.

Management data released for editing can be changed.
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Show Graphic

4 Functions

Graphics such as graphical information about workpiece machining can be called
via the Show Graphic softkey.

DNC IFC

CHAN1

Jog

Channel interrupt

Program aborted

Graphic for DNC IFC SINUMERIK ---

Fig. 4-7

Display of a graphic in the detail view

Note

Graphics can only be displayed with the PCU and access via network drives (not

in conjunction with FTP protocol).

You can display all types of graphic supported by Internet Explorer (e.g., BMP,
JPG, GIF). To display other types of graphic, you must install the relevant
plug-ins. The types of graphic must be entered in the configuration interface.
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4.5 Filter function

The filter function allows you to filter the view of the DNC Cell/Plant archive. When
the filter is activated, only data meeting the filter conditions are displayed.

Note
Filters for DNC IFC SINUMERIK are created and assigned in DNC Cell/Plant.

You can access the following filter functions via the Filter softkey in the DNC
management and PCU/MMC data management screens:

¢ Filter ON/OFF
« Edit current filter
¢ Filter selection

4\

DMC IFC  [CHAN1 Jog MPFD

Channel interrupt

Program aborted

Setting for DMC IFC SINUMERIK --- area motorg/group 6 cylinders/machining centre

— DML getting T4 | 4PF Filter
Filter
OM/OFF
Cur. edit filter
Filter
selection

DNC PCU/MMC Logbook Logout

management] services

Fig. 4-8 Filter settings
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Switch filter on/off

The name of the current filter is specified under the title line in the Filter screen.

The filter symbol indicates whether or not the filter is activated.

v 7

Filter activated Filter deactivated

You can click a softkey (F3) to activate or deactivate the current filter.

Edit current filter

DNC IFC  |[CHANI1 Jog MPFD

Channel interrupt

Program aborted

Edit cumrent filter of DHC IFC SINUMERIK --- area motors/group b cylinders/machining
[~ DNC filter dialog tFF Filter

Field name Operand Yalue
IType - 52 [ S

Screenform
back

DNC
management

PCU/MMLC
services

Logbook

Fig. 4-9 Dialog for editing a filter

The Filter dialog shows all filter criteria applicable to the current filter. Active criteria
are indicated by a tick in the checkbox in front of the filter criteria.

The checkbox in front of each filter criterion can be used to activate or deactivate
that criterion. The operand and value of the filter criterion in question can also be
changed.

Note

Filter criteria are expanded or deleted in DNC Cell/Plant, not in DNC IFC
SINUMERIK.
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Select filter

DNCIFC  |[CHAN1

Jog

MPFO

Channel interrupt

Program aborted

Filter selection of DNC IFC SINUMERIK ---

area motors/group 6 cylindersfmachining centre

r~ DML filter

Filker Marne

*Machine2 / DNC
Filker_3873
Filker 4711

SPF-Filter

shows only MPF-Files

PCU/MMC
SeIvices

Logbook

Fig. 4-10  Filter Selection dialog

Logout

The Filter Selection dialog lists all the filters available for the machine and the user.
The comment stored for the currently selected filter is displayed in the message

line.

Note

A filter marked with the * symbol is specific to a machine or user. The filter name
contains the machine or user name for which the filter is valid.

FBDN2/4-28
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\
DHCIFC  [CHAN1 Jog MPFD
Channel interrupt
Program aborted
Logbook of DNC IFC SINUMERIK ---
|—DNE loghbook
Type | Date | Mumber | Meszage ket :l
[ 30.06.200317:35:14 0 Mumber of files copied DNC->MC: 0 von 1 o
b 30.06.2002377.3306 0 Tranzferring file: <4BCDEF_1.MPF>
I 30.06.200317:33:06 0 Mumber of files copied DNC->MMC: 0 von 1
I 30.06.200317:32:668 0 Tranzferring file: <ABCDEF_1.MPF»

PCU/MMC

services

Fig. 4-11 Logbook

General

Filter

The log book contains all errors and messages that have been displayed in the
message line with their dates and times. That way, you can trace events, such as
downloads, uploads, deletions, user logins and logouts, etc., and errors that have

occurred.

The log book can be displayed from any screen form by pressing the Logbook

softkey.
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4.7 Job interface

General

NC program transfer from another software application (e.g., project-specific
applications of machine manufacturers) can be started via the job interface. The
interface is open and is supplied with the data required for the transmission by the
relevant job program.

You can download NC data automatically or in interactive mode.

Note

Whether data are downloaded interactively or automatically via the job interface
is determined by a parameter setting in the configuration file (DNC_IFC.INI).

Automatic download

NC data are downloaded to the PCU/MMC or NCK automatically; no inputs need to
be made on the DNC IFC SINUMERIK user interface. A prerequisite for automatic
download is that the NC program to be downloaded is clearly identifiable when
transferred to the job interface. If the program cannot be identified unambiguously,
interactive mode is called.

The message line indicates copy operations and active messages in progress.
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Interactive download

In interactive mode, DNC IFC SINUMERIK lists all NC programs and workpieces
meeting the selection criteria passed to the job interface.

Select the program to be downloaded in interactive mode and start the download
operation.

The message line indicates copy operations and active messages in progress.

DNCIFC |[CHAN1 Jog

Channel interrupt D etail

Program aborted

nteractive DNC --- area motors/group b cylinders/machining centre
DML zource

L ilob
completed

cylinderheadyB45

drivinggear336a MPF 2 1 i] 1733 Ahort job

1] | i

T fer to...
Target in PCU/MMEC or MK * Free memony fanster o
| wiorkpiecesivotor

14024704 Byte

PCU/MMC Interactive Logout
SeIvices DHNC

Fig. 4-12  Job interface: Selecting NC data to be downloaded (interactive mode)
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4.8 Login

General

In the default setting, DNC IFC SINUMERIK starts with an automatic login, i.e., it

applies the user and his/her rights as they are entered in the configuration file.

However, you can select other login procedures.

< If you want different users with varying levels of authorization to be able to log
in, you can use a login dialog with manual settings.

* You can also choose the option based on user rights corresponding to the
current protection level on the SINUMERIK or the keyswitch position.

The login procedure (automatic or manual) can be selected in the DNC_IFC.INI

configuration file.
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5.1 General

DNC IFC SINUMERIK settings are configured via the configuration program. This
is started by double-clicking on the DNC_IFCCFG.exe file, which is found in
..\Add_on\DNC_IFC. The configuration settings made using this program are
stored in the DNC_IFC.INI configuration file.

Example of a DNC_IFC.INI configuration file

MCI'S DNC I FC SINUMERIK V2 - Initialization file
"DNC_IFC.INI'"

: This file can be custom zed with "DNC_|I FCcf g. EXE"
[ GLOBAL]

; Higher-1level database type

; (0 = MSDE/ SQL Server/1 = Oracle)
Dat aBaseType =0

; TRACE 1-3 can activate detailed recording.
; Only change tenporarily when troubl eshooting!
TRACE =1

; | P address or DNC nanme of the higher-level DNC server
DNC- HOST =MClI SDNC2

; Use FTP protocol
; (0=No/1=Yes with | ocal DNC_| FCDB/ 2=Yes with renote DNC_| FCDB)
FTP protocol =0

; File type change
; (Y=activat ed/ N=deact i vat ed)
; Note: DrivelnternPath cannot be set to 1 or 2.
; Dat aTypeChange=Y
Dat aTypeChange =N
HWByst em =32

; Default transfer destination can be switched via Sel ect softkey
; (Y=Sof t key confi gured/ N=Softkey not confi gured)
Toggl eSK =Y

;Default transfer destination

i (MMC=Transfer to MMC/ NCK=Transfer to NCK)

; Can be sw tched using softkeys (MMC_NCK=Transfer to MMC or NCK ->
Toggl eSK=Y set)
Def aul t Transfer =MMC_NCK

; Default directory when DNC IFC is started:
7 (0=Machi ne/ 1=Gr oup/ 2=Hi gher -1 evel group)
St artupLayer =0

; Job interface node
; (0=interactive/ 1=aut omati c)
AuToDownLoad =0

; Period in minutes, after which an unconpleted job is deleted
Del et eTi re =60

Aut oResol uti on =Y
Swi t chLanguage =
; FontName =Arial Unicode Ms -> only relevant for |anguages w th special
characters (such as Russian or Chinese)
Font Nanme=

[FTP]
; FTP parameter (only for FTP protocol = 1/2) relevant.
FTP- HOST =DAI SY
FTP- User =A99399958D9895928F
FTP- PW =A98CA48E93A092C79EABA18EBFD59A96A1A696
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; Transfer node ( 1=ASCl |/ 2=bi nary)
FTP node =2

[ bcov ) )
; DCOM configuration: |og-on
DOVAI N =DNC_DOM
USER = John Do
PASSWORD = A98CA48E93A092C79EA8AL8ESFD59A96A1A696

[ PATHS]
; Path nanes without trailing backslash
MVCI ni Drive =F:

MCI'S DNC data directory for access to NC data

The drive nmust be specified fromthe DNC | FC vi ewpoi nt

It is possible to specify either napped network drives (1.) or

conputer and path in UNC Notation (2.) Wen using

FTP (3.), the path must be specified according to the notation required

by the
; FTP server
7 (1.) N linked to DNC\Data on the MCI'S DNC server
; Wor kPat hDNC =N:
; (2.) UNC notation
; Wor kPat hDNC =\\ DAl SY\ DNC$\ Dat a
; (3.) Path nane for FTP server
; Wor kPat hDNC =/ DNC/ Dat a
Wor kPat hDNC =\ \ DAI SY\ DNC\ Dat a

; DHSTenpPath for tenporary storage of files when

; downl oadi ng for DHS-Server and FTP. |f DHSTenpPath is enpty, the
content of the W ndows

; environnent variable YEMP% i s used.
DhsTenpPath =

; DrivelnternPath for DHS- Open

; (Values: 0=Do not evaluate file header/1=Eval uate 1st header/2=Eval uate
al | headers)

;Notice: |f DataTypeChange=Y, DrivelnternPath cannot be set to 1 or 2!
DrivelnternPath =0

[ FI LES]
LogFile =DNC_I FC. | og
ErrLogLen =10

[ MACHI NE]
; Station name in MCIS DNC
MACHI NE = PCU50_840D

; Path for uploading
; 0= Machi ne/ 1= Group/ 2= Mai n group
Def Upl oad =0

[ USER]

; Define |ogin nmethod

; 0= no dialog, Name= and Password= i s used

; 1= user and password have to be specified

;2 = Login with user assigned via ACCESSLEVEL paranet er

; 3= Login with user or dialog assigned via ACCESSLEVEL paraneter
Login =0

; User name shoul d be specified device-specifically for the same user,

due to the display group assignment via MCIS DNC, which is dependent on the
; screen resolution

Nane =DNC

Password =DNC

; Access levels according to Sinunerik HM Advanced startup interface

ACCESSLEVELO =HM System

ACCESSLEVEL1 =HM Manuf act ur er

ACCESSLEVEL2 =HM Servi ce

ACCESSLEVEL3 =HM User

ACCESSLEVEL4 =HM KeyPosi ti on3

ACCESSLEVEL5 =HM KeyPosi ti on2

ACCESSLEVEL6 =HM KeyPosi ti onl

ACCESSLEVEL7 =HM KeyPosi ti on0
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[ TI ME]
;The wait tinme affects the display period of time-controlled nessages
MessageTi me =1000

; Wait time for VB functions
SysTi me =500

; Timer setting controls the delay of the list view display when
scrol ling through the tree view
Del ayTi me =700

; Period, during which transmi ssion of a program can be aborted
BreakTi me =500

[ REFRESH|
; Update list viewregularly (Y=activated/ N=deacti vat ed)
Refresh =N

; Values in seconds
; Period between | ast operation and 1st refresh
Ref reshDel ay =10

;Interval between refreshes
Ref reshl nterval =60

[ GRAPHI CTYPE]
; Permissible graphic types (in capital letters)
TYPEL =G F
TYPE2 =JPG
TYPE3 =PDF

[ DHDI R]
; Sel ectable view of DH directories (in capital letters)

; XXX.DIR = DH directory nane
; ;0= Do not create pseudo workpi ece
; ;1= Pseudo workpiece is created
DHDI Rl =MPF. DI R, O
DHDI R2 =SPF. DI R; 0
DHDI R3 =WKS. DI R, 0
DHDI R4 =ARC. DI
DHDI R5 =CST. DI
DHDI R6 =CUS. DI
Di

[ Machi neRef er ence]
; MCI'S Machi nel D
Maschi nel D1 =Mai n gr oup\ G- oup\ PCU50_840D

[ NCDat aDescri pti on_1]
D1 =NCDATANAVE
D2 =NCDATATYPE
D3 =RELEASEI D

[ NCDat aDef aul t val ue_1]
DL = SPF
D2 =1

[ DNCMVCTy peTab]
; MCIS DNC data types are converted to MVJ PCU data types
; Nunber of types for conversion

DNCMMCTy peCount =2

; Conversion types (e.g., converting TXT to MPF)
DNCMVCTypel =TXT MPF
DNCMVCType2 =DOC | NI

[ MMCDNCTy peTab]
; MMC/ PCU data types are converted to data types on the DNC
; Nunber of types for conversion

MVCDNCTy peCount =2

; Conversion types (e.g., converting MPF to TXT)
MVCDNCTypel =MPF TXT
MVCDNCType2 =I NI DOC
; Copyright (c) SIEMENS A&D, ALL RI GHTS RESERVED
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5.2 Configuration program

i DNC IFC SINUMERIK configuration program o [=] S

File Language Help

DNC IFC SINUMERIK

Configuration program

Pagsword || Login |

Fig. 5-1 Configuration interface Login screen
You log on to the configuration program by entering a password and clicking the
Login button.

The following menus are available in the configuration program:
* File

 Save
« Exit
e Languages
« German
* English
« Help
¢ Help Topics
e About

The configuration program is closed using by selecting File > Exit.
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After the user has logged on, a configuration dialog with 6 tabs appears:
¢ Basic setting

« DNC

e FTP Interface
«  Graphic

e Login

¢ Job Interface

You can exit this configuration dialog either by clicking Cancel with the mouse or
pressing Esc on the keyboard and CANCEL on the operator panel. You then
return to the configuration interface login screen.

You can save configured data either by clicking OK with the mouse or pressing
Ctrl+S on the keyboard and CTRL+S on the operator panel.
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5.2.1 Basic setting

i DNC IFC SINUMERIK configuration program i ]|

File Language Help

Basic zetting |DNCI FTF interface | Graphicl Loginl Job interfacel

~ Transfer target

[¥| Toagle via soft key Target |PEU vI Delay [sec] for dialog abort |44 B0
Fanth amme | SwitchLanguage | 2 |

 Directomy of database server

DE directory
“SPF.DIR | | |
WS DIR i - T
# |MPF.DIF| Pseudo =] ange elete
SHEGH r workpisce

~ DMC -» D file type conversion
DMC type Db type

s ABC N T Mew | Changel Delete |

- DH -> DNC file type conversion

DM type DMC type

ABC #4Z IW __)W Mew | Changel Delets |

Abort [ESC) | OK [Chil+5] |

Fig. 5-2 Configuration interface/Basic settings

The default settings for downloading to/uploading from and operating the PCU are
defined on the Basic Setting tab.

Transfer target can be switched via softkey

This parameter determines whether the default transfer destination for transfer
from DNC can be switched over via a Select softkey:

Checkbox activated = Select softkey available - (v)

Checkbox deactivated = Select softkey no available > (N

Extract from the configuration file:
Section [ GLOBAL]
Toggl eSK = Y

Target

This parameter defines the default transfer destination for transmission from DNC:
PCU = NC data are transferred to the MMC/PCU
NCK = NC data are transferred to the NC

Extract from the configuration file:
Section [ GLOBAL]
Def aul t Transfer = PCU
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Delay for dialog abort

This key parameter defines the period in seconds during which you can cancel the
transfer of a program.

Extract from the configuration file:

The entry in the configuration file is in ms.
Section [Tl Mg
BreakTi me = 5000

FontName

This parameter defines the font for DNC IFC SINUMERIK.

If no font is specified, the default system font is used.

The appropriate font must be specified for foreign languages, which require a
particular font to display special characters correctly.

Extract from the configuration file:
Section [ GLOBAL]
Font Nane =Arial Unicode M5

SwitchLanguage

This parameter defines the internal language selection for DNC IFC SINUMERIK,
primarily for the English area.

The system language is entered in the first input field.

The language used internally is entered in the second input field.

Example:

UK > US

The system language of the computer is UK.

The US language is selected from the list of DNC IFC SINUMERIK internal
languages, as American English should be displayed.

Extract from the configuration file:
Section [ GLOBAL]
Swi t chLanguage =UK, US

Directory of data base server

New directories for the data management server can be set up and existing
directories can be deleted or renamed under Directory of data base server.

Note

You must enter the directory name in capital letters.
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Pseudo workpiece

Check or uncheck the Pseudo workpiece box to define whether NC data are
stored in a pseudo workpiece in DNC.

Important
The Pseudo workpiece box must not be checked for WKS.DIR.

Extract from the configuration file:
Section [DHDI R]

DHDI Rl =MPF. DIR; 0

DHDI R2 =SPF. DIR; 0

Note on configuration file DNC_IFC.INI

In the configuration file, the digit (0 or 1) after the directory name specifies
whether the NC data must be stored in a pseudo workpiece.

0 = No pseudo workpiece

1 = Store NC data in pseudo workpiece

0 is the only permissible setting for WKS.DIR.

DNC -> DM file type conversion

The conversion of file types from DNC system to PCU/MMC data management
server can be defined, or existing conversions can be deleted or changed, under
DNC -> DM file type conversion. Conversion is performed when the data is
downloaded from the DNC system to the data management server.

Important

Conversion is only performed if Evaluation of internal MMC path is not selected
on the DNC tab. Selection: No evaluation

Only file types declared in the DNC system (DNCDATATYPE table) can be
specified as the DNC type.

Extract from the configuration file:
Secti on [ DNCMVCTypeTab]
DNCMVCTypeCount = 2
DNCMVCTypel=TXT MPF
DNCMVCType2=DOC | NI

Note

Conversion is only active for Dri vel nt er nPat h=0.
DNCMVCTypeCount = contains the number of file types to be converted.

© Siemens AG 2005 All Rights Reserved
Motion Control Information System DNC (FB) - 04.05 Edition FBDN2/5-41



DNC IFC SINUMERIK — Downloading NC Data via a Network (FBDN2) 04.05
5 Configuration File

DM-> DNC file type conversion

The conversion of file types from PCU/MMC data management server to DNC
system can be defined, or existing conversions can be deleted or changed, under
DM - DNC file type conversion. Conversion is performed when the data is
downloaded from the data management server to the DNC system.

Important

Conversion is only performed if Evaluation of internal MMC path is not selected
on the DNC tab. Selection: No evaluation

You can specify only file types, which are known in the DNC system
(DNCDATATYPE table), as the DNC type.

Extract from the configuration file:
[ DNCMMCTypeTab] section
MVCDNCTypeCount = 2
MVCDNCTypel=MPF TXT
MVCDNCType2=I NI  DOC

Note

Conversion is only active for Dri vel nt er nPat h=0.
DNCMVCTypeCount = contains the number of file types to be converted.
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@i. DNC IFC SINUMERIK configuration program P | |
File Language Help
Basic zefting  DNC |FTF' interface | Graphicl Login| Job interface
- DMC databasze
& MSDE DML host name or TCPAP address DCOM
™ DRACLE |192.‘IES.1‘I.88 Diamair: |DNE_DDM
Uszer |John Do
Check conhection | xxxxxxxx
Pazsword: |
r Machine
Machine |F'EILIED_84DD Standard return tranzfer |E| vI
Startlevel |D vI
DNC hest path name |\\MC|SDNE2\DNE$\DE'G E waluation of intermal MC path
MMC Directorny |F: keine Auswertung j
Abot (ESC) | OK (Culss) |

Fig. 5-3 Configuration interface/DNC

The connection to the higher-level DNC system and the identification of the PCU in
the DNC system are defined in the DNC tab.

DNC database

The database to be used in the higher-level DNC system is selected via the
Options button:

« MSDE/SQL server (DNC_IFC.INI: 0)

e Oracle (DNC_IFC.INI: 1)

Extract from the configuration file:
Section [ GLOBAL]
Dat aBaseType =0

DNC host name or TCP/IP address

The TCP/IP address or computer name of the DNC host (DNC Cell or DNC
PLANT) is entered in the input field. A connection test can be performed by
pressing the Check Connection button.

Extract from the configuration file:
Section [ GLOBAL]
DNC- HOST =192. 168. 1. 100
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DCOM

Machine

The domain, user name and password on the DNC server are defined for the
DCOM connection in the input fields on the top right.

Extract from the configuration file:
Sect i on[ DCOM

DOVAI N =DNC_Dom

USER = John Do

PASSWORD =* * % % % %

Machine is used for assignment to a machine (control) configured in DNC. The
name of the machine assigned in DNC is specified in the Machine input field.

Extract from the configuration file:
Sect i on[ MACHI NE]
Machi ne = PCU50_840D

Standard return transfer

Startlevel

This defines the hierarchy level to which the NC data will be transferred during
uploads to DNC.

0= Download to the machine directory by default

1= Download to the group directory on a higher level than the machine directory
(father) by default

2 = Downloaded to the group directory (grandfather) on a higher level than the

higher-level machine directory’s group directory by default

Extract from the configuration file:
Sect i on[ MACHI NE]
Def Upl oad = 0

This parameter specifies the default directory when DNC IFC is started:
0=Machine

1=Group

2=Higher-level group

Extract from the configuration file:
Sect i on[ GLOBAL]
St artupLayer =0
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DNC host path name

The drive path for DNC host path name must be specified from the point of view
of DNC IFC SINUMERIK.

This is the specification of the directory in which NC data are stored on the
networked computer.

Note

The path for Windows or UNIX/LINUX computers with Samba is:\DNC computer
name\directory of DNC data directory.

Option when swapping out NC data to a UNIX system:

The path for UNIX/LINUX computers with FTP is, for example: /DNC computer
name/directory of DNC data directory.

Extract from the configuration file:

Sect i on[ PATHS]

Vor kPat hDNC=\\ MCI SDNC2\ DNC$\ Dat a
MMC directory

The key parameter defines the drive or the path of the SINUMERIK software.

Important

F: is the PCU 50/70 drive.
C: is the MMC 103 drive.

The drives are prescribed and can only differ for installation on a PC, in which
case the path to the intended location of the SINUMERIK software must be
specified.

Extract from the configuration file:
Sect i on[ PATHS]
MVCl ni Drive = F:

Evaluation of internal MMC path

The parameter controls the evaluation or generation of a leader with an internal
path (Siemens program header) in the NC data file.

* No evaluation (0)

e Evaluation of one path (1)

¢ Evaluation of several paths (2)

Extract from the configuration file:
Sect i on[ PATHS]
DrivelnternPath = 2
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5.2.3 FTP interface

i DNC IFC SINUMERIK configuration program i ]|
File Language Help
Basic sefting | DNC - FTP interface |Graphic| Loginl Job interface

FTF protocol Mo =

Huost name |D.-’-‘«ISY

Uzer |anonymous

Pazsword | xxxxxx

Transfer mode |Einary j‘

Check. connection |
Abort [ESC) OK [Ctrl+5]

Fig. 5-4 Configuration interface/FTP interface

The FTP interface to the higher-level DNC system is defined in the FTP Interface
tab. This configuration is only required if the transfer between the machine and the
higher-level DNC system is to be performed via FTP.

A connection test can be performed by pressing the Check Connection button.

Note

The default setting is one download per FTP.

FTP protocol

*  No (0):
Operation without FTP:
Data are transferred via the Microsoft network. For this reason, DNC host path
name on the DNC tab must point to a released network drive with the DNC
data directory.

* Yes(1):
Operation with FTP:
DNC_IFC.EXE and DNC_IFCDB.EXE access NC program files via FTP. The
DNC host path name in the DNC tab must include the path to switch over to
the DNC data directory once the FTP connection has been established.

Extract from the configuration file:
Secti on[ GLOBAL]
FTP protocol =0
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Host name

The parameter identifies the host name or the IP address of the FTP server:
e.g., DAISY
e.g., 180.212.26.200

Extract from the configuration file:
Secti on[ FTP]
FTP HOST =DAI SY

User

This parameter identifies the user on the FTP server,
€.g., anonymous

Note

The entry in the DNC_IFC.INI configuration file is encoded.

Extract from the configuration file:

Secti on[ FTP]

FTP- User =A99399958D09895928F
Password

This parameter indicates the password of user on the FTP server,

*kkkkkkkk
e.g.

Note
The entry in the DNC_IFC.INI configuration file is encoded.

Extract from the configuration file:

Secti on[ FTP]

FTP- PW =A98CA48E93A092C79EABAL8E8FD59A96A1A696
Transfer mode

Two modes can be parameterized:

« ASCII (1)
e Binary (2)
Important

For the FTP link between DNC and the DNC IFC SINUMERIK, we recommend
that you use binary mode as the transfer mode!

Extract from the configuration file:
Secti on[ FTP]
FTP node = 2
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5.2.4 Graphics

i DNC IFC SINUMERIK configuration program i ]|
File Language Help
Basic settingl DNCI FTP interface  Graphic |LDgin| Job interface
Graphics types
GIF Mew |
Change |
Delete |
Abort [ESC) OK [Clrl+5]

Fig. 5-5 Configuration interface/Graphics

The types of graphic permissible for display on the Detail Dialog > Show Graphic
screen are defined on the Graphic tab.

Types of graphic
All types of graphic supported by Internet Explorer can be displayed (e.g., BMP,
JPG, GIF). If you wish to display other types of graphic, you must install the

relevant plug-ins.

Note
Graphics can be displayed only with PCU and in operation without FTP protocol.

The type must be entered in capital letters.

Extract from the configuration file:
Sect i on[ GRAPHI CTYPE]

TYPEL =G F

TYPE2 =JPG

TYPE3 =PDF
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5.2.5 Login

i DNC IFC SINUMERIK configuration program i ]|

File Language Help

Basic settingl DNCI FTF interface | Graphic  Lagin |J0b interface'

Type of login |0 login disleg |

User DM Fazzword |m1

- Agzignment of users to access levels

LevelD IW Level 4 IW
Lewvel 1 IW Level B IW
Level 2 IW Level B IW
Level 3 IW Level 7 IW

Abort [ESC) OF [Ctrl+5]

Fig. 5-6 Configuration interface/Login

The login procedure when starting DNC IFC SINUMERIK is configured on the
Login tab.

Login method

This parameter defines the procedure for starting DNC IFC SINUMERIK:

« No Login dialog (default setting) (0):
DNC IFC SINUMERIK is started with the access entered in User and
Password.

* Login dialog (1):
When starting DNC IFC SINUMERIK, users must log on in the Login dialog by
entering their name and password.

e Login via access level (2):
DNC IFC SINUMERIK starts up with the user defined via the assignment of
users to access levels on the current SINUMERIK protection level.

* Login via access level or via login dialog (3)
Login to DNC IFC SINUMERIK is performed as for login via protection levels
(2), although a Login dialog appears if no users have been assigned or if the
user cannot be found in the
DNC user administration. Also, following successful login, a Logout softkey
appears, so that the user can be changed.

Extract from the configuration file:
Sect i on[ USER]
Login = 0
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User/Password

These two parameters correspond to the user name and associated password for
automatic login (login method: no login dialog).

Note

The user DNC with password DNC is defined as the default in DNC IFC
SINUMERIK. Once DNC has been installed, the default user should be deleted
and replaced by a personal user identifier because the user DNC always has
administrator rights. In DNC IFC SINUMERIK, the default user should also be
replaced by a user configured in DNC.

Extract from the configuration file:
Sect i on[ USER]

Name = DNC

Password =DNC

Assigning users to access levels

A user can be assigned here to the 8 protection levels (0-7) of the SINUMERIK
HMI Advanced startup interface. It is, therefore, possible to start DNC IFC
SINUMERIK with the rights of one of the entered users, depending on the current
login method.

Extract from the configuration file:
Sect i on[ USER]

ACCESSLEVELO =HM System
ACCESSLEVEL1 =HM Manuf act ur er
ACCESSLEVEL2 =HM Servi ce
ACCESSLEVEL3 =HM User
ACCESSLEVEL4 =HM KeyPosi ti on3
ACCESSLEVEL5 =HM KeyPosi ti on2
ACCESSLEVEL6 =HM KeyPosi tionl
ACCESSLEVEL7 =HM KeyPosi ti on0
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5.2.6 Job interface

i@ DNC IFC SINUMERIK configuration program

File Language Help

5 Configuration File

=101 %]

v Autormatic ansfer

Basic settingl DNCI FTP interface | Graphicl Login  Job interface |

max. Timeout |ED mn

RELEASEID

Change |
Delete |

Machine reference |M azchinel D11 |M aingrauphGroupt PCLY2

~ MC data dezcription - NCData D efaulbvalus
NCDATANAME |1_ == | |1_ <]
NEDATATYPE New MPF Mo

il

Change

Delete

Abort [ESC)

OK [Ctil+5)

Fig. 5-7 Configuration interface/Job interface

The interface between DNC IFC SINUMERIK and other applications, such as MRP
systems or MCIS MDA, is defined in the Job Interface tab.

Automatic transfer

This parameter defines the transmission mode for the job interface:
¢ Interactive (0)
e Automatic (1)

Extract from the configuration file:
Secti on[ GLOBAL]
AuToDownLoad = 1

Maximum timeout

This parameter defines the time in minutes at the end of which an uncompleted
task transferred via the job interface will be canceled.

Extract from the configuration file:
Secti on[ GLOBAL]
Del et eTi me =60
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Machine reference

This deals with assigning the machine name of the authorizing system to the
machine name in DNC. The machine name of the authorizing system is entered in
the left-hand input field. The machine name within DNC is entered in the right-hand
input field. This must correspond to the machine name on the DNC tab.

Extract from the configuration file:
Section [ Machi neRef erence]
Machi nel D1 =Mai n group\ G oup\ PCUV2

NC data description

The NC data description defines the sequence of values when performing a
download job from an MRP system. The specified parameters are used in
downloading the corresponding NC data file to the SINUMERIK data management
system. At least the NC data file name and the NC data type must be specified.
Parameters without an assigned value are assigned the default value from the
section [NCDataDefaultvalue_1].

Other NC data descriptions (2, 3, etc.) can be configured, e.g., in order to control
normal NC data and workpieces in parallel.

Note

All specified values must correspond to the DNC management parameters.

Extract from the configuration file:
Sect i on[ NCDat aDescri pti on_1]
D1=NCDATANANE

D2=NCDATATYPE

D3=RELEASEI D

NCData Defaultvalue

The NCData Defaultvalue contain the default values for parameters specified in the
NC data description. If a parameter is not assigned by the MRP system, the default
value from section [NCDataDefaultvalue_1] is used instead.

Other NC data defaults (2, 3, etc.) can be configured, e.g., in order to control
normal NC data and workpieces in parallel.

Note

With the exception of the NC data file names, all parameters from the NC data
description must also have an assigned value in the NC data defaults.

Extract from the configuration file:
Sect i on[ NCDat aDef aul t val ue_1]
D2=SPF

D3=1
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5.3 Other configuration options via DNC_IFC.INI

The following parameters must be configured directly in the DNC_IFC.INI
configuration file:

Section [GLOBAL]

Dat aTypeChange =
N = During transfer to a selectable destination (Download to), it is
illegal to change the file type.
Y = During transfer to a selectable destination (Download to), the user
can change the file type. This is also active if conversion tables are configured
in the sections [DNCMMCTypeTab] and [MMCDNCTypeTab]. The
DrivelnternPath parameter may not be set to 1 or 2.

Section [PATHS]

DhsTenpPath =
DhsTempPath describes the directory for temporary files. If the parameter is not
set, the Windows temporary directory (temp) will be used.

Section [TIME]

MessageTi me =
This key parameter controls the dwell time (in ms) of the messages displayed for
DNC IFC SINUMERIK.

A Warning

The parameter must only be modified during commissioning or in consultation
with the hotline!

Del ayTi me =
This key parameter controls the delay (in ms) of the list display of directories when
you scroll through the tree view of DNC IFC SINUMERIK.
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Section [REFRESH]

Refresh =
N = Deactivate automatic refresh of the screen content
Y = Activate automatic refresh of the screen content

RefreshDel ay =
Duration in seconds between last operator action and first refresh

Refreshl nterval =
Duration in seconds between refresh cycles
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04.05 A Appendix

A

A Appendix

A.1 DNC Glossary

Abbreviation | Meaning

ASCII code American Standard Code for Information

7-bit code
BMP BitMaP

Graphics file for clamping diagrams, etc.
CNC Computerized Numeric Control

Numerical control with microprocessors
DNC Direct Numeric Control

System where several CNC machines are linked with a central computer by
bidirectional data exchange.

DNC IFC Direct Numeric Control InterFace Client

SINUMERIK | System where several CNC machines are linked with a central computer by
bidirectional data exchange. Transfer is over a network to SINUMERIK 840D.

FTP File Transfer Protocol

EIA code Electronic Industries Association
8-track punched-tape code corresponding to the ISO code, but with an even
number of holes per character.

HMI Human Machine Interface
ISO code International Organization for Standardization
8-track punched-tape code
IsQL Interactive Structured Query Language
Interactive database access option
MDA Machine Data Acquisition
Machine Stand alone for SINUMERIK/PC incl. evaluation
SINUMERIK | Machine data acquisition/production data acquisition
MDA Machine Data Acquisition
Production data acquisition and evaluation on SINUMERIK 840D
MPF MainProgramFile
NC main program
MMC Man Machine Communication
OCX OLE custom controls
OLE DB Object Linking and Embedding DataBase

Database access functions over OLE/COM
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OLE/COM Object Linking and Embedding/Component Object Model
Object-oriented program model for defining object behavior, also using
process limits

PCU PC Unit
SPF SubProgramFile
NC subprogram
SQL Structured Query Language
Database query language
SQL-net Structured Query Language-net
Interface for network access to database
TCP/IP Transmission Control Protocol/Internet Protocol

Transmission protocol
TDI Machine | Tool Data Information Machine
Information about the availability and handling of tools

TOA ToolOffsetActiv

Tool offsets
WPL WorkPLan

ASCII file for tool diagrams
ZOA ZeroOffsetActiv

Zero offset
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